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1 BioStar 2 Overview

BioStar 2 is a web-based access control management system which is OS-independent and can be used

anywhere.

BioStar 2 expands its versatility even further with its support for access control and time & attendance

module, API, Mobile App, and Device SDK solutions.

License

Versions

Access Control

Max. Device

1,000

Max. Slave per Master

31 (Up to 8 Fingerprint Devices)

(RS-485)
RS-485 Protocol OSDP Supported
. Multi-Door Control Supported
Device
Device Admin Level All / User / Config
Auto Reconnection to )
Direct & Server mode
Server
USB Enrollment Device BioMini, BioMini Plus 2, DUALi DE-620
Daylight Saving Time Supported
Max. Card per User 8
Max. Fingerprint per User 10
Auto User Sync to Device Supported
Access-on-Card Supported
User
Secure Credential Supported
iCLASS Seos Card Supported
Inactive User Report Supported
Custom Fields Supported
Max. Access Level 2,048 (Depends on the device)
Max. Access Group 2,048 (Depends on the device)
Max. Access Group per User 16
Access Max. Door per Access Level 128
Control Auto Access Group Sync to
) Supported
Device
Access Group Report b
PRep Y Supported
Door/User/Elevator
Elevator Max. Floor per Elevator 192
(Floor Max. Floor Level 2,048
Management) Dual Auth Supported
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Anti-passback Zone Supported
Fire Alarm Zone Supported
Max. Zones 100
Max. Device per Zone 1,000 Global, 32 Local
Anti-passback Door APB, Global, Local
Zone Fire Alarm Global, Local
Scheduled Unlock/Lock Supported (Local)
Intrusion Alarm Supported (Local)
Interlock Supported (Local)
Muster Supported (Global)
Dashboard Supported
Server Matching Supported
Audit Trail Supported
Advanced Video Log Supported
Local API Server Supported

BioStar 2 Mobile App Supported (User, Door, Monitoring,

Alarm)

Mobile Access Supported

Time Attendance

Number of Shifts Unlimited

Number of Schedules Unlimited

Number of User per Schedule Unlimited

Shift Type Fixed, Flexible, Floating
Time Card Supported

Number of Leave per User Unlimited

Calendar View Supported

Note

» Check the License for features that your license supports.

License

You can use more features by registering the activation key after purchasing the BioStar 2 license.

License for Access Control
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Starter Standard Advance Professio
(Free) nal

Unlim Unlim Unlim Unlim Unlim Unlim
User ited ited ited ited ited ited
Max.
1,000 1,000 1,000 1,000 1,000 1,000
Device
Max.
5 20 50 100 300 1,000
Door
Supp Supp Supp Supp
Zone - -
orted orted orted orted
Acces Elevator - - - Supp Supp Supp
S orted orted orted
Contr Graphic - - - Supp Supp Supp
ol Map orted orted orted
Server - - - Supp Supp Supp
Matchin orted orted orted
g
Cloud - - Supp Supp Supp Supp
orted orted orted orted
Active - - - Supp Supp Supp
Director orted orted orted
y

Note

» If there is an AC Standard license already in use, it is replaced by an Advance license.

License for Time Attendance

Starter
Standard Advanced Professional
(Free)

Number of Users 1,000 Unlimited

Note

» If there is an Time Attendance license already in use, it is replaced by an Professional license.

License for Video

Video Log - Supported




1 BioStar 2 Overview

License for Visitor
Visitor Management - Supported
Versions

BioStar 2.8.8

New and improved features

Category Functionality

Time & Attendance = Fixed bugs of some features in the TIME ATTENDANCE menu

Compatible firmware
= BioLite Net: 2.3.5 or later
= BioEntry Plus: 2.3.4 or later
» BioEntry W: 2.3.4 or later
»  Xpass: 2.4.4 or later
= Xpass S2: 2.4.4 or later
= BioStation 2: 1.9.0 or later
» BioStation A2: 1.7.1 or later
» BioStation L2: 1.6.0 or later
= BioEntry W2: 1.6.0 or later
= FaceStation 2: 1.4.0 or later
= CoreStation: 1.4.1 or later
» BioEntry P2: 1.4.0 or later
= BioEntry R2: 1.4.0 or later
= BioLite N2: 1.3.2 or later
» XPass D2: 1.3.1 or later
» XPass D2 (Rev 2): 1.4.2 or later
» Facelite: 1.1.0 or later
= XPass 2: 1.2.2 or later
= FaceStation F2: 1.0.0 or later
= OM-120: 1.2.0 or later
= Secure I/O 2: 1.3.0 or later
= DM-20: 1.2.0 or later

BioStar 2.8.7
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New and improved features

Category Functionality

= BioStar 2 performance improvements
General .
= Supplementation of New Local API
User » Supports batch registration of Visual Face using CSV import
Device = Stabilization of features for thermal camera
Monitoring = Supports thermal report
Settin = Email contents improvements
9 = Stabilization of 'Specific Devices' Automatic User Synchronization option

Compatible firmware

BioLite Net: 2.3.5 or later
BioEntry Plus: 2.3.4 or later
BioEntry W: 2.3.4 or later
Xpass: 2.4.4 or later

Xpass S2: 2.4.4 or later
BioStation 2: 1.8.0 or later
BioStation A2: 1.7.1 or later
BioStation L2: 1.6.0 or later
BioEntry W2: 1.6.0 or later
FaceStation 2: 1.3.1 or later
CoreStation: 1.4.1 or later
BioEntry P2: 1.4.0 or later
BioEntry R2: 1.4.0 or later
BioLite N2: 1.3.2 or later
XPass D2: 1.3.1 or later
XPass D2 (Rev 2): 1.4.1 or later
FacelLite: 1.1.0 or later
XPass 2: 1.2.1 or later
FaceStation F2: 1.0.0 or later
OM-120: 1.2.0 or later
Secure I/O 2: 1.3.0 or later
DM-20: 1.2.0 or later

BioStar 2.8.6

New and improved features
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Category

Device

Compatible firmware

BioLite Net: 2.3.5 or later
BioEntry Plus: 2.3.4 or later
BioEntry W: 2.3.4 or later
Xpass: 2.4.4 or later

Xpass S2: 2.4.4 or later
BioStation 2: 1.8.0 or later
BioStation A2: 1.7.1 or later
BioStation L2: 1.6.0 or later
BioEntry W2: 1.5.0 or later
FaceStation 2: 1.3.1 or later
CoreStation: 1.4.0 or later
BioEntry P2: 1.4.0 or later
BioEntry R2: 1.4.0 or later
BioLite N2: 1.3.1 or later
XPass D2: 1.3.1 or later

XPass D2 (Rev 2): 1.4.1 or later

FacelLite: 1.1.0 or later
XPass 2: 1.2.1 or later
OM-120: 1.2.0 or later
Secure I/O 2: 1.3.0 or later
DM-20: 1.2.0 or later

BioStar 2.8.5

New and improved features

Category

Time & Attendance

Compatible firmware

BioLite Net: 2.3.5 or later
BioEntry Plus: 2.3.4 or later

Functionality

= Supports server matching for face recognition devices
= Supports thermal camera on face recognition devices
= Support FaceStation F2

= Support BioEntry W2 (Rev 2)

Functionality

= Supports Wiegand devices
= Improved the Individual Report usability
= Supports users to update TA reports
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= BioEntry W: 2.3.4 or later

= Xpass: 2.4.4 or later

»  Xpass S2: 2.4.4 or later

= BioStation 2: 1.8.0 or later

= BioStation A2: 1.7.1 or later
» BioStation L2: 1.6.0 or later
» BioEntry W2: 1.5.0 or later

» FaceStation 2: 1.3.1 or later
= CoreStation: 1.4.0 or later

= BioEntry P2: 1.4.0 or later

» BioEntry R2: 1.4.0 or later

= Biolite N2: 1.3.1 or later

= XPass D2: 1.3.1 or later

= XPass D2 (Rev 2): 1.4.1 or later
» Facelite: 1.1.0 or later

= XPass 2: 1.2.1 or later

= OM-120: 1.2.0 or later

= Secure I/O 2: 1.3.0 or later
= DM-20: 1.2.0 or later

BioStar 2.8.4

New and improved features

Category Functionality

= Supplementation of New Local API

= Improvement of backup and recovery logic for Web-App, CGl server
system.conf

= Exclusion of TLS V1.1 for improved security

» Improved Thrift communication logic log

= Improved security vulnerabilities on Redis

General

= Improved the logic for issuing mobile access cards

User = Improved the logic for issuing mobile access cards using the CSV

Setting = Stabilization of features for mobile access cards

Compatible firmware
= BioLite Net: 2.3.5 or later
» BioEntry Plus: 2.3.4 or later
= BioEntry W: 2.3.4 or later
= Xpass: 2.4.4 or later
= Xpass S2: 2.4.4 or later
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= BioStation 2: 1.8.0 or later

» BioStation A2: 1.7.1 or later
» BioStation L2: 1.5.1 or later
= BioEntry W2: 1.5.0 or later

= FaceStation 2: 1.3.1 or later
» CoreStation: 1.4.0 or later

» BioEntry P2: 1.4.0 or later

= BioEntry R2: 1.4.0 or later

= BioLite N2: 1.3.1 or later

» XPass D2: 1.3.1 or later

» XPass D2 (Rev 2): 1.4.1 or later
» Facelite: 1.1.0 or later

= XPass 2: 1.2.1 or later

= OM-120: 1.2.0 or later

= Secure I/O 2: 1.3.0 or later
= DM-20: 1.2.0 or later

BioStar 2.8.3

New and improved features

Category Functionality

General » Updated language resource files
Device = Supports FaceStation 2 and FacelLite as a slave of CoreStation
= Supports Mobile Access on BioLite N2
Elevator = Improved the scheduled unlock zone function to support elevator
Setting = Supports Zone in the Admin Item Settings of the custom level

Compatible firmware
= BioLite Net: 2.3.5 or later
= BioEntry Plus: 2.3.4 or later
= BioEntry W: 2.3.4 or later
= Xpass: 2.4.4 or later
» Xpass S2: 2.4.4 or later
= BioStation 2: 1.8.0 or later
= BioStation A2: 1.7.1 or later
= BioStation L2: 1.5.1 or later
» BioEntry W2: 1.4.1 or later
= FaceStation 2: 1.3.1 or later
= CoreStation: 1.4.0 or later
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= BioEntry P2: 1.4.0 or later

= BioEntry R2: 1.4.0 or later

= BioLite N2: 1.3.0 or later

= XPass D2: 1.3.0 or later

= XPass D2 (Rev 2): 1.4.0 or later
» Facelite: 1.1.0 or later

»  XPass 2: 1.2.1 or later

= OM-120: 1.1.0 or later

= Secure I/O 2: 1.3.0 or later

= DM-20: 1.2.0 or later

BioStar 2.8.2

New and improved features

Category Functionality

General = Fixed local file inclusion (LFI) vulnerability

Compatible firmware
= BioLite Net: 2.3.5 or later
= BioEntry Plus: 2.3.4 or later
= BioEntry W: 2.3.4 or later
» Xpass: 2.4.4 or later
= Xpass S2: 2.4.4 or later
= BioStation 2: 1.8.0 or later
» BioStation A2: 1.7.1 or later
» BioStation L2: 1.5.1 or later
= BioEntry W2: 1.4.1 or later
= FaceStation 2: 1.3.1 or later
» CoreStation: 1.3.1 or later
» BioEntry P2: 1.3.1 or later
= BioEntry R2: 1.4.0 or later
= BioLite N2: 1.2.0 or later
» XPass D2: 1.3.0 or later
» XPass D2 (Rev 2): 1.4.0 or later
» Facelite: 1.1.0 or later
= XPass 2: 1.2.0 or later
» OM-120: 1.1.0 or later
= Secure I/O 2: 1.2.4 or later
= DM-20: 1.1.5 or later
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BioStar 2.8.1

New and improved features

Category Functionality

General = Supports MS SQL Server 2019

Time & Attendance = Move the 'In/Out Only and 'All Punches' options in the Individual Report

Compatible firmware
= BioLite Net: 2.3.5 or later
» BioEntry Plus: 2.3.4 or later
»  BioEntry W: 2.3.4 or later
= Xpass: 2.4.4 or later
= Xpass S2: 2.4.4 or later
= BioStation 2: 1.8.0 or later
= BioStation A2: 1.7.1 or later
= BioStation L2: 1.5.1 or later
= BioEntry W2: 1.4.1 or later
= FaceStation 2: 1.3.1 or later
= CoreStation: 1.3.1 or later
= BioEntry P2: 1.3.1 or later
= BioEntry R2: 1.4.0 or later
» BioLite N2: 1.2.0 or later
»  XPass D2: 1.3.0 or later
= XPass D2 (Rev 2): 1.4.0 or later
= Facelite: 1.1.0 or later
»  XPass 2: 1.2.0 or later
= OM-120: 1.1.0 or later
= SecureI/O 2: 1.2.4 or later
= DM-20: 1.1.5 or later

BioStar 2.8.0

New and improved features

Category Functionality

General = DB encryption to enhance security on personal information

Compatible firmware

10
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BioLite Net: 2.3.5 or later
BioEntry Plus: 2.3.4 or later
BioEntry W: 2.3.4 or later
Xpass: 2.4.4 or later

Xpass S2: 2.4.4 or later
BioStation 2: 1.8.0 or later
BioStation A2: 1.7.1 or later
BioStation L2: 1.5.1 or later
BioEntry W2: 1.4.1 or later
FaceStation 2: 1.3.0 or later
CoreStation: 1.3.1 or later
BioEntry P2: 1.3.1 or later
BioEntry R2: 1.3.1 or later
BioLite N2: 1.2.0 or later
XPass D2: 1.2.0 or later
XPass D2 (Rev 2): 1.4.0 or later
FacelLite: 1.1.0 or later
XPass 2: 1.1.0 or later
OM-120: 1.1.0 or later
Secure I/O 2: 1.2.4 or later
DM-20: 1.1.5 or later

BioStar 2.7.14

New and improved features

Category Functionality

= Supports Windows Authentication for MS SQL database server

General connections
= Supports MS SQL Server 2017
= Added the Floor Control API to BioStar 2 API Documents
Device = Support XPass D2(Rev 2)
. » Enhancement in Mobile Access usage
Setting

= Stabilization of 'Specific Devices' Automatic User Synchronization option

Compatible firmware

BioLite Net: 2.3.5 or later
BioEntry Plus: 2.3.4 or later
BioEntry W: 2.3.4 or later
Xpass: 2.4.4 or later
Xpass S2: 2.4.4 or later

11
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= BioStation 2: 1.8.0 or later
» BioStation A2: 1.7.1 or later
» BioStation L2: 1.5.1 or later
= BioEntry W2: 1.4.1 or later
= FaceStation 2: 1.3.0 or later
» CoreStation: 1.3.1 or later
» BioEntry P2: 1.3.1 or later

= BioEntry R2: 1.3.1 or later

= BioLite N2: 1.2.0 or later

» XPass D2: 1.2.0 or later

» Facelite: 1.1.0 or later

= XPass 2: 1.1.0 or later

= OM-120: 1.1.0 or later

= Secure I/O 2: 1.2.4 or later
= DM-20: 1.1.5 or later

BioStar 2.7.12

New and improved features

Category Functionality

Time & Attendance = Support to generate TA reports simultaneously on multiple clients

= Added the new Suprema Mobile Access

Settin . o . . L .
ng = Stabilized 'Specific Devices' Automatic User Synchronization option

12

Compatible firmware
= BioLite Net: 2.3.5 or later
= BioEntry Plus: 2.3.4 or later
» BioEntry W: 2.3.4 or later
»  Xpass: 2.4.4 or later
= Xpass S2: 2.4.4 or later
= BioStation 2: 1.8.0 or later
» BioStation A2: 1.7.0 or later
» BioStation L2: 1.5.1 or later
= BioEntry W2: 1.4.1 or later
= FaceStation 2: 1.3.0 or later
= CoreStation: 1.3.1 or later
» BioEntry P2: 1.3.1 or later
= BioEntry R2: 1.3.1 or later
= BioLite N2: 1.2.0 or later
» XPass D2: 1.2.0 or later
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= Facelite: 1.1.0 or later

» XPass 2: 1.1.0 or later

= OM-120: 1.1.0 or later

=  Secure I/O 2: 1.2.4 or later
= DM-20: 1.1.5 or later

BioStar 2.7.11

New and improved features

Category Functionality

General = Improved dashboard usability
User = Added User IP item to User Information
. = Supports the alert sound for 'Input(Event Name Change)' in the <Trigger
Device .
& Action>
. = Supports the sorting of lists for the User ID and User Group column of
Monitoring

the <Muster Status> page

» Enhances the system security
Setting = Added 'Specific Devices(Only devices belonging to the access group)'
option to <Automatic User Synchronization>

Compatible firmware
= BioLite Net: 2.3.5 or later
= BioEntry Plus: 2.3.4 or later
» BioEntry W: 2.3.4 or later
»  Xpass: 2.4.4 or later
= Xpass S2: 2.4.4 or later
= BioStation 2: 1.8.0 or later
» BioStation A2: 1.7.0 or later
» BioStation L2: 1.5.1 or later
= BioEntry W2: 1.4.1 or later
= FaceStation 2: 1.3.0 or later
= CoreStation: 1.3.0 or later
» BioEntry P2: 1.3.1 or later
= BioEntry R2: 1.3.1 or later
= BioLite N2: 1.2.0 or later
» XPass D2: 1.2.0 or later
» Facelite: 1.1.0 or later
= XPass 2: 1.1.0 or later
= OM-120: 1.1.0 or later
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= SecureI/O 2: 1.2.4 or later
= DM-20: 1.1.5 or later

BioStar 2.7.10

New and improved features

Category Functionality

= Support Facelite

Device
= Support XPass 2

= Improve the Custom Level

= Support to use the custom user field in the T&A report

Time & Attendance = Supports the sorting for entire data in the T&A report

= Added option to select 'First in & Last Out' or 'All in/Out Punches' to
search conditions of the individual report

= Support to the USB fingerprint scanner connection (BioMini, BioMini Plus,

Visitor BioMini Plus 2)

= Update the resource files of Japanese, Arabic, and Spanish

Setting = Add Automatic backup function for Setting.conf file

Compatible firmware
= BioLite Net: 2.3.5 or later
= BioEntry Plus: 2.3.4 or later
= BioEntry W: 2.3.4 or later
» Xpass: 2.4.4 or later
= Xpass S2: 2.4.4 or later
= BioStation 2: 1.8.0 or later
» BioStation A2: 1.7.0 or later
» BioStation L2: 1.5.0 or later
= BioEntry W2: 1.4.0 or later
= FaceStation 2: 1.3.0 or later
» CoreStation: 1.3.0 or later
» BioEntry P2: 1.3.0 or later
= BioEntry R2: 1.3.0 or later
= BioLite N2: 1.2.0 or later
» XPass D2: 1.2.0 or later
» Facelite: 1.1.0 or later
= XPass 2: 1.0.1 or later
= OM-120: 1.1.0 or later
=  Secure I/O 2: 1.2.4 or later
= DM-20: 1.1.5 or later

14
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BioStar 2.7.8

New and improved features

Category Functionality

= Supports multiple use function of controllers in CoreStation

= Supports options for selection by card type

Device = Supports the fingerprint/face duplicate check

= Supports Anti-Tailgating

= Supports setting options for Wiegand authentication result output

Door = Supports Anti-Tailgating

Visitor = Supports to search option for visitors using fingerprints

= Supports user group synchronization in Active Directory

Settin
9 = Supports Anti-Tailgating

Compatible firmware
= BioLite Net: 2.3.5 or later
» BioEntry Plus: 2.3.4 or later
= BioEntry W: 2.3.4 or later
= Xpass: 2.4.4 or later
= Xpass S2: 2.4.4 or later
» BioStation 2: 1.7.1 or later
= BioStation A2: 1.6.0 or later
= BioStation L2: 1.5.0 or later
= BioEntry W2: 1.4.0 or later
= FaceStation 2: 1.2.1 or later
= CoreStation: 1.3.0 or later
= BioEntry P2: 1.3.0 or later
= BioEntry R2: 1.3.0 or later
» BioLite N2: 1.1.0 or later
= XPass D2: 1.2.0 or later
= Facelite: 1.0.0 or later
» XPass 2: 1.0.0 or later
= OM-120: 1.1.0 or later
=  Secure I/O 2: 1.2.4 or later
= DM-20: 1.1.4 or later
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BioStar 2.7.7

New and improved features

Category Functionality

General = Change the license policy
Visitor = Add the VISITOR menu
Setting = Add the settings for visitor management

Compatible firmware
= BioLite Net: 2.3.5 or later
= BioEntry Plus: 2.3.4 or later
= BioEntry W: 2.3.4 or later
= Xpass: 2.4.4 or later
» Xpass S2: 2.4.4 or later
» BioStation 2: 1.7.1 or later
= BioStation A2: 1.6.0 or later
= BioStation L2: 1.4.0 or later
» BioEntry W2: 1.3.0 or later
» FaceStation 2: 1.2.1 or later
= CoreStation: 1.2.0 or later
= BioEntry P2: 1.2.0 or later
» BioEntry R2: 1.2.0 or later
= BioLite N2: 1.1.0 or later
= XPass D2: 1.1.0 or later
= OM-120: 1.1.0 or later
= Secure I/O 2: 1.2.4 or later
= DM-20: 1.1.4 or later

BioStar 2.7.6

New and improved features

Category Functionality

General = Add BioStar 1.x to BioStar 2.x Migration Tool

Monitoring

Support to the Clear APB for each user

Add the event items to IMAGE LOG menu
Add the encryption option to Active Directory menu
= Supports that the administrator can change the port 9000 in FastCGI of

Setting

16
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Category Functionality

Port menu

Compatible firmware
= BioLite Net: 2.3.5 or later
= BioEntry Plus: 2.3.4 or later
= BioEntry W: 2.3.4 or later
» Xpass: 2.4.4 or later
= Xpass S2: 2.4.4 or later
= BioStation 2: 1.7.1 or later
» BioStation A2: 1.6.0 or later
» BioStation L2: 1.4.0 or later
= BioEntry W2: 1.3.0 or later
= FaceStation 2: 1.2.1 or later
» CoreStation: 1.2.0 or later
» BioEntry P2: 1.2.0 or later
= BioEntry R2: 1.2.0 or later
= BioLite N2: 1.1.0 or later
» XPass D2: 1.1.0 or later
= OM-120: 1.1.0 or later
= Secure I/O 2: 1.2.4 or later
= DM-20: 1.1.4 or later

BioStar 2.7.5

New and improved features

Category Functionality

User = Support to the list sorting for group and status column

= Support to the list sorting for RS-485 column
Device = Remove the unsupported AoC events
= Added an Ambient Brightness option to the FaceStation 2 slave device

Door = Support to the list sorting for group column

Video = Remove the unsupported AoC events

= Add the Active Directory menu
Setting = Supports that the administrator can change the port 9000 in setting.conf
= Remove the unsupported AoC events

Compatible firmware
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= BioLite Net: 2.3.5 or later

= BioEntry Plus: 2.3.4 or later
» BioEntry W: 2.3.4 or later

= Xpass: 2.4.4 or later

= Xpass S2: 2.4.4 or later

= BioStation 2: 1.7.1 or later
= BioStation A2: 1.6.0 or later
= BioStation L2: 1.4.0 or later
= BioEntry W2: 1.3.0 or later
» FaceStation 2: 1.2.1 or later
= CoreStation: 1.2.0 or later
= BioEntry P2: 1.2.0 or later

= BioEntry R2: 1.2.0 or later

= BioLite N2: 1.1.0 or later

» XPass D2: 1.1.0 or later

= OM-120: 1.1.0 or later

= Secure I/O 2: 1.2.4 or later
« DM-20: 1.1.4 or later

BioStar 2.7.4

New and improved features

Category Functionality

= Support for Quick Enrollment for FaceStation 2

Device
(FaceStation 2 FW V1.2.2 or later)

Limits the use of passwords that contain the same string, consecutive
string, and login ID

Setting = Limits reuse of the same password

= Support to Spanish and Arabic

= Expanding the number of custom levels to unlimited

Compatible firmware
= BioLite Net: 2.3.5 or later
= BioEntry Plus: 2.3.4 or later
» BioEntry W: 2.3.4 or later
= Xpass: 2.4.4 or later
= Xpass S2: 2.4.4 or later
= BioStation 2: 1.7.1 or later
= BioStation A2: 1.6.0 or later
= BioStation L2: 1.4.0 or later

18



1 BioStar 2 Overview

= BioEntry W2: 1.3.0 or later

» FaceStation 2: 1.2.1 or later
= CoreStation: 1.2.0 or later

= BioEntry P2: 1.2.0 or later

= BioEntry R2: 1.2.0 or later

= BioLite N2: 1.1.0 or later

» XPass D2: 1.1.0 or later

= OM-120: 1.1.0 or later

= SecureI/O 2: 1.2.4 or later
» DM-20: 1.1.4 or later

BioStar 2.7.3

New and improved features

Category Functionality

= Increase the number of administrators that can be added per device
Device = Change the way new settings are applied when adding administrators
using batch edit of devices

Setting = Support for reconnection of devices configured as a port forwarding

Compatible firmware
= BioLite Net: 2.3.5 or later
= BioEntry Plus: 2.3.4 or later
» BioEntry W: 2.3.4 or later
»  Xpass: 2.4.4 or later
= Xpass S2: 2.4.4 or later
= BioStation 2: 1.7.0 or later
» BioStation A2: 1.6.0 or later
= BioStation L2: 1.4.0 or later
= BioEntry W2: 1.3.0 or later
= FaceStation 2: 1.2.0 or later
= CoreStation: 1.2.0 or later
» BioEntry P2: 1.2.0 or later
= BioEntry R2: 1.2.0 or later
= BioLite N2: 1.1.0 or later
» XPass D2: 1.1.0 or later
= OM-120: 1.1.0 or later
= Secure I/O 2: 1.2.4 or later
= DM-20: 1.1.4 or later
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BioStar 2.7.2

New and improved features

Category Functionality

= Support to Live Video View on Graphic Map
Monitoring = Support to viewing Anti-passback Zone and Fire Alarm Zone on Graphic
Map

= Supports <Allowed a day before/after time> setting for working 24 hours

Time & Attendance
or longer

= Add the Security menu

= Change Password Level options

= Support to the setting for Maximum Password Age and Maximum
Password Change Limit

= Support to the setting options for password failures at login

= Support to the Storage Path Settings for image logs

Setting

Compatible firmware
= BioLite Net: 2.3.5 or later
» BioEntry Plus: 2.3.4 or later
= BioEntry W: 2.3.4 or later
= Xpass: 2.4.4 or later
= Xpass S2: 2.4.4 or later
= BioStation 2: 1.7.0 or later
= BioStation A2: 1.6.0 or later
= BioStation L2: 1.4.0 or later
= BioEntry W2: 1.3.0 or later
= FaceStation 2: 1.2.0 or later
= CoreStation: 1.2.0 or later
= BioEntry P2: 1.2.0 or later
= BioEntry R2: 1.2.0 or later
» BioLite N2: 1.1.0 or later
= XPass D2: 1.1.0 or later
= OM-120: 1.1.0 or later
=  Secure I/O 2: 1.2.4 or later
= DM-20: 1.1.4 or later

BioStar 2.7.1
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New and improved features

Category Functionality

Device

» Support to Input(Event Name Change) in Trigger & Action
= Support to the OM-120 Relay time setting value from 1 second

User

= Support for deleting users stored on the device

Monitoring

= Provides the log about whether a user has been updated on the device or
the server

Setting

= Supports synchronization of all devices connected to the server when
users update the device

= Adds root password verification procedures during installation and
upgrade

Compatible firmware

BioLite Net: 2.3.5 or later
BioEntry Plus: 2.3.4 or later
BioEntry W: 2.3.4 or later
Xpass: 2.4.4 or later

Xpass S2: 2.4.4 or later
BioStation 2: 1.7.0 or later
BioStation A2: 1.6.0 or later
BioStation L2: 1.4.0 or later
BioEntry W2: 1.3.0 or later
FaceStation 2: 1.2.0 or later
CoreStation: 1.2.0 or later
BioEntry P2: 1.2.0 or later
BioEntry R2: 1.2.0 or later
BioLite N2: 1.1.0 or later
XPass D2: 1.1.0 or later
OM-120: 1.1.0 or later
Secure I/O 2: 1.2.4 or later
DM-20: 1.1.4 or later

BioStar 2.7.0

New and improved features

Category

Device

Functionality

= Support to the number of users, fingerprints, faces, and cards in
Manage Users in Device
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Category Functionality

Access Control = Support for a larger number of access groups and access groups

Monitoring = Support to Graphic Map

Time & Attendance

= Support to Working alarm time report

= Improve the process for generating the time card

= Support to the separator option in CSV export

= Support to Floating shift

= Support to Fixed option in Meal deduction and Break Time

= Support to Weekend days setting option in Schedule Template

Setting

= Support to Custom Account Level in T&A
= Support to AES encryption type for DESFire card
= Support to DESFire Advanced option

Compatible firmware

BioLite Net: 2.3.5 or later
BioEntry Plus: 2.3.4 or later
BioEntry W: 2.3.4 or later
Xpass: 2.4.4 or later

Xpass S2: 2.4.4 or later
BioStation 2: 1.7.0 or later
BioStation A2: 1.6.0 or later
BioStation L2: 1.4.0 or later
BioEntry W2: 1.3.0 or later
FaceStation 2: 1.2.0 or later
CoreStation: 1.2.0 or later
BioEntry P2: 1.2.0 or later
BioEntry R2: 1.2.0 or later
BioLite N2: 1.1.0 or later
XPass D2: 1.1.0 or later
OM-120: 1.1.0 or later
Secure I/O 2: 1.2.4 or later
DM-20: 1.1.4 or later

BioStar 2.6.4

New and improved features

Category

Setting

Functionality

= Support to set the same action for different triggers
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Compatible firmware
= BioLite Net: 2.3.5 or later
» BioEntry Plus: 2.3.4 or later
= BioEntry W: 2.3.4 or later
= Xpass: 2.4.4 or later
= Xpass S2: 2.4.4 or later
= BioStation 2: 1.6.2 or later
= BioStation A2: 1.5.1 or later
= BioStation L2: 1.3.2 or later
= BioEntry W2: 1.2.3 or later
= FaceStation 2: 1.1.1 or later
= CoreStation: 1.1.2 or later
= BioEntry P2: 1.1.2 or later
= BioEntry R2: 1.1.1 or later
= BioLite N2: 1.0.2 or later
= XPass D2: 1.0.2 or later
= OM-120: 1.0.0 or later
= Secure I/O 2: 1.2.1 or later
= DM-20: 1.1.2 or later

BioStar 2.6.3

New and improved features

Category Functionality

Setting = Support Admin Item Settings when configuring Custom Account Level

Compatible firmware
= BioLite Net: 2.3.5 or later
= BioEntry Plus: 2.3.3 or later
» BioEntry W: 2.3.3 or later
= Xpass: 2.4.4 or later
= Xpass S2: 2.4.4 or later
= BioStation 2: 1.6.1 or later
» BioStation A2: 1.5.1 or later
= BioStation L2: 1.3.1 or later
= BioEntry W2: 1.2.1 or later
» FaceStation 2: 1.1.1 or later
= CoreStation: 1.1.1 or later
= BioEntry P2: 1.1.1 or later
= BioEntry R2: 1.1.0 or later
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= BioLite N2: 1.0.2 or later

» XPass D2: 1.0.1 or later

= OM-120: 1.0.0 or later

= Secure I/O 2: 1.2.1 or later
= DM-20: 1.1.2 or later

BioStar 2.6.2

New and improved features

Category Functionality

User = Support the user information export/import by using the external
storage (USB)

Video = Support the real-time video monitoring

Monitoring = Support the event log import by using the external storage (USB)

Compatible firmware
= BioLite Net: 2.3.5 or later
» BioEntry Plus: 2.3.3 or later
= BioEntry W: 2.3.3 or later
= Xpass: 2.4.4 or later
= Xpass S2: 2.4.4 or later
= BioStation 2: 1.6.1 or later
= BioStation A2: 1.5.1 or later
= BioStation L2: 1.3.1 or later
= BioEntry W2: 1.2.1 or later
= FaceStation 2: 1.1.1 or later
= CoreStation: 1.1.1 or later
= BioEntry P2: 1.1.1 or later
= BioEntry R2: 1.1.0 or later
= BioLite N2: 1.0.2 or later
= XPass D2: 1.0.1 or later
= OM-120: 1.0.0 or later
= Secure I/O 2: 1.2.1 or later
= DM-20: 1.1.2 or later

BioStar 2.6.0
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New and improved features

Category Functionality

= Support the Daylight Saving Time(DST)

= Support the database encryption key management
= Support the system ports setting

= Support the system logs management

= Firmware upgrade notifications supported

= Change the license policy

General

= Support for the auto-Increase User IDs

= Support the iCLASS Seos card setting

= Support the hexadecimal values for the primary and secondary site keys
on the smart card

User & Card = Wiegand card search supported from the Unassigned card menu

= Support for automatic deletion of user information when issuing an AoC
card

= Wiegand Legacy Mode Support

= Blacklist card deletion support

= Support BioLite N2

= Support XPass D2

= Support BioMini Plus 2

Device = Support the user information and log deletion when a tamper event
occurs (secure tamper)

= Device reset excluding network settings

= Wiegand In/Out Support

= Support the interlock zone

Zone

= Support the muster zone
Video = Support MS SQL for Video log

= Support the video file storage management
Monitoring = Add door column to event log list

Compatible firmware
= BioLite Net: 2.3.3 or later
= BioEntry Plus: 2.3.3 or later
» BioEntry W: 2.3.3 or later
= Xpass: 2.4.3 or later
= Xpass S2: 2.4.3 or later
» BioStation 2: 1.6.0 or later
= BioStation A2: 1.5.0 or later
= BioStation L2: 1.3.0 or later
= BioEntry W2: 1.2.0 or later
» FaceStation 2: 1.1.0 or later
= CoreStation: 1.1.0 or later



1 BioStar 2 Overview

= BioEntry P2: 1.1.0 or later
= BioEntry R2: 1.1.0 or later
= BioLite N2: 1.0.0 or later

= XPass D2: 1.0.0 or later

= OM-120: 1.0.0 or later

= Secure I/O 2: 1.2.1 or later
= DM-20: 1.1.2 or later

BioStar 2.5.0

New and improved features

Category Functionality

= Setting https as the default communication protocol

General
= Oracle Database not supported

= Supports CoreStation

= Supports BioEntry P2

Device = Supports BioEntry R2

= Supports the enrollment of a fingerprint from the slave device(BioLite
Net does not support this feature)

Zone = Supports Intrusion Alarm zone (Local)

= Event Log, Real-time Log: T&A Key column added
Monitoring = Event Log: Supports the period setting
= Supports video log

= Supports NVRs (ACTi, Dahua, Hikvision)

Video
= Supports IP cameras

= Alert: Network disconnection detection alert added

Settin
9 - Supports Audit Trail

Compatible firmware
= BioLite Net: 2.3.3 or later
» BioEntry Plus: 2.3.3 or later
» BioEntry W: 2.3.3 or later
= Xpass: 2.4.3 or later
=  Xpass S2: 2.4.3 or later
= BioStation 2: 1.5.0 or later
» BioStation A2: 1.4.0 or later
= BioStation L2: 1.2.3 or later
= BioEntry W2: 1.1.4 or later
= FaceStation 2: 1.0.3 or later
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CoreStation: 1.0.0

or later

BioEntry P2: 1.0.0 or later
BioEntry R2: 1.0.0 or later

BioStar 2.4.1

New and improved features

Category Functionality

General

Supports Mobile Card (NFC, BLE)

Device

Supports FaceStation 2

Time & Attendance ]

Enhanced UI/UX

Merge the time card with T&A report

Display of daily T&A records

Time rate setting is excluded from the time code for leave management.
Break time is displayed on the time slot when fixed work is used.

It is possible to set the Min. Duration and Punch in Time Limit when
flexible work is used.

Setting

Supports Face Group Matching

Compatible firmware
BioLite Net: 2.4.0 or later
BioEntry Plus: 2.4.0 or later
BioEntry W: 2.4.0 or later
Xpass: 2.4.1 or later

Xpass S2: 2.4.0 or later
BioStation 2: 1.4.0 or later
BioStation A2: 1.3.0 or later
BioStation L2: 1.2.2 or later
BioEntry W2: 1.1.2 or later
FaceStation 2: 1.0.0 or later

BioStar 2.4.0

New and improved features

Category

General

Functionality

Supports elevator management
Supporting Oracle Database 11g, 12c
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= Supports OM-120
Device = Supports card USB device (DUALi DE-620)
= Supports secure communication between BioStar 2 and a device

Time & Attendance = Supports time & attendance report PDF export

= Change of detailed custom permission setting
Setting = Supports user ID type setting (numbers/alphanumeric characters)
= Supports dd/mm/yyyy date format

Compatible firmware
= BioLite Net: 2.4.0 or later
» BioEntry Plus: 2.4.0 or later
= BioEntry W: 2.4.0 or later
= Xpass: 2.4.0 or later
= Xpass S2: 2.4.0 or later
» BioStation 2: 1.4.0 or later
» BioStation A2: 1.3.0 or later
= BioStation L2: 1.2.2 or later
= BioEntry W2: 1.1.2 or later

BioStar 2.3.0

New and improved features

Category Functionality

= Supporting a low-resolution monitor

General -
= Improvement in list page move

User = Improvement importing/exporting CSV files

= Supporting BioStation A2 video phone (SIP based)
Device = Supporting the batch editing the device manager
= Supporting an additional information display of a device firmware

Door = Supporting an automatic door setting

= Supporting Wiegand card's facility code setting

= Supporting the batch editing the Wiegand card data format

» Supporting BioStar 2 alert sound's upload and setting (.wav, .mp3)
= Supporting the custom account level (up to 32)

Setting

Compatible firmware
= Biolite Net: 2.3.0 or later
» BioEntry Plus: 2.3.0 or later
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= BioEntry W: 2.3.0 or later

= Xpass: 2.3.0 or later

»  Xpass S2: 2.3.0 or later

= BioStation 2: 1.3.0 or later
= BioStation A2: 1.2.0 or later
» BioStation L2: 1.1.0 or later
= BioEntry W2: 1.0.0 or later

BioStar 2.2.2

New and improved features
= BioEntry W2 support

Compatible firmware
= BioLite Net: 2.2.3 or later
» BioEntry Plus: 2.2.3 or later
»  BioEntry W: 2.2.3 or later
= Xpass: 2.2.3 or later
= Xpass S2: 2.2.3 or later
= BioStation 2: 1.3.0 or later
= BioStation A2: 1.1.0 or later
= BioStation L2: 1.0.0 or later
= BioEntry W2: 1.0.0 or later

BioStar 2.2.1

New and improved features
= BioStation L2 support
= Long-term idle user management
= Access control privilege management per user
= Automatic database backup
= Enrollment device management
= Custom user fields

Compatible firmware
= BioLite Net: 2.2.3 or later
= BioEntry Plus: 2.2.3 or later
» BioEntry W: 2.2.3 or later
= Xpass: 2.2.3 or later
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= Xpass S2: 2.2.3 or later

= BioStation 2: 1.3.0 or later
» BioStation A2: 1.1.0 or later
= BioStation L2: 1.0.0 or later

BioStar 2.2.0

New and improved features
= BioStation A2 support
= Access On Card
= Secure Credential Card
= Global Anti-passback zone
= Image Log

Compatible firmware
» BioLite Net: 2.2.3 or later
= BioEntry Plus: 2.2.3 or later
= BioEntry W: 2.2.3 or later
= Xpass: 2.2.3 or later
» Xpass S2: 2.2.3 or later
= BioStation 2: 1.2.0 or later
= BioStation A2: 1.0.0 or later

BioStar 2.1.0

New and improved features
= BioStar API
= DM-20 support
= Global Anti-passback zone / Local Fire Alarm zone / Local Anti-passback zone
= More secure login password
= License management
= BioStar 2 Cloud support
= BioStar 2 Mobile support
= Zone status monitoring

Compatible firmware
= BioLite Net: 2.0.4 or later
» BioEntry Plus: 2.0.4 or later
=  BioEntry W: 2.0.4 or later
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= Xpass: 2.0.4 or later
= Xpass S2: 2.0.4 or later
= BioStation 2: 1.0.1 or later

BioStar 2.0.1

New and improved features
= BioStation 2 support
= Wireless LAN configuration
= T&A configuration
» Interphone configuration
» Display and sound configuration
= CSV import and export
= Multi-language resource support
= Memory optimization of BioStar 2 server

Compatible firmware
= BioLite Net: 2.0.0 or later
= BioEntry Plus: 2.0.0 or later
» BioEntry W: 2.0.0 or later
= Xpass: 2.0.0 or later
= Xpass S2: 2.0.0 or later

Before using BioStar 2 to implement an access control system, the BioStar 2 server must be installed on
the administrator PC.

The BioStar 2 server receives event logs, user information, etc. from connected devices and stores
them.

BioStar 2 can be installed easily. Before installation, please check the system requirements.
The BioStar 2 installation file can be found on the Suprema's home page(www.supremainc.com).

System Requirements

Installing BioStar 2

Minimum System Requirements

Devices
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2 Installation

= Windows 7 Home
Basic 64bit SP1 or
later

= Windows Server
2008 R2 Standard
64bit SP2 or later

= Windows Server
2008 R2 Standard
64bit SP2 or later

0S
= Windows 7 Home = Windows 7 Home = Windows 7 Home
Basic 32bit SP1 or Premium 64bit Premium 64bit
later SP1 or later SP1 or later
System MariaDB 10.1.10, MS SQL Server 2012, MS SQL Server 2014 SP2,
requirement Databas
MS SQL Server 2016 SP1, MS SQL Server 2017, MS SQL Server
(Server) € 2019
CPU 2 GHz Dual Core 4 GHz Quad Core 4 GHz 16 Core
RAM 8 GB 16 GB 32 GB
SSD 512 GB 1TB 1TB
Others Java 1.8.0_201
CPU 1 GHz 1 GHz 1 GHz
System
. RAM 4 GB 4 GB 4 GB
requirement
Client
( ) Web Google Chrome 75 or later
Browser

BioStar 2 Video Extension

Caon L wecmentes

CPU 4 GHz Quad Core 4 GHz Quad Core
RAM 8 GB 16 GB
HDD 2TB 4TB

Note

= For the best performance, use only the 64-bit operating system.

» BioStar 2 is optimized for Google Chrome.

» To use the Video menu, use the 64bits MariaDB or MS SQL database.

» BioStar 2 supports Windows 7, but Microsoft's technical support for Windows 7 has ended. Be

aware of the OS selection when installing the system.
= If you are using Windows 8.1 or Windows Server 2012 R2, install the KB2919355 update by
referring to the following web page.

https://support.microsoft.com/en-us/help/2919355/windows-rt-8-1--windows-8-1--and-

windows-server-2012-r2-update-april-2
» If MS SQL Server and BioStar 2 are installed on different PCs, you should install the Native
Client on a PC with BioStar 2 installed.
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2 Installation

https://www.microsoft.com/en-us/download/details.aspx?id=50402
Oracle Database is no longer supported. For details, please contact the Suprema Technical
Support.

Installing BioStar 2

BioStar 2 supports a 32-bit operating system and a 64-bit operating system. Check the system type of

your PC where BioStar 2 is to be installed and carry out its installation accordingly.

Note

Do not install BioStar 2 on a PC where BioStar 1 is installed. This may cause performance
problems.

If BioStar 2.3.0 is installed on top of a BioStar 2.2.1 or 2.2.2 installation, all information stored
in the SQLite database is migrated to a new MariaDB database.

Upgrading directly from the existing version to the latest version is possible from BioStar 2.6.0
or higher. If the installed version is lower than 2.6.0, installing all versions in a correct
sequence until reaching version v2.6.0 is essential.

2 22.1>23>24>24.1>25.0>26.xo0r2.7.x > 2.8
2.2 23>24>241>25.0>26.xo0r27x>28x

2.2.1 23>24>241>25.0>26.xo0r27x>28x

2.2.2 23>24>241>25.0>26.xo0r2.7.x>28x

2.3 2.4>24.1>250>26.xo0r 2.7.x > 2.8.x

2.4 2.4.1 > 2.5.0 > 2.6.xor 2.7.x > 2.8.x

2.5 2.6.xor 2.7.x > 2.8.x

2.6 2.8.x

2.7 2.8.x

If you are using Windows 8.1 or Windows Server 2012 R2, install the KB2919355 update by
referring to the following web page.
https://support.microsoft.com/en-us/help/2919355/windows-rt-8-1--windows-8-1--and-
windows-server-2012-r2-update-april-2

If you are using MS SQL 2014 Express, install the Service Pack 2 by referring to the following
web page.

https://www.microsoft.com/en-us/download/details.aspx?id=53168

If MS SQL Server and BioStar 2 are installed on different PCs, you should install the Native
Client on a PC with BioStar 2 installed.

https://www.microsoft.com/en-us/download/details.aspx?id=50402
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=  When backing up a database from an older version of BioStar 2, disable all services and
procedures. Furthermore, if you do not back up and restore the AC database and the TA
database together, you will not be able to use the TA database.

= If you want to back up the database of BioStar 2, be sure to also back up the enckey in the
W Program HRlesW BioStar 2 (x64 ) util folder and the system.conf and setting.conf
file in the W Program HlesYv BioStar 2(x64) folder. Otherwise, the database will be
unavailable.

» The default values for the ports used by BioStar 2 are as follows. If another program occupies
the same port, BioStar 2 may not work properly.

Port

+ HTTP Port Available + HTTPS Port Available

+ Web-socket Port Available « API Port Available

Available

+ T&A HTTPS Port Available + T&A Cloud Port

4
s

+ Database Port # | Available + T&A HTTP Port
rd Available
s

A YA YRASEAIEAY

+ AC Cloud Port Available + FastCGI Port Available

If you use a database configured by the user directly, check the following items before installing BioStar
2.

= MariaDB

= Open the my.cnf file and then change some configurations under
[mysqld] as shown below.

character-set-server=utf8
collation-server=utf8_unicode_ci
max_connections = 600

= Open the my.cnf file and then add some configurations under [mysqld]
as shown below.

log_bin_trust_function_creators = 1
group_concat_max_len = 102400

= Access MariaDB with the root permission and execute the following
command.

> GRANT SUPER ON. TO user_id@'localhost' IDENTIFIED BY "passwo
> GRANT SUPER ON. TO user_id@'%' IDENTIFIED BY "password";

= MS SQL Server



2 Installation

Setting the port

a)

b)

Run SQL Server Configuration Manager and set TCP/IP Protocol
for Protocols for SQLEXPRESS to the desired port number.
Restart SQL Server Services to apply the settings.

Creating the user and database

a)

Log in to the sa account using SQL Server Authentication in SQL
Server Management Studio.

Right-click on Security and click New Login.

Enter the desired name in the Login Name field and select SQL Server
Authentication.

Enter the desired password in the Password and Confirm password
field, and then uncheck the Enforce password policy.

Click OK to save the settings.

Right-click on Database and click New Database.

Enter the desired name in the Database Name field.

Enter the login name in the Owner field. Use the login name set in step
).

In the Database Fles section, we recommend that set the Initial Size
(MB) to 3000 and set the Autogrowth/Maxsize to By 10 MB,
Unlimited.

Setting the Windows Authentication database

1. Presetting

If you are using Microsoft Windows Active Directory, complete the presets as

below before setting up the Windows Authentication database.

a)

Log in to SQL Server Management Studio with an administrator
account.

Right-click on Security and click New Login.

Select Windows Authentication and click Search.

In the Select a user or group window, click Location, then select the
Active Directory path and click OK.

Enter the user name in the object name field, then click Check Names
> 0K

Click Server Roles in the Select a page.

Select sysadmin and click OK.

Click User Mapping in the Select a page.

Select ac, master, ta, ve and set the Default Schema to dbo.

Click OK to save the settings.

2. Setting the database

a)

Run SQL Server Configuration Manager and click Client Protocol
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under SQL Native Client Configuration.

b) Select TCP/IP and check the default port.

c) Click Protocols for SQLEXPRESS under SQL Server Network
Configuration.

d) Make sure that the ODBC port is set to the same as the default port in
TCP/IP.

e) Log in to SQL Server Management Studio by an administrator
account.

f) Click Security> Logins and then double-click NT AUTHORITY
W SYSTEM.

g) Click Server Roles in the Select a page.

h) Select public, sysadmin, and then click OK.

i) Click User Mapping in the Select a page.

j) Select the ac, master, ta, and ve databases and click OK to save.

1) Double-click the downloaded setup program. (ex. 'BioStar 2 Setup.x.x.x.xxx.exe')
2) Select a language and click OK.

Select Setup Language >
*; Select the language fo use during the installation:
English Lo

3) To continue the installation, select I accept the agreement and click Next.

k&4 Setup - BioStar 2(x64) — =

-
License Agreement
Please read the following important information before continuing.

Please read the following License Agreement. You must accept the terms of this
agreement before continuing with the installation.

Software End User License Agreement ~

SUPREMA INC.
SOFTWARE LICENSE AGREEMENT

PLEASE READ THE FOLLOWING TERMS AND CONDITIONS CAREFULLY
BEFORE INSTALLING OR USING THE SOFTWARE OR ANY ACCOMPANYING v

O I accept the agreement
(®1 do not accept the agreement

lext = Cancel
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4) Enter the password for admin account and click Next. The password set in this step will be used
when you log in to BioStar 2.

k&4 Setup - BioStar 2(x64) — =

Admin User
Enter the password for admin user.,

Username : admin

Password : | |

Confirm password : | |

1. It must contain between & and 16 characters.

2. It can contain only English letters, numbers from 0 to 8,
and certain spedal characters (e.qg. |, §, #, %).

3. It must contain at least one alphabet character and at least one number,

Warning
-Admin user password must be managed carefully not to be forgotten.

5) Install the database to be used in BioStar 2. You can install a new MariaDB or connect it to the
already-installed MariaDB. Installing BioStar 2 for the first time, please select Express Installation
and click Next.

&4 Setup - BioStar 2(x64) — >

Database installation type

Select a database type for BioStar 2. You can either install a new database or
connect the existing database.

Use this option for quick installation with the built-in MariaDB server,
The installer will automatically install the MariaDB database server
and create the database.

() Custom installation

Use this option to create database schema on an existing database

on a database server (MariaDB [ M350L) on the local or remote server.
Make sure that the database and user account are created and configured
before starting the installation.

6) If Express Installation has been selected from Database Installation Type, enter the database
manager’s account password and click Next. If Custom Installation has been selected from
Database Installation Type, enter the detailed information on the already-configured database
and click Next.
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&4 Setup - BioStar 2(x64) - d

Express Installation
Enter the password for database root account.

Username : root

Password : | |

Confirm password : | |

1. It must contain between & and 16 characters.

2. It can contain only English letters, numbers from 0 to 9,
and certain special characters (e.q. !, §, #, %).

3. Enter the existing root account password when uparading the server.

\Warning
“Root account password must be managed carefully not to be forgotten.
-Root account password is also used as the initial AC, TA, Video DB passwords.
-When the password is lost, it will not be able to make a version upgrade

and DB backup/recovery.

k&4 Setup - BioStar 2(x64) — =
Custom installation

If you choose database type, you must enter the Root privilege account
information,

DE Type :

Server IP : VE DB name : I:I
severport: [ | veusemame: [ ]
acomname: [ | VEPmswrd: [ ]

TA Username : I:l Check the database connection
TA Password : I:I Generate the database tables

Note

» BioStar 2.8.8 supports the following databases.
- MariaDB 10.1.10
- MS SQL Server 2012
- MS SQL Server 2014 SP2
- MS SQL Server 2016 SP1
- MS SQL Server 2017
- MS SQL Server 2019
= If the database table creation fails when MS SQL Server is set as the Database Type, you
can create the table by executing the script in C:¥W Program Fles'v BioStar 2 (x64)
W dbscriptW mssql folder.

7) Click Next after setting a path for BioStar 2 to be installed.

38



2 Installation

&4 Setup - BioStar 2(x64) - d

Select Destination Location
Where should BioStar 2{x64) be installed?

Setup will install Biostar 2(x64) into the following folder.

To continue, dick Mext. If you would like to select a different folder, dick Browse.

C: WProgram FilesWBioStar 2(x64) Browse...

At least 206.4 MB of free disk space is required.

8) Click Next after setting a path for the encryption key to be stored.
L& Setup - BioStar 2(x64) - X

Encrypt Key Storage Directory
Select the location to store the encrpyt key

'Select a folder to store the encrypt key and dick ‘Next'

To continue, click Next, If you would like to select a different folder, click Browse.

Browse, .

Warning
Select the path where the encrypt key file will be stored,
Please do not alter the file once the location is set,

< Back Canceal

Note

» You can set a path for the encryption key to be stored. However, if the encryption key file is
modified or moved after selecting the path, a system error may occur.
= If you delete BioStar 2, the encryption key files will be deleted.

9) Read the instructions on the responsibility for protecting personal information stored in the
database and click Next to continue the installation.
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&4 Setup - BioStar 2(x64) — >

Responsibility for protecting personal information

Please be aware the system administrator has the responsibility to comply with the
applicable laws of each country when using personal information, biometric data
or any other stored material. To protect the data stored in the database, itis
recommended to use the Encrypt Personal Data on Database option,

10) Enter the port number and click Next.

&4 Setup - BioStar 2(x64) — >

Port Setting
Port Setting Enter a valid port number,

HTTPS Port for Web Server

Enter the desired port number between 10 and 65534,
The default port number is 443,

Availability: Ok

Device Port for Communication

Enter the desired port number between 10 and 65534,
The default port number is 51212,

51212 | Awailability: OK

Note

=  When you install BioStar 2 on a PC where BioStar 1 is installed, the device port (51212) is not
available. In this case, we recommend that uninstall BioStar 1.

9) Select a component of BioStar 2 and click Next. If you select USB Device Agent, a USB-Agent and
a driver for using BioMini, BloMini Plus 2, and DUALi DE-620 will be installed together.
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&4 Setup - BioStar 2(x64) - d

Select Components
Which components should be installed?

Select the companents you want to install; dear the components you do not want to
install, Clidk Next when you are ready to continue.

Full installation e

BinStar 2 2,306.9 MB
2,306.9 MB

USE Device Agent

Current selection requires at least 2,455.0 ME of disk space.

10) If ready to install, click Install.

&4 Setup - BioStar 2(x64) - d

Ready to Install
Setup is now ready to begin installing BioStar 2(x54) on your computer.,

Click Install to continue with the installation, or dick Back if you want to review or
change any settings.

Destination location:
C:%Program FilesWBioStar 2(x54)

Setup type:
Full installation

Selected components:
BioStar 2
Server
USE Device Agent

< Back Install Cancel

11) Select whether to install additional program and click Finish. Follow on screen instructions to
complete.

41



2 Installation

&4 Setup - BioStar 2(x64)

Completing the BioStar 2(x64)
- Setup Wizard

Setup has finished installing BioStar 2(x64) on your computer,
The application may be launched by selecting the installed
shortcuts.

Click Finish to exit Setup.

Note

= The USB Device Agent Certificate provided can be applied to a local network only.

= When another program uses port 443, BioStar-Setting program will be launched automatically
and then you can change the port nhumber. For more information, see Changing port of
BioStar 2.

= For more information on Database setting changes, see BioStar 2 Database Change.

BioStar 2 is a web-based system which can be accessed from anywhere as long as you remember your
login ID and password.

1) Run your web browser.
= We recommend that you use Google Chrome 75 or later.

2) Run BioStar 2.
= If running from the PC installed with BioStar 2, enter 'https://127.0.0.1" in the address input
field of the web browser.
= If BioStar 2 is installed on another PC, enter 'https://BioStar 2 server IP address' in the address
input field of the web browser.
= Do not use the 'Localhost' to access the BioStar 2.

Note

» BioStar 2 uses port 443. If port 443 is used by a program, quit the program and try again. If
the program cannot be closed, run 'Biostar Setting' to change the port number. For more
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3)

4)

5)

6)

7)

8)

information, see
» BioStar 2 uses Java version 1.8.0_201. If BioStar 2 does not run correctly, re-install Java
version 1.8.0_201.

Log in with the administrator account. The administrator account ID is ‘admin” and when you log in
for the first time, Not secure warning will be displayed in the address bar.

A Not secure | be7E://127.0.0.1/%/login

To use HTTPS properly, register the IP address of the PC where BioStar 2 is installed. Click
Download https certification install program.

Unzip the downloaded file and run cert-register.exe file. Enrollment Certification window will

appears.

Enter the IP address of the PC where BioStar 2 is installed and click Enroliment.

-

Enroliment Certification

Server Address :

Cancel

Check the security warning message and click Yes.

When you restart the web browser and enter the registered IP address, Secure will appear on the
address bar of the web browser.

8 Secure | https:// LR el L 45/% /login

Changing server status of BioStar 2

You can check the status of the BioStar 2 server and stop or start the server.

1)

Click @Start > All Programs > BioStar 2 > BioStar Setting.
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—Service Status
IThe Core Web Server service has been started. I Running Stap
—— 1
IThe BioStar 2 service has been started. I Running Stop
e :
[Fea] - :
- IThe T&A Web Server service has been started. I Running Stop
e
IThe Video Server service has been started. I Running Stop
e il
—Web Server Configuration
% HTTPS Port |443
s
—Database Server Configuration
DB Type IMaria DB
Host |12?.D.D.1 Port |3312
Database Name Database User Database Password
AC IbinsL—clrE_ac Ibiusﬁrz_ac_user FEEA
TA Ibiosﬁr_tna Ibiomrtnauser FE R
Video Ibinsl:clr_\.re Ibiusﬁweuser FE A
Test Connection | Save |
2) Click Stop button of the server you want to stop.
— Service Status
IThe Core Web Server service has been started. I Running Stap
L]
—h—
IThe BioStar 2 service has been started. I Running Stap
—h—
IThe Ta&A Web Server service has been started. I Running Stap
—
IThe Video Server service has been started. I Running Stop
—

3) Click Start button to restart the server.
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Service Status

‘T:".e Core Web Server service has been stopped. I Stopped Start

——

‘T:“.e Bio5Star 2 service has been started. I Running Stop

|
'-
I

=
=

‘T:“.e T&A Web Server service has been started. I Running Stop

|
'-
I

‘T:".e Video Server service has been started. I Running Stop

|
'-
I

Note

» If the time setting on the BioStar 2 server has changed, stop and restart the Core Web
Server. Otherwise, BioStar 2 may not work properly.

Changing port of BioStar 2
You can change the port used by BioStar 2.

Note

» If you use MS SQL as a database, when changes the port in BioStar 2, you must also change
the port manually in the database. Otherwise, BioStar 2 may be disconnected from the
database and may not work properly.

Changing with BioSar Setting (HTTPS port)

1) Click @Start > All Programs > BioStar 2 > BioStar Setting.
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e 0 )

—Service Status
IThe Core Web Server service has been started. I Running Stop
—
—t—
IThe BioStar 2 service has been started. I Running Stop
—ah :
- IThe T&A Web Server service has been started. I Running Stop
—t
IThe Video Server service has been started. I Running Stop
—t—
~Web Server Configuration
% HTTPS port 443
”
— Database Server Configuration
DB Type |Maria DB
Host |12?.n.n.1 Port |3312
Database Name Database User Database Password
AC Ibins’GrE_ac IbiusGrE_ac_user I**””*“
TA Ibiustdr_tna IbiusL—drtnauser FEEEEmE
Video Ibins'l.—dr_ve Ibiusl.?rveuser FEEEREREE
Test Connection | Save |
2) Click Stop button of Core Web Server.
3) Enter the port number in HTTP port field.
—Service Status
IThe Core Web Server service has been stopped. I Stopped Start
—
The BioStar 2 service has been started. Running Sto
—— : P
—
- IThe T&A Web Server service has bean started. I Running Stop
—
The Video Server service has been started Runnin St
——1 I = I g op
—
~Web Server Configuration
% HTTRS Port | 443
Y 4

4) Click Start button of Core Web Server.
5) Run BioStar 2.
» If using port 450, enter 'IP address::450".
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Changing with BioStar 2 for all port

Note

= The items may vary depending on the type of license that is activated.

1) Log in to BioStar 2 and click on the port. All ports in use in BioStar 2 are
displayed.

Port

* HTTP Port Available * HTTPS Port # | Available
* Web-socket Port Available * API Port # | Available
+ Database Port

* T&A HTTPS Port Available * T&A Cloud Port # | Available

I'd

I'd

# | Available * T&A HTTP Port # Available
I

s

* AC Cloud Port Available - FastCGI Port # | Available

2) Click the # of the port to change and enter the desired value.
3) Click Apply to save the settings.

Changing database of BioStar 2

You can change the database settings of BioStar 2.

1) Click @Start > All Programs > BioStar 2 > BioStar Setting.



3 Login

—Service Status
IThe Core Web Server service has been started. I Running Stop
e it
IThe BioStar 2 service has been started. I Running Stop
—t :
m fi i il
- IThe T&A Web Server service has been started. I Running Stop
—t
IThe Video Server service has been started. I Running Stop
——
—Web Server Configuration
% HTTPS Port |443
s
—Database Server Configuration
DB Type IMaria DB
Host |12?.D.D.1 Port |3312
Database Name Database User Database Password
AC Ibinsl]rE_ac Ibius’GrE_ac_user FEEA
TA Ibios‘L—dr_tna Ibios‘L—drtnauser FE R
Video Ibinsﬁr_\.fe Ibius’l]r'.feuser FE A
Test Connection | Save |

2) Click Stop button of Core Web Server and Core Web Server. Database Server Configuration will be

enabled.
—Database Server Configuration
DB Type | Maria DB
Host |12?-U-0-1 Port |3312
Database Name Database User Database Password
AC IbiosGrz_ac Ibios’mrz_ac_user EHRE LR
TA Ibiusiar_tna IbiosGrtnauser R
Video IbiosGr_ve IbiOSGrveuser wak
Test Connection | Save |

3) Edit the necessary fields. If you are not sure about the each information, contact your system
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administrator.
4) Click Test Connection to check if the database has been set properly.
5) Click Save to save the settings.

BioStar 2 provides web-based services and various functions concerning access control.

Access groups configured in BioStar 2 refer to access privileges. An access group can be configured
using a combination of user, access level and door (device) information.

Below is a step-by-step guide on how to use BioStar 2.

Q Step 1. Register Activation Key

You can use more features by registering the activation key after purchasing the BioStar 2 license.

Related Information

Q Step 2. Adding Devices

Add devices to connect to BioStar 2. You can set up an authentication mode for each device type or
assign an administrator to each device.

You can also configure actions to be performed according to various events (authentication failure,
duress fingerprint authentication, Anti-passback violation, etc.) occurring in the device.

(® Related Information

Q Step 3. Adding and Configuring Doors

Add the information on the doors installed with devices. You can configure relay, Anti-passback, dual
authentication, alarm, etc.

(® Related Information
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Q Step 4. Configuring Access Levels

You can create an access level by combining door and schedule information. Multiple doors and
schedules can be registered to a single access level.

& Related Information

Q Step 5. Configuring Access Groups

You can create an access group by combining access level (doors and schedules) and user information.
Multiple access levels and users can be registered to a single access group.

& Related Information

Q Step 6. Adding Users

Add the information to use for access control such as user information, fingerprints, etc. User
information can be registered directly on the device or on the PC running BioStar 2. You can also fetch
the user information registered within the device to BioStar 2 or transfer the user information registered
within BioStar to the device.

(® Related Information

O Step 7. Zone Configuration

You can configure anti-passback and fire alarm zone. The fire alarm can be set to local zone and global
zone. Only available when purchasing a standard license.

Related Information
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Q Step 8. Viewing Logs

You can view event logs, device status, door status and alert history, or just view the real-time log

information.

® Related Information
Event Log
Real-time Log
Device Status
Door Status

Alert History

The DASHBOARD gives you an overview of the major event status, usage status, notice, alarms, etc.

Dashboard
Overview Year Month Week
November 2018 ~ October 2019
10
8
1 6 -
4 .
® Accessdenied (v ©
2 Access denied(inva.. ¢
Tamper on 5
° e s
NOV DEC JAN FEB MAR APR MAY JUN JuL AUG SEP ocT
Usage Notice
B9 - What's new with BioStar 2.7.10
)
:—a (8 © 2) (2) (2) (&
()] =/ " 4
User Fingerprint Face Card Device Door Zone Access Group
10 2 1 1 6/1000 3/1000 11000 2
r  Missed Alarm
3 2019/10/3015:03 BioEntry P2 541611123 Tamper on
2019/10/30 14:53 Xpass D2 Keypad 330000007 User 04 Access denied (Invalid access group)
2019/10/3014:52 Xpass D2 Keypad 330000007 User 04 Access denied (Invalid access group)

1 Alert Event Status by Period < Notice

z Usage Status £ Alert List
Missed Alarm
Note

= You can set what to display in "Alert Event Status by Period" in the Setting > Alert.
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= 15 alarms that have been missed in the last 6 months are displayed in 'Missed Alarm' in the
latest order.
= You can view the list of monitored alerts and write notes by clicking the alert list icon.

Alert List X

| viewsisory | ®E (0 BE [P

[l 2016/07/25 10:59 BioLiteNet 538101276 RS-485 disconnected
O 2016/07/25 10:58 BioStation 2 546832590 (192.168.16.108) kyle Access denied (Invalid access group)
I:‘ 2016/07/25 10:55 BioStation A2 541531008 (192.168.16.20... Tamper on

Related Information

Alert History

You can use the DEVICE menu to add, delete or edit registered devices, fetch the user information
registered within the device to the server or upgrade the firmware.

Adding and Managing Device Groups
Basic Search and Registration

Advanced Search and Registration
Wiegand Device Search and Registration
Slave Device Search and Registration
Managing Users Registered with Devices
Upgrading Firmware

Editing Device Settings and Information
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- 2 3 4
! %:—:/.JDevices X " sorons ~ | [ea |
s | , (>
All Devices
E E‘OS[.E-‘M v f‘usmmgf 546832506 BioStation 2 546832506 All Devices BioStation 2 Hormal
g corestalion S0 1aadannos 542501048 BioStation L2 542501048 ( All Devices BioStation L2 192.168.14.125 HNormal
7 — . BioStation 2 546832506
123400068 CoreStation 40 123400068 (...  All Devices CoreStation 40 III 192.168.14.124  Normal
Waiting Device
USB Device
6
. Function Button (Delete Data & Sync
1 Basic Search t ) . )
Device, Print, Column Setting)
z Advanced Search € Device List
> Page Navigation Buttons and Number of List Rows 7 Device and Group List
< Registered Device Search ¢ Expand Button
Note

Registered devices can be searched by ID, Name, IP Address.
Only BioMini can be connected as USB device.

When you select a device on the list, you can use the following functions.

Reconnect: Reconnects the selected device. This function is available when only one device
is selected.

Sync Device: Synchronizes the user and access control information from BioStar 2 with the
registered devices. The synchronization will occur based on the information on the server
database, and the users that exist on the devices only will be deleted. Click Manage Users in
Device to retrieve users from the device to the BioStar server.

Delete Data & Sync Device: You can delete user related data including users, access
groups and schedules on the device and transfer the data on the server to the device. On the

device list page, select the target devices, click the Function button (| *** ) and choose the
Delete Data & Sync Device.

Batch Edit: Edits the information on multiple devices at once. This function is available only
when multiple devices are selected.

Manage Users in Device: Uploads the user information registered with the device to BioStar
2 or deletes it.

Armware Upgrade: Easily upgrades the firmware of the device.

Delete Device: Deletes the selected device from the list. You cannot delete a device that is
set as a door or a zone.
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Adding and Managing Device Groups
You can register device groups for easy management of multiple devices. Name your device groups
according to installation locations of the devices for greater convenience.
= Adding Device Groups

1) Click DEVICE.
2) Right-click on All Devices and click Add Device Group.

All Devices

Add Device Group

3) Enter a name.

Note

» Device groups may be created in up to 8 levels.
= Up to 48 characters may be entered for a device group name.
= Renaming Device Groups

1) Click DEVICE.
2) Right-click on the name of a group you wish to rename and click Rename

Device Group.
All Devices
16F
Add Device Group
276 (1!
Rename Device Group
01268

Delete Device Group

Walling Uevice

3) Enter a name.

Note

= Up to 48 characters may be entered for a device group name.

= Deleting Device Groups
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1) Click DEVICE.
2) Right-click on the name of a group you wish to delete and click Delete Device
Group.

All Devices

16F

Add Device Group

Rename Device Group

Delete Device Group

276 (1

01268

ing vevice

Note

Basic Search and Registration

Deleting a group deletes all devices included in the group.

You can automatically search for devices connected to BioStar 2 and register them. Before searching for
devices, check whether they are correctly connected. When adding multiple devices at once, it will be
more convenient to know the location, ID and IP address information of each device in advance.

1) Click DEVICE > SEARCH DEVICE.
2) All available devices are shown. When the user ID type is mismatch with BioStar 2, the user ID type
of the device will be automatically changed according to BioStar 2.

Search Device X

Found 7 device(s). 2 device(s) have invalid IP addresses.

m oy
541531041
546832590

546832437

541531014

o o oo o

539308127

544708056

542501008

BioStation A2 541531041 (..

’

BioStation 2 546832590 (19... ##

BioStation 2 546832437 (19.. ¢

BioStation A2 541531014 (..

BioEntryPlus 539308121 (1
BioEntry W2 544108056
(192.168.16.238)

BioStation L2 542501008
(192.168.16.231)

' 4

g

All Devices

All Devices

All Devices

All Devices

All Devices

All Devices

All Devices

Device Type
(Master/Slave)

BioStation A2 [[]

Biostation2 [
BioStation 2

Biostation A2 [T

BioEntryPlus [

BioEntry w2 [

BioStation L2

IP Address

192.168.16.179

192.168.16.196

192.168.16.192

192.168.16.160

192.168.16.239

192.168.16.238

192.168.16.231

(192.168.1.23)

N/A
(192.168.1.23)

« 23
g e

Connectable.
Connectable.
Connectable.
Connectable.

Connectable.

Connectable.

Connectable.

3) To view newly found devices only, click ¥ and then click Show New Devices Only.
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Search Option

Show Mew Devices Only

.Timeout{sec)| 3 |

Note

= To hide devices which do not respond within a set period of time, click ¥ and then enter a
duration in Timeout(sec).

= If the devices you are looking for are not shown on the list, click Search to search for the
devices again.

4) You may change the Name and Group of a device found to anything you like. If the IP address of
the device cannot be used or otherwise needs to be changed, click Set IP to change it.

5) To use a dynamic IP address, select Use DHCP. To manually enter the IP Address, Subnet Mask
and Gateway, deselect the option. To enter the BioStar 2 network information, select Device —
Server and enter the Server IP and Server Port.

Set IP X

1] Device Type

Use DHCP
538102578 BioLiteNet

« IP Address 192.168.16.207
« Subnet Mask 255.255.255.0
+ Gateway 192.168.16.1

+ Device Port | 51211 |

Device - Server Connection

« Server IP | 192.168.1.6 |

+ Server Port | 51212 |

Apply \ ‘ Cancel

6) To save the IP settings, click Apply.
7) To register the configured device, click Add.
8) Select the registered device, and click Sync Device.

Note

» If you add a new device, the key of the device changed to the value of the data encryption key
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on the server. All user data on the device will be deleted when the key is changed.
» If you want to delete user related data including users, access groups and schedules on the
device and transfer the data on the server to the device, click the Delete Data & Sync

Device. On the device list page, select the target devices, click the Function button (' *** ) and
choose the Delete Data & Sync Device.

» After registering a device, you can edit its details by referring to Editing Device Settings and
Information.

» To register all waiting devices in the Waiting Device group, right-click on the group name
and click Add All Waiting Devices. To register each device, right-click on the device name
and click Add Waiting Device.

» If a different user ID type is set for BioStar 2 and a device, change the device setting
according to the user ID setting of BioStar 2.

= If the user ID type of BioStar 2 is set with alphanumeric characters, some devices may not be
used and/or limitations may occur. For more details, refer to Server.

Advanced Search and Registration

You can register a device by specifying its IP address and port number.

1) Click DEVICE > ADVANCED SEARCH.

2) Enter the IP address and port number of a device to search.

3) Click Search to view the list of devices found. If the device you are looking for is not shown on the
list, click Search to search again.

Advanced Search *

538101276 BioLiteMNet 538101276 (192.168.1. BE 23 BioLiteMet 192.168.16.230

Cancel

4) Select a group to add the found device to and click Add.
5) Select the registered device, and click Sync Device.

Note

» After registering a device, you can edit its details by referring to Editing Device Settings and
Information.
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Wiegand Device Search and Registration

You can easily add Wiegand devices connected to master/slave devices.

1) Click DEVICE.

2) Right-click on the name of a master/slave device to search for Wiegand devices and click Add
Wiegand Device.
3) The list of Wiegand devices connected to the master/slave device is shown.

Add Wiegand Device X

DoorModule20 200000013 has 2 wiegand Device(s).

Wiegand Index

0 Wiegand Reader 0 (1273741837) rd

1 Wiegand Reader 1 (2347483661) rd

[ Add \ ‘ Cancel

4) Select the device to add, and click Add.

Slave Device Search and Registration

You can easily expand your access control system network by adding slave devices to existing master
devices. Master devices and slave devices can be connected together via RS-485. Besides regular
devices, additional devices such as Secure I/O can be connected.

1) Click DEVICE.

2) Right-click on the name of a master device to search for slave devices and click Search Slave
Device.

3) The list of slave devices connected to the master device is shown. If the devices you are looking for
are not shown on the list, click Search to search for the devices again.
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Search Slave Device x

D 538101268 BioLiteNet 538101268 BioLiteNet

BioLiteNet 538101276 (192.168.16.230) has 1 slave Device(s).

Cancel

4) Select a group to register the device to and click Add.

Note

= If the fingerprint authentication device is the master device, FaceStation 2 cannot be added as
a slave device.

= FaceStation 2 cannot be added as a slave device with a different device. FaceStation 2 must
be added separately.

» If FaceStation 2 is the master device and a different slave device has been added already,
FaceStation 2 cannot be added as a slave device.

= When you connect FaceStation 2 as a slave device while FaceStation 2 is the master device,
only one FaceStation 2 can be added as a slave device.

Managing Users Registered with Devices

You can see the number of users, fingerprints, faces, and cards stored in the device.
You can compare the user information stored in the device with the user information registered in
BioStar 2, transfer the information to BioStar 2 or delete the information.

Note

= The Manage Users in Device function is available only when one device is selected.

1) Click DEVICE.
2) Select a device and click Manage Users in Device. A comparison of the user information
registered within the device and the user information registered within BioStar 2 is displayed.
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Manage Users in Device X

BioStation A2 541531008 (192.168.14.223)

&) G2 )01 [ s0rows » |
Q54 fipe @0 A i All Users | | Different Users | Upload | | Delete |
|
|:| 50 0 ] Device Default Mew User
D 49 0 0 Device Default Mew User
|:| 48 0 0 Device Default Mew User
|:| 47 0 0 Device Default Mew User
|:| 46 0 0 Device Default Mew User
D 45 0 0 Device Default Mew User
D 44 0 0 Device Default Mew User
[ ] 43 0 0 Device Default New User
Close

= Same: The user's information is the same as the information registered within BioStar 2.
» Different: The user's information is different from the information registered with BioStar 2.
= New User: The user has not been registered with BioStar 2.

3) After selecting user information, click Delete to delete it or click Upload to upload it to BioStar 2.
When you click Upload, if BioStar 2 contains user information of the same ID, it can be updated
with the information in the device.

Note

= After registering a device, you can edit its details by referring to Editing Device Settings and
Information.

=  When you delete user information, it is only deleted from the device and the information in
BioStar 2 remains intact.

Upgrading Firmware

You can easily upgrade the firmware on any device connected to BioStar 2 without any additional
connection or action.
Copy the firmware files that you have downloaded to the following folder. If the folder does not exist,
you need to create it.

» 32-Bit Operating Systems: C:¥ Program FilesW BioStar 2W firmware
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64-Bit Operating Systems: C:W Program Files (x86)W BioStar 2W firmware

1) Click DEVICE.

2) Select a device and click Armware Upgrade. Multiple devices of the same type can be batch

upgraded.

Firmware Upgrade X

BioStation 2 546832590 (192.168.16.108)

Firmware Version

BioStation 2 (BS2-OMPW) 1.3.0 [2016/07/07 16:31]

BioStation 2 (BS2-OMPW) 1.2.0 [2016/02/04 17:43]

‘ Close |

3) Click the firmware version to start the upgrade.

Note

It is possible to upgrade a number of devices with the same RS-485 mode simultaneously. For
example, a number of master devices can be upgraded simultaneously and a number of slave

devices can be upgraded simultaneously as well.

It is possible to upgrade a number of master devices or slave devices that have no master

device simultaneously.

It is not possible to upgrade a number of slave devices which is connected to the same

master device simultaneously.

(® Related Information

Information

Editing Device Settings and Information

You can edit detailed information of registered devices. For more information on registering devices,

see Basic Search and Registration or Advanced Search and Registration.

The details shown may vary depending on the RS-485 connection type or the device type.

1) Click DEVICE.
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2) Click a device on the device list to edit.

3) Edit the fields by referring to Information, Network, Authentication, Advanced Settings, DM-20 , OM-
120, CoreStation and Wiegand Device.

4) To edit information of multiple devices, select multiple devices and click Batch Edit.

Device Batch Edit X

Devices (2)

+ Use DHCP Use DHCP

SRR R R R R Y

Full Access Full Access

Time Zone

None

Smart Card Layout

Subnet Mask

Gateway

Matching Timeout

Device Port

]
]

Connection Mode

2
1]
=
]
[y-]
v
[12]
]
=
<
]
=
o
[=]
S
=
o
]
=1
=]
=

Server Address

Server Port

A
]
]

« RS485

n
a

- Baid Daka

o

5) Click # of the field you want to edit and edit the information.
6) After editing all information, click Apply.

Note

» The fields displayed for Batch Edit may vary depending on the device type selected.
= If you select both master devices and slave devices and click Batch Edit, only some of the
Authentication and Display/Sound fields can be edited.

Information

You can enter or edit the name and the group of a device. If a new firmware version is available, you
can upgrade to it.
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1) Edit all fields of the Information tab.

Information

P

2 —A-

5 —
s —7
s
61
7 —

* Name

Device ID

* Firmware Version

* Kernel Version

* Restore to default

* Time Zone

* Daylight Saving Time

System

14 —[ * Display Date

CoreStation 40 123400068 (192.168.14.124) * Group All Devices ¥

* Device Type
* Firmware Upgrade * Product Name
* Hardware Version

All Without Network * Locked Inloc!

2
(UTC) W. Europe Standard Time, London, Lis... ¥ Time Synchronization with Server ]7 13

]—16

Get Time

o [ron  Jomown

1 Name Enter a device name.
2 Device ID View the device ID.
3 F|rmTNare Click Upgrade to install a new firmware version.
Version
4 Kernfel View the kernel version.
Version
Reset the settings of the device.
5 Restore to
default = All: Reset all settings.
= Without Network: Reset all settings excluding the network settings.
6 Time Zone Set the time zone of the device.
7 Daylight Apply the daylight saving time to the device. To add a new daylight saving
Saving Time | time rule, see Daylight Saving Time.
Change the device group. For more information on adding device groups,
8 Group : : .
see Adding and Managing Device Groups.
9 Device Type | View the device type.
10 Product View the model name.
Name
11 Hardware View the hardware version.
Version
12 Locked Unlock button will be available when the device is disabled via Trigger &
Action.
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Time
13 Synchroniza | Select the option to synchronize the time information of the device with the
tion with server.
Server
Date and Click H to manually set the date and time. If the Time Synchronization
14 Time with Server option is selected, the date and time cannot be selected
manually.
15 Get Time Click the button to fetch the time set in the device.
16 Set Time Click the button to apply the time set in BioStar 2 to the device.

2) Click Apply to save the settings.

Note

= Make sure to set the correct date and time as they are recorded in the Event Log and the
Real-time Log.

Network

You can configure various connection settings such as TCP/IP and RS-485, etc.

Note

» Editable fields vary depending on the device type.

1) Edit all fields of the Network tab.
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Network

TCP/IP

Use DHCP

+ IP Address

+ Gateway

+ DNS Server Address

WLAN

Use

+ Operation Mode

+ Authorization Type

+ Authorization Key

Server

Device - Server Connection

+ Server Address 192.168.16.46

Serial

+ RS485 Master

+ Subnet Mask

« Device Port 51211

+ SSID

+ Encryption Type

+ Server Port 51212

+ Baud Rate 115200

N

device.

1 TCP/IP

Note

You can configure the TCP/IP connection settings of the device.

» Use DHCP: Select this option to allow the device to use a dynamic IP
address. If this option is selected, network settings cannot be entered.
» IP Address, Subnet Mask, Gateway: Enter network settings of the

= Device Port: Enter a port to be used by the device.
= DNS Server Address: Enter a DNS server address.

= The devices and the firmware versions where a DNS server address
can be entered are as follows.
- BioStation L2 FW 1.0.0 or later
- BioStation A2 FW 1.0.0 or later
- BioStation 2 FW 1.2.0 or later
- BioLite Net FW 2.2.0 or later
- BioEntry Plus FW 2.2.0 or later
- BioEntry W FW 2.2.0 or later
- Xpass FW 2.2.0 or later
- Xpass S2 FW 2.2.0 or later
- FaceStation 2 FW 1.0.0 or later
- BioLite N2 FW 1.0.0 or later
- Facelite FW 1.0.0 or later
- XPass 2 FW 1.0.0 or later
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Turns on or off the wireless LAN. You can also configure the wireless LAN
related settings from the device menu. For the detailed information, refer to
the device's user guide.
2 WLAN
Note
= Only for BioStation 2, BioStation A2 and FaceStation 2.
You can enter connection settings to use in the server mode.
= Device — Server Connection: Select this option to configure the
BioStar 2 settings for connecting to the devices. If this option is selected,
BioStar 2 server network settings can be entered.
= Server Address: Enter the IP address or domain name of the BioStar 2
server.
= Server Port: Enter the port number of the BioStar 2 server.
Note
3 Server
= The devices and the firmware versions where a domain address can
be entered for the server address are as follows.
- BioStation L2 FW 1.0.0 or later
- BioStation A2 FW 1.0.0 or later
- BioStation 2 FW 1.2.0 or later
- BioLite Net FW 2.2.0 or later
- BioEntry Plus FW 2.2.0 or later
- BioEntry W FW 2.2.0 or later
- Xpass FW 2.2.0 or later
- Xpass S2 FW 2.2.0 or later
You can configure the connection mode and baud rate of devices connected
over RS-485.
4 Serial
= RS-485: Set a RS-485 mode.
» Baud Rate: Set a baud rate of the RS-485 connection.

2) Click Apply to save the settings.

Authentication

You can configure the user authentication settings of the device.

Note

» Editable fields vary depending on the device type.
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1) Edit all fields of the Authentication tab.

Authentication

* Auth Mode

{ H

= L@
=
. e
2 ———— . FullAccess I visable
3 — - server Matching P inactive
_ Fingerprint
+ 1:N Security Level Normal
+ Sensor Sensitivity
+ Template Format
6
* View Image ) Disabled
+ Advanced Enroliment @ ) Enabled
+ Duplicate Check ) Disabled
Card Type
« CSN Card @) e
EMa1
- Format Type P norma
« Wiegand Card &
B icass
+ Wiegand Format
7 * Smart Card @ ) eravied
+ MIFARE
B Classic/Plus
« iCLASS
& sruse
« Layout
« Mobile C nab
N

*Add

¥

+ Auth Timeout

+ Face Detection Level

+ Scan Timeout

* 1:N Fast Mode Auto
« Matching Timeout [ ]
+ Sensor Mode Auto On
- Fingerprint LFD ®

+ Byte Order 8

10 sec ]7 4
NotUse |————— 5

10 sec

5sec

Not Use

N

You can configure the authentication modes of the device. BioStar 2 can use
any combinations of fingerprint, ID, card, PIN and face as authentication

1 Auth Mode

modes.

= Click + Add and create an authentication mode by dragging and dropping
available options. Select a schedule and click OK to register the
authentication mode. If no desired schedule is available, click + Add

Schedule to create it.

= For more information on configuring schedules, see Schedules.
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You can grant full access to users registered within the device without

2 Full Access .
setting any access groups.
It is possible to set server matching. When Active is set, the authentication
is carried out using the user information stored in the PC where BioStar 2 is
installed, and when Inactive is set, the authentication is carried out using
the user information stored in the device. When using server matching, the
server matching of BioStar 2 should be also activated. For more information,
refer to Server.
Note
» The devices and the firmware versions where server matching can
be used are as follows.
- CoreStation FW 1.0.0 or later
- BioEntry P2 FW 1.0.0 or later
Server

3 - BioEntry W2 FW 1.0.0 or later
Matching - BioStation L2 FW 1.0.0 or later

- BioStation A2 FW 1.0.0 or later

- BioStation 2 FW 1.2.0 or later

- BioLite Net FW 2.2.0 or later

- BioEntry Plus FW 2.2.0 or later

- BioEntry W FW 2.2.0 or later

- Xpass FW 2.2.0 or later

- Xpass S2 FW 2.2.0 or later

- BioLite N2 FW 1.0.0 or later

- XPass D2 FW 1.0.0 or later

- XPass 2 FW 1.0.0 or later

- FaceStation 2 FW 1.4.0 or later
= Server Matching is not available for FaceLite.

When using a combination of multiple credentials in Auth Mode, the system

Auth waits for this length of time to authenticate the second credential.

4 Timeout Set a timeout period for authenticating the second credential after
authenticating the first credential. If the second credential is not

authenticated within this time, the authentication fails.

You can set an algorithm step for recognizing a face with a camera builtin a
device when a user tries to authenticate.

If it is set to Normal, it can detect a face at an arm’s length. If it is set to
Face High, it can detect a face at a shorter distance. If it is set to Not Use, it

5 Detection cannot use the face recognition function.

Note

= Only for BioStation A2.
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You can configure the detail settings concerning fingerprint authentication.

» 1:NSecurity Level: You can set a security level to use for fingerprint or
face authentication. The higher the security level is set, the false rejection
rate (FRR) gets higher, but the false acceptance rate (FAR) gets lower.

» Scan Timeout: You can set a fingerprint scan timeout period. If the
fingerprint is not scanned within the set time, the authentication fails.

» Sensor Sensitivity: You can set a sensitivity level of the fingerprint
recognition sensor. Set the sensor sensitivity higher if you wish to use a
higher sensor sensitivity level and obtain more detailed fingerprint
information.

» 1:NFast Mode: You can set the fingerprint authentication speed. Select
Auto to have the authentication speed configured according to the total
amount of fingerprint templates registered within the device.

» Template Format: You can view the fingerprint template format.

» Matching Timeout: You can set the matching timeout period. If the
authentication is not completed within the set time, the authentication
fails.

» View Image: Displays the image of the fingerprint on the screen during
the authentication process.

» Sensor Mode: If the option is set to Auto On, the sensor will
automatically go on when it detects a finger. If the option is set to Always
On, the sensor will always be on.

» Advanced Enrollment: Checks the quality of the scanned fingerprint to
avoid the poor quality fingerprint template enroliment. The user will be
alerted when the quality of the fingerprint scanned is low and given
enrollment instructions.

» FAngerprint LAD: It is possible to set the live fingerprint detection level. If
the live fingerprint detection level is higher, the false rejection rate on
actual human fingerprints will increase.

= Duplicate Check: You can check for duplicates when registering
fingerprints or faces.

= Enrollment Time: If a face is not registered during the set time when
registering a user's face, the face registration will be canceled.

= Motion Sensor: Set the sensitivity for detecting motion near the device.

= Ambient Brightness: Sense the brightness near the device and adjust
the intensity of IR LED.

« Enhanced fake face enrollment block: It is possible to set the
Enhanced fake face enrollment block. If the live face detection level is
higher, the false rejection rate on actual faces will increase.

= Quick Enrollment: Set whether or not to use a Quick Enrollment. When
you set this option to Enabled, the face registration procedure is set to 1
step. If you set the option to Disabled, it is set to 3 steps. To register
high-quality face templates, disable Quick Enroliment.

Fingerprint /
Face
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Note

= Fingerprint LFD is available only for BioStation A2, BioStation L2,
BioEntry W2 and BioLite N2.

» Enroliment Time, Motion Sensor, Ambient Brightness,
Enhanced fake face enrollment block and Quick Enroliment is
available only for FaceStation 2.

You can set the type of card used by the device.

Note

= The type of card supported by the device is displayed.

= CSN Card: You can select the CSN card and format type and set the byte
order.

Note

» If Format Type is set to Nornal, the device will read the card serial
number (CSN). If the option is set to Wiegand, the device will read
the card serial number in a Wiegand format that the user has
defined.

» If Format Type is set to Wiegand, you can select the Wiegand
format to be used in the device. To set a new Wiegand format, refer

7 Card Type to Wiegand.

= When Byte Order is set to MSB, the device reads a card ID from the
highest byte to the lowest byte. For example, the highest byte of the
card ID 0x12345678 is 0x12 and the device sequentially reads 0x12,
0x34, 0x56 and 0x78. When the option is set to LSB, the device
reads a card ID from the lowest byte to the highest byte.

» Wiegand Card: You can select a Wiegand card type and set the Wiegand
format.

Note

= You can select the Wiegand format to be used in the device. To set
a new Wiegand format, refer to \Wiegand.

= Smart Card: It is possible to select the smart card layout to be used in
the device. To set a new smart card layout, refer to Smart / Mobile Card.
= Mobile Card: You can set the type of mobile card.

Note

» Changing the fingerprint template format makes all previously stored fingerprints unusable. Be
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sure to select the correct template format before registering user fingerprints.
« If Full Access is set to Enable, the device cannot be added to an Access Level.

2) Click Apply to save the settings.

(& Related Information

Server

Advanced Settings

You can set the administrator, display/sound and trigger & action.

1) Click Advanced tab.

2) Edit the fields by referring to Administrator, T&A, Display/Sound, Trigger & Action, Image Log,
Wiegand, Interphone and Camera.

3) Click Apply to save the settings.

Note

= Editable fields vary depending on the device type.

Administrator

You can assign and manage administration rights of the devices.

Note

»= You can add and manage up to 1,000 administrators. The number of administrators that can

be added depends on the device firmware version.

1) Click + Add and select a user.

Administrator

+ All

- e B
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1 Al The assigned administrators can use all menu functions such as adding and
editing users.
) U The assigned administrators can manage the user information but cannot
Ser change the display, sound, network and RS-485 settings of the device.
. The assigned administrators can change the display, sound, network and
3 Configuration : . ) .
RS-485 settings of the device but cannot manage the user information.
Note

»  Click W to delete the registered users.
» The administrator settings configured for each device do not affect the BioStar 2 privileges.

T&A

You can change the device's name of the T&A event or configure the device's T&A Mode.

1) Edit the necessary fields.

T&A

1 4[ + T&A Mode By User v * T&A Required ) Not Use ]7 )

s _

Code1 check in

Code 2 check out

Code 3 meal start

Code 4 meal end

o Jam— Jowrpien

You can configure the T&A event settings.

= Not Use: The user cannot record T&A events.

= By User: The user can manually select a T&A event before the
authentication.

1 T&A Mode » By Schedule: T&A event automatically changes according to the pre-
defined schedule. You can select the schedule under the T&A Event
option.

» Last Choice: The T&A event that the last user has selected remains
unchanged until you change the T&A event manually.

» Fixed: The user can use the fixed T&A event only. Configure the T&A
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Mode to Fixed and select the event you want to use as fixed.

The user will be forced to select a T&A event during the authentication
process. The T&A Mode option must be set to By User in order to use the
Require T&A option.

) T&A
Required

You can set the name of T&A events or you can add schedules which will be
used when you set the T&A Mode as By Schedule.

» T&A Key: Lists the keys that you can use for T&A event selection. Choose

3 T&A Event one of the function keys that you want to edit.

» Label: You can change the name of the T&A event for the T&A key.

» Schedule: You can set a schedule for the By Schedule. The T&A mode
must be set to By Schedule in order to enable this option. For more
Information on configuring new schedules, see Schedules.

Note

= For a device with no LCD screen, T&A Mode can set to Fixed or By Schedule. You can register
a fixed T&A event or a T&A event that changes according to the schedule.
Supported devices are BioEntry P2, BioEntry W2, BioEntry Plus, BioEntry W, Xpass, Xpass S2,
XPass D2 and XPass 2.

Display/Sound

You can edit display and sound settings of the device. You can configure LED or buzzer action for each
event.

Note

» Editable fields may vary depending on the device type.

1) Edit the necessary fields.

= BioEntry P2, BioEntry W2, BioLite Net, BioEntry Plus, BioEntry W, Xpass, Xpass S2,
XPass D2, XPass 2

Note

= Language, Menu Timeout, Backlight Timeout, Mgs. Timeout can only
be used by BioLite Net.
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Display/Sound

1 4[ Language English v Update Resource
2——] voume @ o - Menu Timsout e w3
4 4[ Backlight Timeout S i ————— T + Msg. Timeout [ ] 205“]7 5
e “
Normal + LED Infinite ) ON
Locked BLUE - 2000 msec 0 msec
RTC Error CYAN v 2000 |msec | g msec
Waiting Input OFF = 0 msec | g msec
6 — Waiting DHCP p
¢ « Buzzer Infinite \) OFF Counts 0
Scan Finger
OFF = 0 msec | p msec [] Fade Out
Scan Card
OFF - 0 msec | g msec [ ] Fade Out
Auth Success
OFF v 0 msec | g msec [ ] Fade Out
Auth Fail
Auth Duress

o [ren {oworgion

Sets the display language of the device.
1 Language | Click Update Resource to transfer a language resource file
to the device.

N

Volume Turns the sound on or off.

Menu Sets the timeout period for changing from the menu screen
Timeout to the standby screen.

w

Backlight | Sets the timeout period for the display backlight to turn off
Timeout automatically.

N

sg. Sets the timeout period for various messages to disappear
Timeout automatically.

Ul
=<

LED/
Buzzer

Selects an event and set LED or buzzer actions for the event.

(o))

= BioStation 2, BioStation L2, BioLite N2, Facelite

Display/Sound

1 4[ Language 30 v Update Resource
2 4[ Volume BT 10% - Menu Timeout (] 20 sec ] 3
2 —[ Theme Theme 1 - + Backlight Timeout (] 20 sec ] 5
5 + Msg. Timeout S Ees—Y P11
7 - Use Voice \) Disabled
+ Background Logo v
g — 1 Update
Add Clear
+ Sound Start Find
Verify Successful Find
9
Verify Failed Find
Update
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Sets the display language of the device.

1 Language | Click Update Resource to transfer a language resource file
to the device.

2 Volume Controls the volume.

3 M_enu Sets the timeout for the menu screen.
Timeout

4 Theme Changes the style of the device's home screen.

5 B_acklight Sets the timeout for the backlight.
Timeout

6 Msg. Sets the timeout period for various messages to disappear
Timeout automatically.

7 Use Voice

Enables voice guidance.

8 Backgroun
d

Sets the items to be displayed on the device's home screen.

= Logo: Displays the user’s uploaded image on the home
screen. You can upload an image by clicking Add.

= Notice: Displays messages typed by the administrator.

= Slide Show: Displays a slideshow of maximum 10 images.
You can upload an image by clicking Add.

Note

» Click Update to apply the configurations to the
device instantly.

» Clicking Update will not apply when you change the
type of the Background. Click Apply to save the
configuration.

9 Sound

Configures the sound effect for boot, authentication success,
and authentication failure events.
Click Find and select a *.wav file(less than 500KB).

Note

» Click Update to apply the configurations to the
device in real-time.

= BioStation A2, FaceStation 2
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Display/Sound
Language s20f Update Resource

Vi [ ] 0% + Menu Timeout [ ] 20 sec

—

2 —[ olume ]_
4 —[ + Backlight Timeout [ ] 20 sec + Msg. Timeout ] 2.0 s!::’— 5
3 4[ Use Voice () Disabled

- Home Screen Logo

Update

Add || Clear

(_J slide Show Disabled

+ Sound Start Find

Verify Successful Find

Verify Failed Find

Update

o [ ron Lo

Sets the display language of the device.

1 Language | Click Update Resource to transfer a language resource file
to the device.

2 Volume Controls the volume.

3 Menu Sets the timeout for the menu screen.

Timeout

4 | Backlight | gets the timeout for the backlight.
Timeout

5 Msg. Sets the timeout period for various messages to disappear
Timeout automatically.

6 Use Voice | Enables voice guidance.

Sets the items to be displayed on the device's home screen.

= Normal: Displays the default image on the home screen.

» Logo: Displays the user’s uploaded image on the home
screen. You can upload an image by clicking Add.

= Notice: Displays messages typed by the administrator.

Note

7 Home
Screen = Click Update to apply the configurations to the

device instantly.

» Clicking Update will not apply when you change the
type of the Background. Click Apply to save the
configuration.

= When you set Logo for Home Screen and set Slide
Show Enabled, you can display a slideshow of
maximum 10 images on the home screen. You can
upload an image by clicking Add.
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Configures the sound effect for boot, authentication success,
and authentication failure events.
Click Find and select a *.wav file(less than 500KB).

8 | Sound )
Note

» Click Update to apply the configurations to the
device in real-time.

Trigger & Action

You can configure triggers and actions for each situation. For instance, you can get all alarms to go off
when an authentication fails or disable the device when its RS-485 connection is lost. You can select an
event or you can configure the desired triggers and actions.

1) Click + Add and configure the settings.

Add Trigger & Action x

®) Event + Device ®) Output « Device

BioStation L2 542501048 (192.168.14.125) > BioStation L2 542501048 (192.168.14.125) v
Input Alert Sound

+ Event List - Port

Input(Event Hame Change) Disable Device

None -

i « Signal Setting
Fail to save to the server DB

Muster zone alarm cleared

Muster zone alarm detected
Muster zone time limit violation

Interlock zone Alarm Clear

Interlock door open denied alarm (Occupied)
Interlock door open denied alarm

I

- -

o nen oo

You can select a pre-defined event or add a user defined trigger.

» Event: You can select a pre-defined event.

» Input: You can set a user defined trigger by selecting Port, Switch,
Duration (ms), and Schedule.

« Input(Event Name Change): You can set a user defined trigger by
selecting Port, Switch, Duration (ms), Schedule and Event Name.

1 Trigger
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Note

» If you set the trigger as an event, you can select only one event from
the event list.

= When configuring a user defined condition by selecting Input or
Input(Event Name Change), if no desired schedule is available,
click + Add Schedule to create it. For more information on
configuring schedules, see .

= When configuring a user defined condition by selecting Input(Event
Name Change), if no desired event name is available, click Add
Event Name to create it. When the event occurs, the event name is
displayed in the Event Log and Real-time Log.

= Up to 64 characters may be entered for the event name.

2 Action

You can select a pre-defined action or add a user defined action.

Note

= When configuring a user defined action by selecting Output, if no
desired schedule is available, click + Add Schedule to create it.
For more information on configuring schedules, see

= If you set the trigger as Input(Event Name Change), you can set
the Action to None.

Image Log

You can set an image log event and schedule to be used in the device. An image log can be used in the
device with a built-in camera, and 25 types of event can be used.

Note

= Only for BioStation A2 and FaceStation 2.

1) Set Enabled for the image log. It is possible to set Preset from Setting > Image Log. For more

information, see

2) Click + Add and set a desired event and schedule.
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Wiegand

Image Log

+ Image Log

+ Configuration

{ L) Enabled

m -

1:1 authentication succeeded

1:1 authentication failed

1:1 duress authentication succeeded

1:N authentication succeeded

1:N authentication failed

1:N duress authentication succeeded

Dual authentication succeeded

Dual authentication failed

Authentication failed

Access denied

Administrator menu entered

v

v

-

Always
Always
Always
Always
Always
Always
Always
Always
Always
Always

Always

v

it

v

t

-

4 4 4 4 4 4 4
o = = = = = = =€

4
il

You can define the Wiegand Input/Output.

1) Edit the necessary fields.

Wiegand

1 4‘ + Input/Output
2 4‘: + Wiegand Input Format
3 4[ + Output Mode

o nen e

Input v

Default -

I Normal Fail Code

« Pulse Width(us)

+ Pulse Interval(ys)

= Output info

a0 4 1
10000 = ]— 5
®) CardiD () Userld ———————————— 6

1 Input/ You can select input/output mode.
Output
Wiegand . . . .
You can set a format for Wiegand. For more information on setting a
2 Input .
Wiegand format, see Card Format.
Format
You can set the Wiegand signal output mode. If it is set to Normal, a card
will be scanned in the set Wiegand format. If it is set to ByPass, CSN will be
3 Output sent regardless of Wiegand authentication. ByPass should be set when
Mode using the device without an entrance door control function.
If it is set to Normal mode, it is possible to set Fail Code, and select a value
to be transmitted when Wiegand card authentication fails.
4 Pulse Width | You can set the pulse width of the Wiegand signal.
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Pul
5 uise You can set the pulse interval of the Wiegand signal.
Interval
. You can select the information output to the device when the user
6 Output info )
authenticates.

Secure Tamper

If a tamper event occurs on the device, you can set to delete the entire user information, the entire log,
and the security key stored on the device.

1) To use the secure tamper, set to On.

* Secure Tamper /) On * All the users, logs, and encryption key in the device will be removed at the secure tamper event.

Interphone

You can set the interphone.

Analog Interphone

SIP Interphone

Analog Interphone

It is possible to set whether or not to use an analog interphone.

Note

= Only for BioStation 2.

1) Click Use to use a connected intercom.

Interphone

Use

SIP Interphone

It is possible to set whether or not to use a SIP interphone.

Note
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= Only for BioStation A2 and FaceStation 2.
» Itis recommended to use Asterisk for the SIP server.

1) Click Use to to use a connected interphone.
2) Edit the necessary fields.

Interphone

Use

1 4[ SIP Server IP Address | 192.168.0.1 + SIP Server Port 5061 ]7 2
3 4[ Account ID 210 + Open Door Button v ]7 4
(DTMF)
5 [- Account + Confirm Password ]7 6
7 4[* DTMF Mode RFC2833 x
. Add
Extension Number Extension Number Display Name. d
101 Support L]

L[]

102 Reception

o (menJomoon

SIP Server

1 You can enter the IP address of the SIP server.
IP Address
SIP Server

2 Port You can set the SIP server port. The default value is 5061.

3 Account ID You can enter the account ID of the SIP server.
Open Door

4 Button(DTM | You can set a button for carrying out an entrance door relay.
F)
Account

5 You can enter the account password of the SIP server.
Password
Confirm .

6 Enter the account password one more time.
Password

7 DTMF Mode | You can set the mode for transmitting DTMF signals.

8 Extension You can register up to 16 extension numbers. Click + Add to add an
Number extension number.

Camera

It is possible to set the camera frequency. If you set the frequency incorrectly in the environment where

the fluorescent light is used, flickering on the image may occur.
Different camera frequencies are used depending on geographic location. 60 Hz is generally used in
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U.S., and 50 Hz is used in all other areas.
For the camera frequency of a given area, contact a sales agent.

Note

= Only for BioStation A2.

1) Select the frequency.
Camera

+ Power Line I-requency. 50Hz

Thermal & Mask

You can set the detailed settings of thermal camera and mask detection.

Thermal camera with Suprema face recognition devices measures temperature of users passing the
access point and limit the access of users with higher temperature than preset threshold. And the face
recognition devices can also detect masks and restrict access to users without masks.

Note

= Only FaceStation 2 and FaceStation F2 support thermal cameras.
= The supported thermal cameras are as follows.

- TCM10-FS2

- TCM10-FSF2
= Only FaceStation F2 supports mask detection.

1) Edit the necessary items.
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Thermal & Mask

Mask Configuration

Mask Detection  Use (Deny access when failed to detect ma..

+ Mask Detect Level

Thermal Camera

Thermal

Camera Use

¢ Celsius/Fahrenheit
+ Save Temp. Data

B ) enabled

* Show Infrared Image Enabled

* Threshold Temp. (*C)

+ Temp. Fail Sound Enabled

* Check Mode

+ Camera Configuration

Temp. Correction
('c)

Distance(cm)

Emission Rate 0.98
Dynamic ROI I oisabled
ROI X(%)

ROI Y(%)

ROI Width(%)

ROI Height(%)

Thermal & Mask Check Mode

N

Mask
1 Configuratio
n

You can set whether to use mask detection or not.

= Mask Detection: You can set whether to use mask detection or not. If
you select Use (Deny access when failed to detect mask), it refuses
authentication of users who are not wearing a mask and saves event logs.
If you select Use (Allow access after leaving log when failed to
detect mask) users who are not wearing a mask can authenticate but
event logs still be saved.

» Mask Detect Level: You can set sensitivity for mask detection.

Thermal
Camera

You can set options whether to use the thermal camera and edit the detailed
settings.

= Thermal Camera Use: You can set whether to use thermal camera or
not. If you select Use (Deny access when exceeded threshold
temperature), it refuses authentication of users with elevated
temperature than the preset threshold and saves event logs. If you select
Use (Allow access after leaving log when exceeded threshold
temperature), users with elevated temperature than the preset
threshold can authenticate but event logs still be saved.

» Celsius/Fahrenheit: Change the unit of temperature.

= Threshold Temp. (? /? ): Set the threshold temperature to limit the
access. Users with detected temperature over the threshold will be denied
access.

= Save Temp. Data: Save temperature data. When this mode is Enabled,
it saves both authentication and temperature logs. When this mode is
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o o

Disabled, it only saves authentication logs.

= Temp. Fail Sound: Set the alerts to trigger when the temperature is
higher than the preset threshold.

= Show Infrared Image: Display infrared imaging on the screen of the
devices.

= Camera Configuration: Configure the thermal camera settings for
accurate measurement.
- Temp. Correction (? ): Depending on the device usage environment,
the temperature can be calibrated to measure as high or low as a certain
value. For example, in an environment where the temperature value is
always measured high by 0.1? , set the temperature compensation value
to-0.1? .
- Distance(cm): Set up the distance between the user and device.
- Emission Rate: Set up the emissivity to precisely measure the
temperature of the user.
- Dynamic ROI: If there are lights in the device field of view, you can set
the thermal camera to automatically measure the user's temperature
rather than that light.
- ROI X(%), ROI Y(%), ROI Width(%), ROI Height(%o): If you set
Dynamic ROI to Disabled, you can manually set the ROI(Region of
Interest). Set the temperature measurement area by adjusting the size
and position of ROL

Note

» Itis recommended to maintain the default values of the camera
configuration settings for the best performance. The default values
of each option are as follows:

- Distance(cm): The distance may have different default values ?
depending on the device. (FaceStation 2: 80 cm / FaceStation F2:
50 cm)

- Emission Rate: 0.98

- ROI X(%): 30

- ROI Y(%): 40

- ROI Width(%o): 40

- ROI Height(%o): 20

Set the thermal & mask check mode depending on the desired usage.

= Check after authentication: Measure the temperature or detect the

Thermal & mask after a successful authentication.
3 Mask Check | = Check before authentication: Authentication is performed after
Mode checking whether the user is wearing a mask or measuring the

temperature. When using this mode, it does not attempt to authenticate
user’s identity if they does not wear masks or their temperature has been
detected to be above the threshold.
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» Check without authentication: The device may only be used to
determine whether a mask is worn or to measure temperature. In this
mode, regardless of authentication, all users wearing a mask or below the
reference temperature can enter.

2) Click Apply to save the settings.

DM-20

You can edit detailed settings of registered DM-20.

1) Click DEVICE.
2) Click a DM-20 on the device list to edit.
Information

1T — + Device Type + Firmware Version Firmware Upgrade

* Product Name

Advanced -

Supervised Input

+ Configuration Index | Supervised ‘Supervised Input Resistor

Supervised 2.2 -

|
Supervised 2.2 v ‘
Supervised 2.2 = ‘

|

r-\l (-1

Supervised 2.% >

o (menJomoion

You can modify the device’s settings.

= Name: Enter a device name.

= Device ID: View the device ID.

= Device Type: View the device type.

= Armware Version: Click Armware Upgrade to install a newer firmware
version.

= Product Name: View the model name.

1 Information
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You can modify the Supervised Input settings. The DM-20 can oversee the
2 Advanced On, Off, Open, and Short status of the device connected to the Supervised
Input port, and can set the terminating resistor as 1k®@, 2.2k@, 4,7k@ , 10kR,

3) Click Apply to save the settings.

OM-120

You can edit detailed settings of registered OM-120.

1) Click DEVICE.
2) Click a OM-120 on the device list to edit.

Information

* Name 0OM-120 12345678 + Device ID
+ Device Type « Firmware Version 4+ Firmware Upgrade
+ Product Name + Kernel Version

+ Hardware Version

o (mn Jomoon

You can modify the device’s settings.

= Name: Enter a device name.

= Device ID: View the device ID.

» Device Type: View the device type.

= Armware Version: Click Armware Upgrade to install a newer firmware
version.

» Product Name: View the model name.

= Kernel Version: View the kernel version.

= Hardware Version: View the hardware version.

1 Information

3) Click Apply to save the settings.

CoreStation

You can edit detailed settings of registered CoreStation.
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1) Click DEVICE.
2) Click a CoreStation on the device list to edit..
3) Edit the necessary items.

= Information

Information

+ Name CoreStatien 40 542070627 (192.168.14.205) + Group All Devices
« Firmware Version 4 Firmware Upgrade + Product Name

* Restore to default All Without Network * Locked
+ Time Zone (UTE) W. Europe Standard Time, London, Lis. Time Synchronization with Server
- Daylight Saving Time

System

+ Display Date Get Time

o

= Name: Enter a device name.

» Device ID: View the device ID.

» Armware Version: Click Armware Upgrade to install a newer
firmware version.

= Kernel Version: View the kernel version.

= Restore to default: Reset the settings of the device. Click All to
reset all settings. Click Without Network to reset all settings
excluding the network settings.

= Time Zone: Set the time zone of the device. You can set a
different standard time zone of the device from the time zone of
the BioStar 2 server.

= Daylight Saving Time: Apply the daylight saving time to the
device. To add a new daylight saving time rule, see Daylight
Saving Time.

= Group: Change the device group. For more information on adding
device groups, see Adding and Managing Device Groups.

= Device Type: View the device type.

» Product Name: View the model name.

= Hardware Version: View the hardware version.

» Locked: Unlock button will be available when the device is
disabled via Trigger & Action.

= Time Synchronization with Server: Select the option to
synchronize the time information of the device with the server.

Informati
on

» Display Date: Click ] to manually set the date and time. If the
Time Synchronization with Server option is selected, the date

System and time cannot be selected manually.

» Get Time: Click the button to fetch the time set in the device.

= Set Time: Click the button to apply the time set in BioStar 2 to the
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Description

device.

= Network

Network
TCP/NIP
Use DHCP
- IP Address

* Gateway

Server

- Subnet Mask

+ Device Port 51211

Device » Server Cennection

+ Server Address

Serial

* RS485

+ Baud Rate

Host 115200

0 115200

115200

1 115200 v ‘
115200 ‘

o [omogion

TCP/IP

= Use DHCP: Select this option to allow the device to use a dynamic

IP address. If this option is selected, network settings cannot be
entered.

IP Address, Subnet Mask, Gateway: To assign a fixed IP to
the device, enter the information of each network. Uncheck Use
DHCP and enter the information.

Device Port: Enter a port to be used by the device. This port is
used for the communication between BioStar 2 and the device.
DNS Server Address: Enter a DNS server address.

Server

Device — Server Connection: Select this option to configure
the BioStar 2 settings for connecting to the devices. If this option
is selected, BioStar 2 server network settings can be entered.
Server Address: Enter the IP address or domain name of the
BioStar 2 server.

Server Port: Enter the port number of the BioStar 2 server.

Serial

RS-485: You can only use Master.
Baud Rate: Set a baud rate of the RS-485 connection.

= Authentication
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Authentication

Server Matching I mactive
Fingerprint
- 1:N Security Level Normal - T:N Fast Mode Auto

+ Template Format

Card Type

+ CSN Card ) Enabled

EM4100 Mifare/Felica

* Format Type I Normal * Byte Order MSB

T

= Server Matching: It is possible to set server matching. When
Active is set, the authentication is carried out using the user
information stored in the PC where BioStar 2 is installed, and
when Inactive is set, the authentication is carried out using the
user information stored in the device. When using server
matching, the server matching of BioStar 2 should be also
activated. For more information, refer to Server.

Authentic
ation

» 1:NSecurity Level: You can set a security level to use for
fingerprint or face authentication. The higher the security level is
set, the false rejection rate (FRR) gets higher, but the false
acceptance rate (FAR) gets lower.

Fingerpri | = 1:NFast Mode: You can set the fingerprint authentication speed.

nt Select Auto to have the authentication speed configured
according to the total amount of fingerprint templates registered
within the device.

» Template Format: You can view the fingerprint template
format.

You can set the type of card used by the device.

Note

= The type of card supported by the device is displayed.

= CSN Card: You can select the CSN card and format type and set
Card the byte order.

Type
Note

» If Format Type is set to Nornal, the device will read the
card serial number (CSN). If the option is set to Wiegand,
the device will read the card serial number in a Wiegand
format that the user has defined.

» If Format Type is set to Wiegand, you can select the
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o Joworgion

Wiegand format to be used in the device. To set a new
Wiegand format, refer to Wiegand.

= When Byte Order is set to MSB, the device reads a card ID
from the highest byte to the lowest byte. For example, the
highest byte of the card ID 0x12345678 is 0x12 and the
device sequentially reads 0x12, 0x34, 0x56 and 0x78. When
the option is set to LSB, the device reads a card ID from the
lowest byte to the highest byte.

= Mobile Card: You can set the type of mobile card.

— Advanced

Advanced =

- Tamper None - - Switch Type @) wormally Open
* ACFail None - + Switch Type @) wormally open

Trigger & Action
Contuen “—- o

Wiegand
+ Input/Qutput + Pulse Width(us) 40

+ Wiegand Input Format | Default - + Pulse Interval (ps) 10000

Supervised Input

I nput
I mput
I nput
B mput
I mput
[@ I
(I nput

+ Secure Tamper \) off

O

= Tamper: You can set the AUX port where the tamper is

Advance connected.
d » AC Fail: You can set the AUX port that monitors the power input
signal.

= Configuration: You can set the operation of the device according
to a pre-defined alarm or signal input. For example, you can set
to output a signal set by the user or not to use the device when a
temper on signal occurs in CoreStation.

Trigger
& Action
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R

Add Trigger & Action X

® Event + Event List ® output + Port
NNNNN

Input Alert Sound
Input(Event Name Change) O Failto save to the server DB Disable Device

O scheduled unlock zone ended

O Interlock door open denied alarm

- -

= In/Out: You can only use input mode.

» Input Format: You can set a format for Wiegand. For more
information on setting a Wiegand format, see Card Format.

= Pulse Width: You can set the pulse width of the Wiegand signal.

= Pulse Interval: You can set the pulse interval of the Wiegand
signal.

Wiegand

You can set the supervised input port of CoreStation to be used as
Supervis | TTL input port and set a resistance value to be used for supervised
ed Input input. 1ke, 2.2k@, 4.7k? and 10k? can be set for the resistance

value.
Secure If a tamper event occurs on the device, you can set to delete the
entire user information, the entire log, and the security key stored
Tamper

on the device.

4) Click Apply to save the settings.

Wiegand Device

You can edit detailed information of registered Wiegand devices.

1) Click DEVICE.
2) Click a Wiegand device on the device list to edit.
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Information
* Name wiegand Reader 1 (575624497) * Device ID
* Device Type * Locked
Authentication

*+ Operation Schedule Always * Full Access @ ) Disable

* Matehing Timeout [ ] 5sec

Advanced -

Tamper

- Tamper Port Mone « Switch Type [ ) normally open

LED/Buzzer

* Green LED Port Mone * Buzzer Port None

o Jam— Jowrpien

You can modify the settings of the Wiegand device.

1 Information = Name: Enter a device name.
= Device ID: View the device ID.
= Device Type: View the device type.

Modify the Wiegand device’s authentication settings.

= Operation Schedule: Configure the activating time for the device.

Authenticati | = Full Access: Allows the user to authenticate anytime. This overrides the

on access group of the user on the master device.

» Matching Timeout: You can set the matching timeout period. If the
authentication is not completed within the set time, the authentication
fails.

Modify the Wiegand device’s tamper switch and LED settings.

= Tamper Port: Select the input port where the Wiegand device's tamper
3 Advanced switch is connected.

» Switch Type: Select the tamper switch type for the tamper operation.

= Green LED Port: Select the control port for the green LED.

» Buzzer Port: Select the control port for the buzzer.

3) Click Apply to save the settings.

You can use the DOOR menu to add the information on doors connected to devices.

You can configure relay, dual authentication, anti-passback, forced open and held open alarm settings of
the device. The door information is then used as a component of the access levels.

Adding and Managing Door Groups
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]

I

All Doors

All Doors

Add Door

Z 3

All Doors BioStation 2 546832590 (1. BioLiteNet 538101276

All Doors

¢ Door List

Page Navigation Buttons and Number of List Rows € Door and Group List

= Registered Device Search

Function Button (Print, Column Setting)

» Expand Button

After selecting a door, you can perform the following actions.
= Delete Door: Deletes the selected door from the list.

Adding and Managing Door Groups

You can add groups for easy management of multiple doors. Name your door groups according to door

locations or office names for greater convenience.

= Adding Door Groups

1) Click DOOR.

2) Right-click on All Door Groups and click Add Door Group.

5 All Doors

Add Door Group

3) Enter a group name.

Note
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Door groups may be created in up to 8 levels.
Up to 48 characters may be entered for a door group name.

= Renaming Door Groups

1) Click DOOR.
2) Right-click on the name of a group you wish to rename and click Rename Door
Group.
5 All Doors
16F-1
Add Door Group
Rename Door Group

elete Door Group

3) Enter a name.

Note
Up to 48 characters may be entered for a door group name.

— Deleting Door Groups

1) Click DOOR.
2) Right-click on the name of a group you wish to delete and click Delete User
Group.
p All Doors
16F-1
Add Door Group
Rename Door Group
Delete Door Group
Note

Deleting a group deletes all doors in the group.
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Adding Doors

You can configure the doors to use in your access control installation. You can select an entry device and
an exit device, configure Anti-passback settings for improved security, or configure alarms for each
door.

1) Click DOOR and click ADD DOOR.
2) Configure the settings by referring to Information, Configuration, Option, Anti PassBack and Alarm.
3) After editing all information, click Apply.

(® Related Information

Basic Search and Registration
Slave Device Search and Registration

Adding and Managing Access Levels

Information

You can enter or edit the name, group and description of the door.

1) Edit all fields of the Information tab.

Information

1 4[ Name 17F-1 + Group All Door Groups v ]7 3
2 —[ Description

o Jam— Jowrpien

1 Name Enter a door name.

Set a door group. For more information on adding door groups, see Adding

2 Grou
P and Managing Door Groups.

3 Description Enter a short description of the door.

2) Click Apply to save the settings.

Configuration

You can configure various settings for the device, exit button, door sensor, etc.
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1) Edit all fields of the Configuration tab.

Configuration

2 4[ + Door Relay(s)

3 4[ + Exit Button
4 ——————— - Door Sensor

Xpass D2 400000005 v + Exit Device Xpass D2 400000005 - 7"

Relay 0 of CoreStation 40 542070627 (192.1

Input Port 1 of CoreStation 4¢ * Switch @ ) normally open

nput Port 1 of CoreStation 40 542070627 v + Switch [ Normally Open

+ Use sensor when Ents D OFF

n Entry
Confirmed APB enabled

o (mn Jomoon

1 Entry device

Select a device to use for entry. You can select a device from the list of
registered devices. If no registered device is available, see Basic Search and
Registration, Advanced Search and Registration, Wiegand Device Search and
Registration, or Slave Device Search and Registration.

2 Door relay

Select a relay to control the door lock.

3 Exit button

Select a port to use for the exit button.

= The Switch can be set to Normally Closed or Normally Open.

4 Door sensor

Select a port to check the door status.

= The Switch can be set to Normally Closed or Normally Open.

» Use sensor when Entry Confirmed APB enabled: You can set
whether to use the door sensor when using Entry Confirmed APB.

« If Door Sensor is set to None, the Alarm tab cannot be edited.

5 Exit device

Select a device to use at exit. An exit device can only be used when there is
a slave device connected. If there is no registered slave device, see Basic
Search and Registration, Advanced Search and Registration, Wiegand Device
Search and Registration, or Slave Device Search and Registration.

= If no exit device is selected, the Anti Pass Back tab cannot be edited.

2) Click Apply to save the settings.

Note

= CoreStation can not be set as either an entry device or an exit device.

& Related Information

Anti Passback
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Option

You can configure additional options.

1) Edit all fields of the Option tab.

Option

Open

+ Open Time [ ] 3 sec

Dual Authentication

2 + Device

Anti-Tailgating

+ Sensor None

o o Jomogion

You can configure options concerning the opening of the door.

= Open Time: Set the duration for which the door will remain open after a
user authentication is completed. When the authentication is successful,
the relay will be activated for the set time. When this time elapses, the
relay no longer sends the signal to the door.

Note

1 Open = Open Time may vary depending on the type of
door lock used.

» Lock when door is closed: When the door sensor detects that the door
is closed, the door is locked. This option is not available if Use
Automatic Door is set to ON

» Use Automatic Door: When using an automatic door as an entrance
door, a relay can operate regardless of the status of a door sensor. This
option is not available if Lock when door is closed is set to ON

You can configure the door to open only when authenticating credentials of
two persons (an ordinary user and an administrator).

= Device: Select a device to use dual authentication. If No device is

Dual
L selected, the dual authentication mode is disabled.
2 Authenticati N .
on = Schedule: Set a schedule to use dual authentication. If no desired

schedule is available, click + Add Schedule to create it. For more
information on configuring schedules, see Schedules.

= Approval Type: You can configure the administrator authentication
order. Setting to None will require two users to authenticate regardless to
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o [son  Jowowr

the access group. Setting to Last will require an authentication by a user
belonging to an access group that has been set after a normal user
authentication.

= Authentication Group: You can configure a group to which the
administrator belongs.

» Authentication Timeout: Set a timeout period for authenticating the
second credential after the first credential has been authenticated. If the
second credential is not authenticated within the timeout period after the
first credential has been authenticated, the door will not open.

Anti- You can configure the door to detect the tailgating.

Tailgating

= Sensor: You can select the sensor to detect tailgating.

2) Click Apply to save the settings.

Anti-passback

You can use Anti-passback to manage the access history and enhance security.

Anti-passback can help prevent the users from using an access card to enter and then passing the card
over to another user. It can also prevent unauthorized persons who have entered by following users
with access privileges from getting out on their own. This feature is available when both an entry device
and an exit device are installed. If Exit Device is set to None, this feature is unavailable.

For more information on configuring exit devices, see Configuration.

Note

= A master device and a slave device should be connected via the RS-485 interface in order to
activate the Anti-passback section on the Door page.

1) Edit all fields of the Anti PassBack tab.

Anti PassBack

1 —[ Type Soft APB v * Reset Time 1440 min ]_ 2

o (menJomoon

Select an Anti-passback type.

1 Type = None: Select this option to disable the Anti-passback feature.
= Soft APB: Select this option to allow entry but set off an alarm or create
a log entry in BioStar 2 when Anti-passback is violated.
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» Hard APB: Select this option to prohibit entry and set off an alarm or
create a log entry in BioStar 2 when Anti-passback is violated.

You can set a time period for resetting the Anti-passback feature. The

2 Reset Time maximum possible duration is 7 days (10080 min.). If set to 0, the feature is

not reset.

2) Click Apply to save the settings.

Alarm

You can configure an alarm to go off or the device to lock when the door is opened by force, held open

or an anti-passback violation occurs.

1) Edit all fields of the Alarm tab. To add an action, click + Add.

Alarm

T —

2 —A-

5 [-

g —-

Held Open +Add

Held Open Time L . ) 3sec

Forced Open +Add

Anti PassBack +Add

o {menJomoior

1 Held Open You can configure alarm actions to be taken when the door is held open.
P Click + Add and select an action. Click OK to add the action.
Held Open
2 Time P You can configure the maximum allowed time for the door to remain open.
Forced You can configure alarm actions to be taken when the door is opened by
3 Open force.
P Click + Add and select an action. Click OK to add the action.
You can configure alarm actions to be taken when an Anti-passback violation
occurs.
4 Anti- Click + Add and select an action. Click OK to add the action.
passback
= An exit device must be registered before the Anti-passback setting can
be configured.
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2) Click Apply to save the settings.

Editing Doors

You can edit an existing door or batch edit multiple doors.

1) Click DOOR.

2) In the door list, click a door to edit.

3) Edit the details by referring to the instructions in Adding Doors .

4) To edit information on multiple doors, select multiple doors and click Batch Edit.

Edit All X

Open
+ Open Time r 4 [ ]

Cancel

4) Click # of the field you want to edit and edit the information.
5) After editing all information, click OK.

You can configure the elevator to control floors with the access control device and OM-120 by using the
ELEVATOR menu.

Adding and Managing Elevator Groups
Adding Elevators

Editing Elevatos

Note

» The ELEVATOR menu will appear when the Advanced or higher license is activated.

100



8 Elevator

2 3
T A | Al Elevators \[ T m =3

7 4[, All Elevators E”— 4
Elevator 1
& Elevator 1 All Elevators BioStation A2 541531008 BioStation A2 5 0OM-120 12345.
1 Add Elevator ¢ Elevator List
z Page Navigation Buttons and Number of List Rows € Elevator and Group List
> Registered Elevator Search 7 Expand Button

< Function Button (Print, Column Setting)

After selecting an elevator, you can perform the following actions.
= Delete Elevator: Deletes the selected elevator from the list.

Adding and Managing Elevator Groups
You can add groups for easy management of multiple elevators. Name your elevator groups according to
elevator locations for greater convenience.
— Adding Elevator Groups

1) Click ELEVATOR.
2) Right-click on All Elevators and click Add Group.

5 All Elevators

Add Group

AL

dd G
W

3) Enter a group name.

Note

» Elevator groups may be created in up to 8 levels.
= Up to 48 characters may be entered for an elevator group name.
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— Renaming Elevator Groups

1) Click ELEVATOR.
2) Right-click on the name of a group you wish to rename and click Rename

Group.
5 All Elevators
Parkview 1
Add Group

Rename Group

Dgtg) Group

3) Enter a name.

Note

= Up to 48 characters may be entered for an elevator group name.

= Deleting Elevator Groups

1) Click ELEVATOR.
2) Right-click on the name of a group you wish to delete and click Delete Group.

5 All Elevators

Parkview 1

Add Group

Rename Group

Deletefzroup

Note

» Deleting a group deletes all elevators in the group.

Adding Elevators

You can configure the elevators to use for the floor control.

1) Click ELEVATOR and click ADD ELEVATOR.
2) Configure the settings by referring to Information, Detail, Option, and Alarm.
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3) After editing all information, click Apply.

(® Related Information

Basic Search and Registration
Slave Device Search and Registration

Adding and Managing Access Levels

Information

You can enter or edit the name, group and description of the elevator.

1) Edit all fields of the Information tab.

Information

1 4[ Name Elevator 1 + Group All Elevators - ]7 3
2 —[ Description
0| nem | s
1 Name Enter an elevator name.

Set an elevator group. For more information on adding door groups, see

2 Grou
P Adding and Managing Elevator Groups.

3 Description Enter a short description of the elevator.

2) Click Apply to save the settings.

Detail

You can select a device to connect to the elevator and floor information.

Note

= BioEntry Plus, BioEntry W, BioLite Net are not available as a controller.

1) Edit all fields of the Detail tab.
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Detail

Configuration

1 4[ + Controller BioStation A2 541531008 (192.168... + Reader BioStation A2 541531008 (192.168... v ]— 2
3 4‘: * Module OM-120 12345678 v

Floor

4 4[ + Total Number of Floors| 12 Apply + Auto-mapping O Autofmappmg]i 5

* Floor Settings Floor Name Device Relay Number
Elevator 1 - 1 0M-120 12345678 Relay 0 of OM-120 12345678 De.. « v
Elevator 1 - 2 0M-120 12345678 Relay 1 of OM-120 12345678 De.. « v
Elevator 1 - 3 0M-120 12345678 Relay 2 of OM-120 12345678 De.. « v
Elevator 1 - 4 0M-120 12345678 Relay 3 of OM-120 12345678 De.. « v
Elevator 1 - 5 0M-120 12345678 Relay 4 of OM-120 12345678 De.. « v
6 Elevator 1 - 6 0M-120 12345678 Relay 5 of OM-120 12345678 De.. « v
Elevator 1 - 7 0M-120 12345678 Relay 6 of OM-120 12345678 De.. « v
Elevator 1 - 8 0M-120 12345678 Relay 7 of OM-120 12345678 De.. « v
Elevator 1 -9 0M-120 12345678 Relay 8 of OM-120 12345678 De.. « v
Elevator 1 - 10 0M-120 12345678 Relay 9 of OM-120 12345678 De.. « v
Elevator 1 - 11 0M-120 12345678 Relay 10 of OM-120 12345678 D.. v
Elevator 1 - 12 0M-120 12345678 Relay 11 of OM-120 12345678 D.. v

o o Jomogion

Select a device that controls the elevator access permission.
Note
1 Controller
= Only a master device can be selected.
= You can select it from the list of registered devices. If there is no
registered device, refer to Basic Search and Registration.
Select a device you intend to use for authentication.
Note
2 Reader
= You can select a device among the master device, slave device, and
Wiegand device.
= OM-120 cannot be set as the reader.
Select OM-120 to control the elevator button relay.
3 Module Note
= Only OM-120 can be selected.
4 Total Enter the total number of floors that you can move using the elevator.
Number of
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Note
Floors
= Up to 192 floors can be entered.
5 Auto- Select whether or not to use auto-mapping. If Auto-mapping is used,
mapping Relay Number is assigned in consecutive order.
Floor
6 ) You can set the floor name and the relay number to control the floor.
Settings

2) Click Apply to save the settings.

Option

You can configure additional options.

1) Edit all fields of the Option tab.

Option

Relay Control

+ Open Time

Dual Authentication

+ Reader

Tamper

+» Tamper Port

] 5 sec

None v

Mone v

o o Jomogion

You can configure options concerning the activating of the relay of the floor.

1 Relay = Open Time: Set the duration for which the floor button will remain
Control activate after a user authentication is completed. When the authentication
is successful, the relay will be activated for the set time. When this time
elapses, the relay no longer sends the signal to the relay of the floor.
You can configure the floor button to activate only when authenticating
credentials of two persons (an ordinary user and an administrator).
Dual
2 Authenticati = Device: Select a device to use dual authentication. If No device is
on selected, the dual authentication mode is disabled.

= Schedule: Set a schedule to use dual authentication. If no desired
schedule is available, click + Add Schedule to create it. For more
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information on configuring schedules, see Schedules.

= Approval Type: You can configure the administrator authentication
order. Setting to None will require two users to authenticate regardless to
the access group. Setting to Last will require an authentication by a user
belonging to an access group that has been set after a normal user
authentication.

» Authentication Group: You can configure a group to which the
administrator belongs.

» Authentication Timeout: Set a timeout period for authenticating the
second credential after the first credential has been authenticated. If the
second credential is not authenticated within the timeout period after the
first credential has been authenticated, the door will not open.

3 Tamper You can set a port to output the tamper signal.

2) Click Apply to save the settings.

Alarm

An action can be set to be performed when tamper input or a separate input signal is detected.

1) Edit all fields of the Alarm tab. To add an action, click + Add.

Alarm
1 —— + configuration +add | — 2
o men pwewen
1 Trigger Tamper input detection or separate input signal detection can be set.
An action can be set to be performed according to the status set under
trigger.
2 Action 9 . -
The floor button of the elevator can be activated, and/or output of a specific
signal can be set.

2) Click Apply to save the settings.

Editing Elevators

You can edit an existing elevator or batch edit multiple elevators.
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1) Click ELEVATOR.

2) Inthe elevator list, click an elevator to edit.

3) Edit the details by referring to the instructions in

4) To edit information on multiple elevators, select multiple elevators and click Batch Edit.
5) Click # of the field you want to edit and edit the information.

6) After editing all information, click OK.

You can use the ACCESS CONTROL menu to create access levels by configuring doors and access
schedules and to configure access groups using access levels and user group information.
The configured access groups are then used as components of the access control.

Note

= The Aoor Level tab and ADD ALOOR LEVEL button will appear when the Advanced or higher
license is activated.

- 3 4 5
! 4“—‘ Access Group \[ " m [eo

~ Ly

9 4[ Access Access Floor
Group | Level | Level | Status AG 12F - 12F 12F access

AG 12F

AG 1F ~ 6F - 1F ~ 6F 1F ~ 6F access

AGTF ~6F AG 7F ~ 11F - TF~11F TF ~ 11F access

AG TF ~ 11F

1 Add Access Group € Function Button (Print, Column Setting)

Access Group / Access Level / Floor

z Add Access Level ) ]
Level List

Access Groups / Access Level / Floor

> Add Floor Level ¢
Level Groups

Tab buttons for the Access Group,

< Page Navigation Buttons and Number of List Rows ¢ Access Level, Floor Level and Status
list pages
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1 Add Access Group € Function Button (Print, Column Setting)

1
! Registered Item Search ( Expand Button

After selecting an access group or an access level, you can perform the following actions.
» Delete Access Group: Deletes the selected access group from the list.
= Delete Access Level: Deletes the selected access level from the list.
= Delete Hoor Level: Deletes the selected floor level from the list.

Adding and Managing Access Levels

You can configure a schedule during which users are allowed to access the door and add it to an access
level.

— Adding Access Level

1) Click ACCESS CONTROL > ADD ACCESS LEVEL.
2) Enter Name and Description for the access level.
3) Click + Add.

4) Click + to select a door and a schedule.

+ Add

Door 1 Always

Note

«  Click Q. to search for an item.

» If no desired door is available, add it by referring to

= If no desired schedule is available, click + Add Schedule to create it. For
more information on configuring schedules, see

= Click ¥ to delete an item.

5) Click Apply to save the settings.

= Editing Access Level

1) Click ACCESS CONTROL > Access Level tab.
2) Inthe access level list, select an access level to edit.
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3) After editing the necessary fields, click Apply.

= Deleting Access Level

1) Click ACCESS CONTROL > Access Level tab.
2) Inthe access level list, select an access level to delete.
3) Click Delete Access Level.

Adding and Managing Access Groups

You can configure access privileges by using access levels and user group information.

= Adding Access Group

1) Click ACCESS CONTROL > ADD ACCESS GROUP.

2) Enter Name and Description for the access group.

3) Click + Add for each field.

4) Click + to select an access level, a floor level, a user group or a user.

+ Name

+ Description

+ Access Rule

Add Add
S : “ :

Note

= If no desired access level is available, click + Add Access Level to
create it. For more information on access levels, see Adding and
Managing Access Levels.

= If no desired floor level is available, click + Add Hoor Level to create it.
For more information on floor levels, see Adding and Managing Floor
Levels.

= Click ¥ to delete an item.

4) Click Apply to save the settings.
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= Editing Access Group

1) Click ACCESS CONTROL > Access Group tab.
2) Inthe access group list, select an access group to edit.
3) After editing the necessary fields, click Apply.

= Deleting Access Group

1) Click ACCESS CONTROL > Access Group tab.
2) Inthe access group list, select an access group to delete.
3) Click Delete Access Group.

Adding and Managing Floor Levels
You can configure the floor access privileges by using elevators and floor information.

Note

= The Aoor Level tab and ADD ALOOR LEVEL button will appear when the AC standard
license is activated.

= Adding Floor Level

1) Click ACCESS CONTROL > ADD ALOOR LEVEL.

2) Enter Name and Description for the floor level.

3) Click + Add.

4) Click « to select an elevator, a floor name, and a schedule.

-

Elevator 1 Elevator 1-1+ Always

Note

- Click @, to search for an item.

» If no desired elevator is available, add it by referring to

= If no desired schedule is available, click + Add Schedule to create it. For
more information on configuring schedules, see

= Click ¥ to delete an item.
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5) Click Apply to save the settings.

= Editing Floor Level

1) Click ACCESS CONTROL > Hoor Level tab.

2) In the floor level list, select a floor level to edit.

3) After editing the necessary fields, click Apply.

= Deleting Floor Level

1) Click ACCESS CONTROL > Hoor Level tab.

2) Inthe floor level list, select a floor level to delete.

3) Click Delete Access Level.

Access Group Status

On the Status page, you can view who has the right to access certain doors. You can use a filter or

combine filters to narrow down the result. You can also export the result as a CSV file. There are two

types of the access privilege status view: by user and by door.

1) Click ACCESS CONTROL > Status.

2) Choose Door Permission by Door, Door Permission by User, Elevator permission by Hoor,

or Elevator Permission by User.

3) To view the result of a specific type only, click the T of a column and apply a filter.

Access Group by Door

i

Y Save Filter

2
‘\ 1 /1

50 rows

B

All Doors

All Doers

All Doors

All Doers

All Doors

All Doers

All Doors

All Doors

All Doers

16F

16F

16F

16F

16F

16F

16F

16F

16F

Alw,

Alw:

Alw,

Alw,

Alw,

Alw:

Alw,

Alw;

Alw:

ays

ays

ays

ays

ays

ays

ays

ays

ays

556

33

30

24

a9

User 006
User 26
User 024
User 021
User 018
User 015
User 010
Administrator

kyle

All Users

All Users

All Users

All Users

All Users

All Users

All Users

All Users

All Users

Mone

None

None

None

Mone

None

Mone

Administrator

None
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1 Save Filter Saves the set filter.
Button
You can move a page or set the number of list rows to be displayed on one
page.
Page = | " : Go to the first page.
Navigation .
2 Bugltlgnsl and = | *: Go to the previous page.
Number of « | 2 /2: Enter the page number to move to.
List Rows = [ *: Go to the next page.
» | "I Go to the last page.
« | 21T . get the number of list rows to be displayed on one page.
Function
Buttons . ) . i
3 (Print, CSV You can print the list of logs or save it as a CSV file. Also, the column
Export, settings can be modified.
Column
Setting)
Access
4 Privilege Shows the access privilege status of users.
Status List

You can use the USER menu to add users to BioStar 2 or to devices and manage their information.

You can also add users' fingerprints, manage their authentication credentials such as cards and PINs and

use them in access control, or grant administrator privileges.

Adding and Managing User Groups

Adding User Information

Adding User Credentials

Enroll Card

Transferring User Information to Devices

Editing User Information

Managing Long-term Idle Users
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2 3 4
r— All Users X 1 N

5
0
7 6F USER 0
0

Function Button (Print, Column Setting,
CSV Export, CSV Import, Data File
Export, Data File Import, Send Visual
Face Mobile Enrollment Link)

n

1 Add User f

_ Tab buttons for the User and Long-term Idle User list

€ User List
pages
= Page Navigation Buttons and Number of List Rows 7 User Group
< Registered User Search ¢ Expand Button
Note

» Registered users can be searched by Name, Email.
= For more information on Send Visual Face Mobile Enrollment Link, see

When you select a user, you can perform the following functions.
= Batch Edit: Batch edits the information on multiple users. This function is available only when
multiple users are selected.
» Transfer to Device: Transfers user information registered with BioStar 2 to devices.
= Delete User: Deletes the selected user from BioStar 2. User information registered in
devices is not deleted.

Adding and Managing User Groups

You can add groups for easy management of multiple users. Name your user groups according to users'
organizations for greater convenience.

= Adding User Groups

1) Click USER.
2) Right-click on All User Groups and click Add User Group.
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5 All Users 3

Add User Group

3) Enter a group name.

Note

» User groups may be created in up to 8 levels.
= Up to 48 characters may be entered for a user group name.

= Renaming User Groups

1) Click USER.

2) Right-click on the name of a group you wish to rename and click Rename User
Group.
5 All Users 3

User Group 1 2

Add User Group

3) Enter a group name.

Note

» Up to 48 characters may be entered for a user group name.

= Deleting User Groups

1) Click USER.
2) Right-click on the name of a group you wish to delete and click Delete User
Group.
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5 All Users 3

User Group 1 2

Add User Group

Rename User Group

Delete User Group

Note

» Deleting a group deletes all users in the group from BioStar 2.

Adding User Information

You can add photo, name, email, telephone, etc. of a user.
A fingerprint scanner is required for adding users’ fingerprints. If a fingerprint scanner is already
connected to BioStar 2, you can use the scanner to add fingerprints.

1) Click USER > ADD USER.
2) Enter or select the necessary fields in the Information tab.

Note

= The information with ~ must be entered.
3

2

Information
* Name *+ Email hi 4
+ 1D 5 + Telephone '7 5
1 + Group All Users - + Status @ ) Active ] 5
* Period 2001/01/01 00:00 - 2030/12/31 23:50 | HH
+ Add Photo
- Operator Level User - + Access Group v ]7 7
+ Login ID :’7 g+ UserIP '7 8
13
+ Password ]— 10
12

N

Add the user's photo. Click + Add Photo to select the user's photo.

1 Photo Note

= Only an image file can be uploaded.
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Enter a unique ID to assign to the user.

Note

= When Number is set for User ID Type in Setting > Server, a number

2 ID between 1 and 4294967295 can be entered.

= When Alphanumeric is set for User ID Type in Setting > Server, a
combination of alphabetic characters and numbers can be entered.

= Do not use spaces when entering ID.

= Numbers or Alphanumeric characters can be set for the user ID type.
For more details, refer to Server.

Enter the user's name.

3 Name Note

= Up to 48 characters may be entered for the user's name.

Enter the email address.

Note
4 Email . - - : . .
= |f the mobile access messaging option set as Email, user's email
address is required when using the mobile access.
= User's email address is required when using visual face mobile
enrollment.
Enter the telephone number.
5 Telephone Note
= |f the mobile access messaging option set as Text Message, user's
telephone number is required when using the mobile access.
6 Status You can temporarily deactivate the user's account.
7 Access Set an access group. If no desired access group is available, add it by
Group referring to Adding and Managing Access Groups.
Enter the user IP. If you register user IP, you can strengthen the security by
allowing access only when the IP information registered in the account and
the IP information of the PC match.
8 USERIP Note
= The user IP can be entered in the format xxx.xxx.xxx.xxx. Each octet
can only be entered in numbers between 0 and 255.
= Users whose user IP is not registered can log in regardless of the IP
information of the PC.
] Enter the login ID.
9 Login ID
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Note

* The login ID appears when you set the Operator Level.

Enter the login password. You can change the password level by referring to
Server.

10 | Password Note

» The password appears when you set the Operator Level.
= The Confirm Password will appear when you enter the password.
Enter the password again to confirm.

Set a BioStar operator privilege level.

= None: The user has no operator privilege.

» Administrator: The user can use all menus.

= User Operator: The user can only use the USER and PREFERENCE
menus.

= Monitoring Operator: The user can use the MONITORING and
PREFERENCE menus and only view the DASHBOARD, USER, DEVICE,
DOOR, ZONE and ACCESS CONTROL menus.

11 Operator = Video Operator: The user can only use the VIDEO menu.

Level = T&A Operator: The user can only use the TIME ATTENDANCE menu and
only view the USER menu.

= User: The user can only view own information and T&A records.

Note

= To setanew user permission, refer to Adding Custom Account Level.

= Ifyou have upgraded from BioStar 2.5.0 to BioStar 2.6.0 and you are
using custom account level for monitoring, set operator level again.

12 Period Set an active period of the account.

Select a user group. If no desired user group is available, add it by referring

13
Group to Adding and Managing User Groups.

3) Enter or select the necessary fields in the Credential tab and click Apply. For more information on
adding credentials, see Adding User Credentials.

Note

* You canrefer to the User/Device Management on the Server to learn how to add custom user
fields for extra user information.
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(® Related Information

Export/Import CSV

You can export/import user data in CSV files. This feature is useful when you create users in bulk or
when you transfer users to another 3rd party systems.

Note

» If a CSV file to import contains data for custom user fields and the fields do not exist on the
server, then the data for the fields will be ignored during the import process. You can refer to
the to learn how to add custom user fields.

» If you enter the user information in a language other than English or Korean, save the CSV file
in UTF-8 format.

= CSV Export

1) Select users from the user list you intend to save to a CSV file and click | *** |,
2) Click CSV Export.

Print

Column Setting
CSV Export
CSV Import
Data File Export

Data File Import

3) The CSV file will be downloaded automatically.

= CSV Import

1) Click | *** ' and then click CSV Import.

118



10 Users

2)
3)

4)

Print

Column Setting
CSV Export
CSVolmport
Data File Export

Data File Import

Select the CSV file and then click Open.
Set Start import at row and then click Next.

CSV Import X

« File Import | cr\fakepath\User_201607.. || Browse |

« Start import at row | 2 |

B -

The user data field of the CSV file and the user data field of BioStar 2 are
mapped and displayed automatically. When you click Remap, the fields of the

same name will be remapped.
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5)

120

CSV Import X

Remap
CSV Field
user_id user_id v
name name v
phone phone v
emall email -
user_group user_group v
start_datetime start_datetime v
expiry_datetime expiry_datetime hd
csn None A
csn_mabile None hd N
26 bit S1A Standard... None -
HID 37 bit-H10302 MNone hd
HID 37 bit-H10304 None -

T -

Click Next after selecting whether to maintain the user data of which user ID
has been already registered to BioStar 2 or overwrite with the CSV file
information.

Note

= You can issue Mobile Access Cards via CSV Import. When CSV Import is
complete, 1 credit will be deducted per Mobile Access Card in the Airfob
Portal. Disable matching if you do not want to issue Mobile Access Cards.

= If the same data as the Mobile Access Card issued to the user who is
already registered in BioStar 2 exists in the CSV file, data can be
maintained or overwritten, and the existing Mobile Access Card is
maintained.

= If there is data different from the mobile access card issued to the user
who is already registered in BioStar 2 in the CSV file, the existing Mobile
Access Card is maintained if the data is retained, and if overwritten, a
new Mobile Access Card is issued to the user.

= You can enroll user's visual face via CSV Import. For more information,



10 Users

see

6) If an error occurs during the import of CSV file information, you can upload it
again after checking only the erroneous CSV data.

Note

« If there are additional columns in the CSV file other than the basic user
columns, BioStar 2 will fail to import the CSV file.

Export/Import User Information

You can store the data file on external storage (USB) and import to BioStar 2 or device. Up to 500,000
users can be moved from server to device or from device to device.

Note

» The exported data file from devices using older firmware version cannot be imported into
BioStar 2. Make sure always use the latest version of firmware.

» If the fingerprint template format is different, the data file cannot be imported. For example,
the data file exported from a device which uses the Suprema fingerprint template format
cannot be imported into a device which uses the ISO fingerprint template format.

— Data File Export

1) Select users from the user list you intend to export to a data file and click | ***
2) Click Data Fle Export.

Print

Column Setting
CSV Export
CSV Import
DataFile Export

Data File Import

3) Select a device type to apply the exported data file. Only devices with USB port
is displayed.
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Data File Export X

Please select a device type to apply the exported data file. (Default: BioStation 2)

#) BioStation2
BioStation A2

FaceStation2

N o

4) The data file is automatically downloaded.

Note

= The exported data file includes the profile photo, user ID, name, period,
access group, PIN, auth mode, credentials (face, fingerprint, card), 1:1
security level.

» Be sure that the device is selected correctly. Otherwise, the device cannot
recognize the data file.

= Data File Import

1) Click '+ and then click Data File Import.

Print

Column Setting
CSV Export
CSV Import

Data File Export

Dat@‘ﬁjle Import

2) Select the desired file (*.tgz) and then click Open.
3) A success message will appear on the screen when import successfully.

Adding User Credentials

You can add various user credentials such as PINs, fingerprints and cards.
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Adding PIN

Add a PIN.

1) Select the PIN option and enter a PIN to use.

« PIN sese + Confirm PIN

2) For confirmation, enter the PIN again in Confirm PIN
3) Click Apply to save the settings.

Auth Mode

You can configure an authentication mode for each user.
Select Device Default to allow the user to authenticate using the modes configured in
or select Private Mode to assign a unique authentication mode to each user.

1) Set Auth Mode to Private Mode.
2) Click + Add and configure the settings.
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Add New Auth Mode X

1 —[ + Extended Auth Mode \) Mot Use

#Extended Auth Mode is only supported by FaceStation F2.

[+ Auth Mode

o8 = o

Biometrics ID

N -
O T T ——

Set whether to use Extended Auth Mode. When Extended Auth Mode is set to
Use, the auth mode can be combined including both face and fingerprint.
1 Extended
Auth Mode Note
» Extended Auth Mode is only supported by FaceStation F2.
2 Auth Mode Drag and drop authentication methods to use.

3) Click Apply to add the authentication mode.

Note

» If Exclude Device Default Authentication Mode is set, only the personal authentication
mode set in BioStar 2 can be used. If Include Device Default Authentication Mode is set,
both the authentication mode set in the device and the personal authentication mode set in
BioStar 2 can be used.

+ Auth Mode (._L;' Private Mode

+ Add

e ,v

!_L/ Include Device Default Authentication Mode

124



10 Users

Enroll Fingerprint

You can add the user's fingerprints if the device supports fingerprint authentication. Fingerprints can be
scanned using a finger scanner or at the installation location.

Note

= Make sure that the user's finger is clean and dry.
» Do not add fingers with wounds or faint fingerprints.

1) Click + Fingerprint and configure the settings.

Enroll Fingerprint X

1 4[. Device BioLiteNet 538101276 (192.168.16.213) L 4

2 ——+ Quality [ [ ] -
3 4[|:| View Image

Enroll Fingerprint

4 4[ + Add Scan /9

Delete ———— 8

5 validate I

Duress |——— =

. -
to. | Tem i Descrpton |

1 Device Select a device to enroll the fingerprint with.
. Select a fingerprint enroliment quality level. Any fingerprint which does not
2 Quality . . .
meet the quality requirement will not be enrolled.
3 View Image | Select this option to view the original image when a fingerprint is scanned.
Enroll . . .
4 ) . Click + Add to add a fingerprint. Up to 10 fingerprints can be added.
Fingerprint
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This section shows the analysis of the fingerprint enrolled.
e =
5 |I=|ngerpr|nt s E‘ o = g ":
mage Al -
i Tigmn || Tt
P, -
J'k i& ¥ o g ﬂ
P , N L4 qL b}
Select this option to add the fingerprint as a duress fingerprint. When
6 Duress threatened by someone to open the door, the user can authenticate using
this fingerprint to send an alarm signal to BioStar 2.
2 Validate It is possible to check if the fingerprint has been enrolled already or not
when using the server matching.
8 Delete Deletes the selected fingerprint.
9 Scan Click Scan and then place a finger on the fingerprint scanner or the device
sensor.

2) Click Enroll to enroll the fingerprint.
3) Setthe 1:1 Security Level and click Apply.

Note

» Fingerprints used for regular access should not be registered as duress fingerprints.

» The View Image option shows the fingerprint image but does not store it on BioStar.

» If the fingerprint authentication rate is low, delete the existing fingerprint information and add

a new fingerprint.

» Use an adequate security level. If 1:1 Security Level is too high, the fingerprint

authentication rate may be too low or the false rejection rate (FRR) may be too high.

» For best fingerprint scanning quality, make sure to cover the entire surface of the fingerprint

sensor with the finger. We recommend using the index finger or the middle finger.

Enroll Face

You can add the user's faces if the device supports face authentication.
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Note

= When registering a face, maintain a distance of 40cm to 80cm between the device and the

face.

» Be careful not to change the facial expression. (smiling face, drawn face, wink, etc.)

= If you do not follow the instructions on the screen, the face registration may take longer or

may fail.

» Be careful not to cover the eyes or eyebrows.

» Do not wear hats, masks, sunglasses or eyeglasses.

» Be careful not to display two faces on the screen. Register one person at a time.

= Itis recommended for a user wearing glasses to register both faces with and without glasses.

1) Click + Face and configure the settings.

Enroll Face x

1 4[. Device

Mone -

2 4[. Face Pose Variation . 4

Enroll Face

3 4[ 1st Scan - 7

+ Add Delete .

Use as Profile Image 5

I-E- I ‘ Cancel ‘

[

1 Device Select a device to enroll the face with.
Face Pose Set the sensitivity for the position, angle, and distance of a face when
2 Variation registering the face. Set the sensitivity high if you wish to obtain a detailed
face template.
3 Enroll Face Click + Add to add a face. Up to 5 faces can be added.
4 Face Image | View the registered face.
5 Use as Select the registered face you wish to use as your profile image.
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Profile
Image
6 Delete Deletes the selected face.
7 Scan Click Scan and then follow the instructions on the device screen to scan.

2) Click Enroll to enroll the face.
3) Setthe 1:1 Security Level and click Apply.

Note

» If the face authentication rate is low, delete the existing face information and add a new face.
» Use an adequate security level. If 1:1 Security Level is too high, the authentication rate may
be too low or the false rejection rate (FRR) may be too high.

Enroll Visual Face

Visual Face is a credential that captures the user's face with a visual camera. It is different from face
information captured with an infrared camera and is only available on devices that support Visual Face.
Visual Face can also be registered non-face-to-face using a user's mobile device.

Note

= The devices that can use Visual Face are as follows.
- FaceStation F2

= Register by Device

You can enroll a visual face by FaceStation F2.
1) Click + Visual Face and configure the settings.
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Enroll Visual Face X

1 + Device FaceStation F2 547835989 (192.168.12.175) v

Enroll Visual Face

2 4[ + Add [ Scan N

Upload Image —«—— 5

Delete [

Use as Profile Irrageji 7

= -

o [ren {ouorgion

1 Device Select a device to enroll the visual face with.
Enroll ) . .
. Click + Add to add a visual face. Up to 2 visual faces can be
2 Visual
added.
Face
Visual
3 Face View the registered visual face.
Image
4 Scan Click Scan and then follow the instructions on the device
screen to scan.
Upload the image to use as a visual face.
Note
5 Upload
Image = Itis recommended to use image files larger than
250*250, and the max size of the image is up to
10MB.
» Supported image file formats are JPG, JPEG and PNG.
6 Delete Deletes the selected visual face.
Use as . . i
Select the registered face you wish to use as your profile
7 Profile .
image.
Image

2) Click Enroll to enroll the visual face.
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= Register by CSV Import

You can enroll user's visual face by importing CSV.

1)
2)
3)
4)

5)
6)

Click USER.

Select users from the user list you intend to enroll visual faces.

Export the selected list to a CSV file by referring to CSV Export.

Enter the file name of visual face image, including the extension in visual face
column (face_image_filel, face_image_file2) of CSV file, and then save it.

1 name : phone : email : user_gEmup stan_date:ime expiry_dalztime face_imagejile: face_imagejileZ‘

2 Administrator All Users 2001-01-01 0:00 2030-12-31 23:59 admin_01.png

3 |USER1 012-3456-7890 abc@suprema.cokr All Users 2001-01-01 0:00 2030-12-31 23:59 user_01,jpg user_01_b.png
4 |USER2 def@suprema.co.kr All Users 2001-01-01 0:00  2030-12-31 23:59 user_02,pg user_02_bjpg

5 |USER3 ghi@suprema co.kr All Users 2001-01-01 0:00 2030-12-31 23:59 user_03.png
Import CSV file that added visual faces into BioStar 2 by referring to Import CSV.
Click Browse, select the path where visual face images are stored, then click
Upload.

CSV Import X
+ Face Image Directory
Please select a directory Browse
0%
Success 0
Fail 0
Close
Note

» Itis recommended to use the same path for the CSV file and visual face
image files to be loaded.

= Itis recommended to use image files larger than 250*250, and the max
size of the image is up to 10MB.

» Supported image file formats are JPG, JPEG and PNG.

7) Click Next to complete the CSV import. If an error occurs during the import of
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= Register by Mobile Device

You can send the visible face mobile enrollment link to users via email. Users can
access the link from their mobile device and enroll their visual face directly.

1) Select users from the user list you intend to enroll the visual face and click | ***

All Users 1N soraws v [ =

# Batch Edit [ Transfer To Device W Delete User

Print

Column Setting

1 Administrator - All Users - €SV Export
€3V Import
USERT abc@suprema.co kr All Users
Data File Export

USER2 def@suprema co kr All Users
Data File Import

USER3 ghi@suprema.co.kr All Users = Send Visual Face Mobile Enrollment Link

2) Select Send Visual Face Mobile Enrollment Link and then click Yes. The
visual face enrollment link will be sent to the email of the selected user. When

the user completes the upload, the visual face is enrolled in the user
information.

Note

= Complete the email contents setting before using Visual Face Mobile
Enroliment. See the for more information.

=  You can check whether the email was successfully sent or not in the audit
trail. See the for more information.

= [fthe user receiving the visual face mobile enrollment link uses an external
email application, the language of the email application must be set to the
language of their country. If the language does not support Unicode, the
text in the email may be broken.

=  When the user clicks on Visual Face Mobile Enrollment link, the Visual
Face Enrollment Service is executed as follows.
Follow the instructions on the screen to enroll the visual face.
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BioStar 2

Visual Face Registration

Register

© 2020 SUPREMA INC. ALL RIGHTS RESERVED.

BioStar 2

Visual Face Registration

BioStar 2 Visual Face Registration is required to send limited personal
data on individuals to facilitate the service being provided for the
operator. This information is collected by each operator for the
purpose of providing templates for biometric authentication to users.
All data sent is required and managed by the operator you agree to
provide data for this purpose and the manufacturer does not collect
any data separately.

Personal information to be sent and managed by operator

BioStar 2 Visual Face Registration sends the minimum personal
information required for service delivery. Following information will be
sent through the current webpage once the user agrees on uploading
the image selected.

= Photo taken from current webpage

= Photo selected by user

NEXt
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= [tis recommended to use image files larger than 250* 250, and the max
size of the image is up to 10MB.

» Supported image file formats are JPG, JPEG and PNG.

= Visual Face Enrollment link sent will expire after 24 hours.

Enroll Card

You can assign access cards to users or manage the existing cards.
For the types of card supported by the device, refer to the device manual.

Registering CSN Card

Registering Wiegand Card

File format : PNG/JPG only (Less than SME)

Cancel

Registering Smart / Mobile Cards

[Card Enrollment using the USB Agent]

e | | wegma | smricars

BioStar 2

Visual Face Registration

EM X X X
MIFARE 0 X 0]
DESFire 0] X 0]

FeliCa o X X
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HID Prox X X X

HID iCLASS X X X

Registering CSN Card

You can register the CSN cards.

1) Click + Card.
2) Select CSNfor Card Type.

Enroll Card X

« Card Type CSN L 4
« Registration Register by Card Reader -
Option
+ Device BioStation 2 546832590 (192.168.16.108) 4
Information
« Card ID Read Card
‘ Cancel

3) Select a desired Registration Option.

= Register by Card Reader

You can register a card by scanning the card information with the device connected
to BioStar 2.

a) Select Register by Card Reader for Registration Option.
b) Select the device to scan a card.
c) Click Read Card and scan a card with the device.

= Assign Card
You can assign a registered card to a user.

a) Select Assign Card for Registration Option.
b) Click the card to be assigned from the list or search for the card.
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= Enter Manually
You can register a card by entering a card number directly.
a) Select Enter Manually for Registration Option.

b) Click Use User ID or enter directly.

4) Click Enroll to register a card.

(® Related Information

Card Usage Status

Card Format

Registering Wiegand Card

You can register the Wiegand cards.

1) Click + Card.
2) Select Wiegand for Card Type.

Enroll Card X

« Card Type | Wiegand v |

« Card Data | 26 bit SIA Standard-H10301 4 |
Format

« Registration | Register by Card Reader - |
Option

« Device | BioStation 2 546832590 (192.168.16.108) - |

Information

« Facility Code | || Read card

« Card ID 1 | |

cancel |

3) Seta Card Data Format. If no desired card data format is available, see \Wiegand to set a
Wiegand format.
4) Select a desired Registration Option.

= Register by Card Reader
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You can register a card by scanning the card information with the device connected

to BioStar 2.

a) Select Register by Card Reader for Registration Option.

b) Select the device to scan a card. The available devices will be displayed on the
top of device list, if no device is available, see CSN Card Format of

¢) Click Read Card and scan a card with the device.
= Assign Card
You can assign a registered card to a user.

a) Select Assign Card for Registration Option.
b) Select the card to be assigned from the list.

Note

= Only the cards with the set Card Data Format will be displayed on the
list.

= Enter Manually
You can register a card by entering a card number directly.
a) Select Enter Manually for Registration Option.

b) Enter the Facility Code or Card ID 1.

4) Click Enroll to register a card.

(® Related Information

Registering Smart / Mobile Cards

It is possible to enroll the Access on card or Secure credential card.

Note

= To set the mobile card, set Active for Mobile Card Enrollment on the User/Device
Management tab of Setting > SERVER.

= Toissue a smart card or a mobile card, the correct card type must be set. For detailed
contents regarding the card type, refer to
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1) Click + Card.

Enroll Card X

1)
2)

3)
4)

5)

« Card Type Smart Card - « Device BioStation A2 541531008 (192.1.. =
+ Card Layout + Smart Card Secure Credential Card -
Format Type
Information
« Card ID 12 + PIN

+ Fingerprint

1st Finger 2st Finger

Duress Duress

Iesue Mobile Card | Cancel

Select Smart Card for Card Type.
Select a device where the smart card can be used. To set the smart card layout, refer to Card ID
Format on Authentication.

Set Card Layout Format. It is possible to set the card layout from Smart Card.
Select Smart Card Type.
= Access On Card: Allows you to save user information (Card ID, PIN, Access Group, Period,
and fingerprint templates) on the card.
= Secure Credential Card: Allows you to save user information (Card ID, PIN, and fingerprint
templates) on the card. The authentication is unavailable if the fingerprint template and PIN
information of the user is not in the card, and the authentication is only available when the
user information is stored in the device or BioStar 2. In order to use information stored in
BioStar 2, server matching must be activated.
Select the fingerprint template to be enrolled on the card.

6) Clicking Issue Mobile Card or Write Smart Card will enroll the card.

Note
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= If a mobile card has been issued, it can be used only after the issued card is activated through
the BioStar 2 Mobile app.

» Itis possible to set card ID for the Secure credential card directly.

= The information stored in BioStar 2 is used for the user information to be stored in the smart
card. If the new user information is not stored, incorrect user information may be stored in
the smart card. Also, if the changed user information is not synchronized with the device, the
device may not be able to carry out authentication.

& Related Information

Read/Format Smart Cards

It is possible to format the smart card and record information again.

1) Click + Card.
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2)
3)

4)
5)
6)

Enroll Card x

« Card Type | Read Card v | « Device | None v |
« Card Layout « Smart Card None
Format Type
— Information
+ Card ID + PIN
+ Access Group « Period
+ Fingerprint
1st Finger 2st Finger
Duress Duress

!

Read Card | [ Cancel

Select Read Card for Card Type.

Select a device which can read the smart card. The list of devices only appears when the smart
card layout is set. For setting, refer to Card ID Format on Authentication.

Select Smart Card Type.

Click Read Card.

Check the card information and click Format Card.

(® Related Information

Card Usage Status

Card Format

Enroll Mobile Access Card

You can assign the mobile access to users when using the mobile access in conjunction with Suprema
Airfob Portal.

Mobile Access Card supports registration either of each user individually or of multiple users at once via
CSV Import.
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Depending on the issuance method of Mobile Access Card set in the Airfob Portal, the user's email or

phone number should be entered.

Note

= For more information about using Suprema Airfob Portal and Mobile Access, see Mobile
Access.

1) Click + Mobile.
2) Select a desired Registration Option.

== Assign Card

Unassigned CSN Mobile cards registered in BioStar 2 can be assigned to users.
a) Select Assign Card for Registration Option.

Enroll Card X

- Card Type | CSN Mobile - |

+ Registration | Assign Card v |

Option . ’

| xJ[@])E=IE ) FI6 [ sorows ~ |

Card ID Type Status

159609338918850 CSN Mobile Unassigned
1596096 75842251 CSM Mobile Unassigned
159609677396051 CSM Mobile Unassigned
159609709440751 CSN Mobile Unassigned
15960974T048552 CSN Mobile Unassigned

@

b) Click the card to be assigned from the list or search for the card.

Enter Manually

CSN Mobile cards can be registered with a card ID entered manually or a random
card ID.
a) Select Enter Manually for Registration Option.
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Enroll Card X

« Card Type | CSN Mobile v |
« Registration | Enter Manually v |
Option . ’
Information
. CardID | 159617081751551 | UseuseriD |
+ Input Type C) Use random card 1D

b) If Input Type is set as Use random card ID, a card ID is automatically
generated. Click Use User ID to use the user ID as the card ID.
If Input Type is set at Enter manually, a card ID can be entered manually.

Note

» Itis recommended to set Input Type to Use random card ID to
prevent duplicate card ID generation.

3) Click Enroll to register a mobile access card.

Note

» If the activation code sent to you via email or text message is lost or deleted, you can reissue
the activation code by clicking Reissue. However, Mobile Access Cards activated in the Airfob
Portal cannot be reissued.

|' Reissue |

| Block | W

CSN Mobile Mobile Access Card 1D: 159609752740350

& Related Information

Adding User Information

Mobile Access

Transferring User Information to Devices

You can transfer user information registered with BioStar 2 to devices.
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1) Select a user to transfer and click Transfer to Device.

Transfer To Device X

Users (3)
+ Device List
] All Devices
[] 16F
I:‘ i BioLiteNet 538101276 (192.168.16.230)

|:| Overwrite users with different information

Cancel

2) Select the Overwrite users with different information option to overwrite duplicate user
information.

3) Select devices to transfer the information to. Click Q, to search for a device.

4) Click Transfer to transfer the user information.

(® Related Information

Managing Users Registered with Devices

Deleting User from Devices

You can delete users from each device registered in BioStar 2.

1) Select a user to delete from the device and click Delete From Device.
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Delete From Device X

Users (3)
* Device List
Q,
All Devices
14F
Em -
Note

= The Delete From Device button is activated only when the Automatic User
Synchronization is set as Not Used. You can refer to the User/Device Management for
more detailed information on the Automatic User Synchronization.

2) Select devices to delete the users. Click Q, to search for a device.
3) Click Delete to delete users.

Note
=  When you delete a user, it is only deleted from the device and the user in BioStar 2 remains
intact.

Editing User Information

You can edit an existing user or batch edit multiple users.

1) Inthe user list, click a user to edit.
2) Edit the details by referring to the instructions in Adding User Information, Adding User Credentials

and Enroll Card.
3) To batch edit information of multiple users, select multiple users and click Batch Edit.
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Batch Edit X

Users (19)
+ Group
Active

+ Status

+ Period

+ Access Group

SN N NN

+ Operator Level

B o

4) Click # of a field to edit its information.
5) Click OK to save the changes.

Note

= You cannot modify the Operator Level of "Administrator".

Managing Long-term Idle Users

You can view, edit and delete the users who do not have access events for the recent months.
You can use a filter or combine filters to narrow down the result and export it as a CSV file.

1) Click Status tab.

2) Setthe idle period. You can choose from one month to six months.

3) You can narrow down the result by setting the filters on the headers of the result table.
4) Click Delete User after selecting multiple users if you want to delete the multiple users.

Note

= Only users with the operator level of Administrator or User Operator can use the Delete
User menu. You can refer to the Adding User Information for more detailed information on
the operator level.

On the ZONE page, you can add anti-passback, fire alarm, schedule lock and schedule unlock zones, and
configure the settings.
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Anti-passback Zone
Fire Alarm Zone
Schedule Lock Zone
Scheduled Unlock Zone
Intrusion Alarm Zone
Interlock Zone

Muster Zone

Note

= The ZONE menu will appear when the Advanced or higher license is activated.

2 3
1 4[ Anti-passback \[ " 1 g e }[ v
7 —[> [© anti-passback E]]i 4
e slerm - Name Entry Devices Exit Devices Active/Inactive Status
senedleg Lok APB 1 BioStation L2 542501048 (192. Wiegand Reader 0 (1616242872)  Active Hormal
6 Scheduled Unlock
Intrusion Alarm
Interlock 5
1 Add Zone £ Zone List
2 Page Navigation Buttons and Number of List Rows € Zone Type
> Registered Zone Search 7 Expand Button

< Function Button (Column Setting)

Anti-passback Zone

Anti-passback zone provides an enhanced function than the door based anti-passback feature.

1) Click ZONE and click ADD ZONE.
2) Click Anti-passback and click Apply.
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Information

—

* Name

Configuration

Alarm

-

* Mode

+ Anti-passback Type

« Entry Confirmed APB

- Entry Devices

+ Network
Failure Action

*+ Action

APB Bypass

—

- Bypass Group

APB 1 * Type

Global « Active/Inactive

* Reset Time 1440 min,

Follows door configuratio

2.168.14.221 » Exit Devices Xpass D2 400000005

+Add

o o Jomogion

Information

Modify the settings of the anti-passback zone.

= Name: Enter an anti-passback name.
= Type: View the zone type.

Configuratio
n

Modify the zone settings of the anti-passback.

» Mode: It is possible to set either Local or Global for the range of zone
application. If Local is set, the zone can be set only with the entry devices
and devices connected with RS-485, and if Global is set, the zone can be
set with all devices enrolled in BioStar 2.

» Active/Inactive: You can disable the anti-passback zone. Select Active
to enable it.

» Anti-passback Type: Select an Anti-passback type.

» Reset Time: You can set a time period so that all anti-passback violations
can be deleted. This allows the user to be granted access after the time
period. The maximum possible duration is 7 days (10080 minutes). If set
to 0, anti-passpack violations will not be deleted and the users who have
previously violated the anti-passback rule will not be granted access.

« Entry Confirmed APB: You can set the range to apply the anti-passback.
If Entry Confirmed APB is set to ON, the anti-passback is applied
according to the actual operation of the door that the entry and exit device
are configured. If this option is set to OFF, the rule is applied according to
the user's authentication regardless of the door operation. When set to
Follows door configuration, the anti-passback rule is applied according
to the setting of the Use sensor when Entry Confirmed APB enabled
option of the door.

» Entry Devices: Select a device to use for entry. You can select a device
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from the list of added devices. If no registered device is available, see
Basic Search and Registration, Advanced Search and Registration,
Wiegand Device Search and Registration, or Slave Device Search and
Registration.

= Exit Devices: Select a device to use at exit. You can select a device from
the list of added devices. If there is no registered slave device, see Basic
Search and Registration, Advanced Search and Registration, Wiegand
Device Search and Registration, or Slave Device Search and Registration.

= Network Failure Action: It is possible to set the door operation in case
the communication between BioStar 2 and the device where anti-passback
is set has been lost. Setting is available when Global is set for Mode.
When Open by auth is set, the door opens when the user has been
authenticated normally. When Open by auth & record APB log is set,
an anti-passback violation alarm occurs and the door opens. When Door
locked & record APB log is set, an anti-passback violation alarm occurs
and the door does not open.

3 Alarm

Choose the operation to be triggered when an APB violation occurs.

4 APB Bypass

Select an access level. Users who have the access level will not be restricted
by the anti-passback rule.

3) Click Apply to save the settings.

Related Information

Anti-passback

Fire Alarm Zone

Configure the fire alarm zone.

1) Click ZONE and click ADD ZONE.
2) Click Are Alarm and click Apply.
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Information

1 + Name + Type

Configuration

Mode (I vLocal Active/Inactive [ ) Active
+ Door Door 1 - + Elevator

+ Device / Input

Alarm

3 <|i + Action
e Tren o

Modify the settings of the fire alarm zone.
1 Information
= Name: Enter a fire alarm zone name.
» Type: View the zone type.
Modify the zone settings of the anti-passback.
= Mode: You can set fire alarm in two different modes. Local mode will
allow the master device and slave devices that are connected via RS-485
to be selected. Global mode will allow selection of all devices added to
BioStar 2.
= Active/Inactive: Disable the fire alarm zone. Select Active to enable
it.
» Door: Select the door(s) to include in the fire alarm zone.
2 Configuratio | . Elevator: Select the elevators to include in the fire alarm zone. You can
n select multiple elevators.
= Device/Input: Click + Add and configure the device to set off the fire
alarm signal.
Note
= When Local is set for Mode, either Door or Elevator can be set as
the fire zone.
= When Global is set for Mode, both Door and Elevator can be set
as the fire zone at the same time.
3 Alarm Choose the operation to be triggered when a fire alarm signal occurs.

3) Click Apply to save the settings.
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Scheduled Lock Zone

You can configure the scheduled lock zone. The scheduled lock zone keeps the door locked based on the

schedule that has been set.

1) Click ZONE and click ADD ZONE.
2) Click Scheduled Lock and click Apply.

[ Information

+ Name

[ Configuration

5 + Active/Inactive Active
+ Door Door 1
[ Alarm
3 —
+ Action
[ Scheduled Lock Bypass

+ Bypass Group Mot Use

Exit Allowed

+ Add

o (menJomoion

1 Information

= Type: View the zone type.

Modify the settings of the scheduled lock zone.

= Name: Enter a scheduled lock zone name.

enable it.
Configuratio

Modify the zone settings of the scheduled lock.

= Active/Inactive: Disable the scheduled lock zone. Select Active to

2 » Lock Type: You can configure the zone to lock only the entering device,

n

Add Schedule to create it.

or to lock both entering and exiting device.
» Door: Select the door(s) to include in the scheduled lock zone.
» Schedule: Select a schedule. If no desired schedule is available, click +

3 Alarm

Choose the operation to be triggered when a scheduled lock signal occurs.

Lock Bypass | by the scheduled lock rule.

Scheduled Select an access level. Users who have the access level will not be restricted

3) Click Apply to save the settings.
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Scheduled Unlock Zone

You can configure the scheduled unlock zone. The scheduled unlock zone keeps the door open based on
the schedule that has been set.

1) Click ZONE and click ADD ZONE.
2) Click Scheduled Unlock and click Apply.

[ Information

+ Name « Type

[ Configuration

+ Active/Inactive ") Active - Started by
User Authentication

+ Door/Elevator B 0Door « Schedule -
»

+ Door

[ Scheduled Unlock Authentication

- Access Group Not Use

o (menJomoion

Modify the settings of the scheduled unlock zone.

1 Information

= Name: Enter a scheduled unlock zone name.

= Type: View the zone type.

Modify the zone settings of the scheduled unlock.

» Active/Inactive: Disable the scheduled unlock zone. Select Active to
enable it.

» Started by User Authentication: When set as Active, the user who
belongs to the access group must authenticate in the configured schedule
to start a schedule unlock.

= Door/Elevator: You can set doors or elevators as schedule unlock zones.

Configuratio | * Schedule: Select a schedule. If no desired schedule is available, click +

2 N Add Schedule to create it.
= Door: If you select Door, the door list is activated. Select the door(s) to
include in the scheduled unlock zone.

» Elevator: If you select Elevator, the elevator list is activated. Select the
elevators to include in the scheduled unlock zone. You can select multiple
elevators.

= Hoor: You can select the floor of the selected elevator.

Note
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» If you select an elevator that has already been configured with a
different scheduled unlock zone, you cannot set the same floor.

Choose the operation to be triggered when a scheduled unlock signal

3 Alarm
occurs.
Scheduled
4 Unlock You can select the access group where the user belongs who can start a
Authenticati | scheduled unlock.
on

3) Click Apply to save the settings.

Intrusion Alarm Zone

When intrusion alarm zone is used, you can detect trespassing of an unauthorized user to a designated
zone without permission.

1) Click ZONE and click ADD ZONE.
2) Click Intrusion Alarm and click Apply.

[ Information

+ Name « Type

[ Configuration

7 — -+ Mode Local = Active/Inactive @) Active

+ Deor 14F Door 01 v * The sensor of this door can be used as detecting intrusion

[ Arm/ Disarm Setting

+ Delay Time Arm 0 =1 Disarm 0 =1

+ Arm/Disarm Card ) + Arm/Disarm Group None

+ Arm/Disarm Setting
(Device)

+ Arm/Disarm Setting
(Input)

[ Intrusion Setting

+ Detect Intrusion

[ Alarm

+ Configuration

Modify the settings of the intrusion alarm zone.

1 Information

= Name: Enter an intrusion alarm zone name.
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» Type: View the zone type.

You can change the general settings of an intrusion alarm zone.

» Mode: You can check the application range of the zone. Only Local mode

Configuratio is supported for intrusion alarm zone, and the zone can be set only with
n devices connected to the entry device and RS-485.
= Active/Inactive: You can disable the intrusion alarm zone. Select
Active to enable it.
= Door: Select the doors to include in the intrusion alarm zone.
You can add an authentication setting for arm and disarm.
= Delay Time: You can set the delay time to arm or disarm. Armis the
delay time from the authentication to the arm, and Disarm is the delay
time from the intrusion detection to the alarm occurs.
» Access Card: You can add a card with permission to arm or disarm. You
can register up to 128 access cards.
= Access Group: You can add an access group with permission to arm or
disarm. You can register up to 128 access groups.
= Arm/Disarm Setting: You can set the arming and disarming by device
or input signal. Click + Add and set each item.
Add arming and disarming by device
Click Device to select a device to control the intrusion alarm zone among
the entry and exit devices of the door, and select Arm Type.
Card, Key, and Card or Key can be selected for the Input type. Only
Arm / Card is available as the input type for a device with no LCD screen.
Disarm
Setting

« Device

BioStation L2 542501048 (192.168.14.125)

« Arm Type

Arm / Disarm

+ Input Type

Card or Key

e [T
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Add arming and disarming by input signal

Click Device to select the device that controls the intrusion alarm zone.
Click Port and select an input port of the selected device.

Select Arm Type and set the switch type and the signal duration.

Add Arm/Disarm Setting (Input) X

Setting
+ Device + Switch
Y

| BioStation L2 542501048 ... v | @) rormally open
+ Port + Duration{ms)

| Input Port 0 v | | 100 =
+ Arm Type

| Arm / Disarm v |

B -

Note

» Itis activated only when Door is set from Configuration.

Intrusion
Setting

You can set the intrusion detection signal. When you click + Add and set as
shown in the screen below, the device recognizes the detection of intrusion if
N/O sensor connected to input port 0 of BioStation L2 sends a signal for
100(ms).
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Add Intrusion Setting X

+ Device « Switch
™
| BioStation L2 542501048 ... v | @) rormally open
+ Port + Duration{ms)
| Input Port 0 v | | 100 =

Cancel

Note

» It is activated only when Door is set from Configuration.

5 Alarm

Set the alarm action to carry out when a specific event occurs at the
intrusion alarm zone.

Note

= It is activated only when Door is set from Configuration.

3) Click Apply to save the settings.

Interlock Zone

Interlock zone monitors the status of two or more doors by door sensor and relay state to control that
one door cannot be opened or close if other doors are open or unlocked. You can also disable access if
a user stays within the zone.

154



11 Zone

Note

= Aninterlock zone can be configured with up to 4 doors.
= Aninterlock zone can only set the doors with the devices connected to the CoreStation.

= A device set as an interlock zone cannot be set to another zone.
= A door set as an interlock zone cannot be set to another zone other than the fire alarm zone.

1) Click ZONE and click ADD ZONE.
2) Click Interlock and click Apply.
3) Edit the necessary items.

[ Information

* Name

[ Configuration

2 — | * Mode

* Door

[ option

* Action

[ Alarm

* Action

- Type

Local « Active/Inactive @) Active

Door 2 v * Door sensor must be set to use.

+Add

o (mn Jomoon

Modify the settings of the interlock zone.
1 Information .
= Name: Enter an interlock zone name.
= Type: View the zone type.
You can change the general settings of an interlock zone.
= Mode: You can check the application range of the zone. Only Local mode
i . is supported for interlock zone, and the zone can be set only with devices
Configuratio ]
2 N connected to the CoreStation and RS-485.
» Active/Inactive: You can disable the interlock zone. Select Active to
enable it.
= Door: Select the doors to include in the interlock zone. You must select at
least two doors that are the door sensor is connected.
If a user stays in the zone, this option can prevent others from entering the
zone.
3 Option
Note
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= Itis activated only when Door is set from Configuration.

4 Alarm

Set the alarm action to carry out when a specific event occurs at the
interlock zone.

Note

» It is activated only when Door is set from Configuration.

4) Click Apply to save the settings.

Muster Zone

The muster zone is used as a place where users gather when an emergency occurs. It can also be used

for the purpose of monitoring the number of users and list of users in a specific area, or for notifying the

manager of alarms and alerts when a user stays in a specific area for a long time.

1) Click ZONE and click ADD ZONE.
2) Click Muster and click Apply.
3) Edit the necessary items.

[ Information

* Name

Configuration

* Mode
« Entry Devices

+ Access Group

Alarm

* Action

* Type

Global * Active/Inactive ’—\ Active

BioLiteNet 538101276 v * Exit Devices BioStation 2 546832506 v

AG 1 v * Max Time Limit 0 min.

—:“-‘Mld

o [ron  Jomown

Modify the settings of the muster zone.

1 Information
= Name: Enter a muster zone name.
= Type: View the zone type.
You can change the general settings of a muster zone.
5 Configuratio | = Mode: You can check the application range of the zone. Only Global mode
n is supported for muster zone, and the zone can be set with all devices

added to BioStar 2.
= Active/Inactive: You can disable the muster zone. Select Active to
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enable it.

Entry Devices: Select a device to use for entry. You can select a device
from the list of added devices. If no registered device is available, see
Basic Search and Registration, Advanced Search and Registration,
Wiegand Device Search and Registration, or Slave Device Search and
Registration.

Exit Devices: Select a device to use at exit. You can select a device from
the list of added devices. If there is no registered slave device, see Basic
Search and Registration, Advanced Search and Registration, Wiegand
Device Search and Registration, or Slave Device Search and Registration.
Access Group: Set the access group to which the user who will be
staying in the muster zone. Up to 16 access groups can be set.

Max Time Limit: Set the maximum amount of time that user can stay in
the zone. It can be set up to 4320 minutes, and an alarm occurs when the
user stays in the muster zone exceeding the specified time.

3 Alarm

Set the alarm action to carry out when a specific event occurs at the muster
Zone.

Note

= Itis activated only when Entry Devices and Exit Devices is set
from Configuration.

4) Click Apply to save the settings.

You can use the MONITORING menu to view lists of access control events, device and door status, zone

status and the alert history.

You can see and control the status of the doors in real-time in the graphic if you add a graphic map.

List View

Graphic Map View

157



12 Monitoring

'
z—{»

List View Graphic Map View

= EventLog
(®) Real-time Log
Device Status
[ poor status
[T Froor Status
© zone status
’(D‘ Alert History

i} Thermal Report

e

= Event Log
[ vsaveriter |- Period | «| 10ay(9 202010112 0000~ 202011012 2359) v | » ]— 1 [Z]]— 6
Date Door A 4 Device ID T Device Al User Group A User T Event Y View

2020/10/12 15:0. 547836011 FaceStation F2 5478, All Users 2(user 01) User update succeeded (Bio.
2020/10/12 15.0. 547836011 FacesStation F2 5478 All Users 1(Administrator) User update succeeded (Bio.
2020/10/12 145 547836011 FaceStation F2 5478, All Users T(Administrator) User update succeeded (Bio.
2020/10/12 14:5. 547836011 FaceStation F2 5478, BioStar connected

2020/10/1214:3. 547836011 FaceStation F2 5478. Tamper on

2020/10/12 14:3. 547836011 FaceStation F2 5478, DHCP connected

2020/10/1214:3. 547836011 FaceStation F2 5478, Device started

547836011 FaceStation F2 5478. Network connected

2020/10/1214:3.

1 Tab buttons for List View and Graphic Map View

z Expand Button

> Save Filter Button

< Search period of Event Log

(3. ]

Page Navigation Buttons and Number
of List Rows

Function Button (Print, CSV Export,
Data File Import, Column Setting)

List of Selected Monitoring Items

Monitoring Categories

Note

List View

The Hoor Status, Zone Status and Graphic Map View will appear when the AC standard

license is activated.

The Live Video Viewl menu will appear when the Video license is activated.

You can see lists of access control events, device and door status, zone status and the alert history.

You can also apply filters to the collected monitoring data and view specific types of monitoring

information.

Event Log

Real-time Log

Live Video View

Device Status

Door Status

Floor Status

Zone Status

Alert History

Thermal Report
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Note

= The Hoor Status and Zone Status menu will appear when the AC standard license is
activated.
= The Live Video Viewl menu will appear when the Video license is activated.

Event Log

You can view all the logs of all past events. You can also apply various filters to sort the displayed data.

Note

= Make sure to check the time and date setting of the device. For more information on
configuring device time, see Information.

= When the image log is set, you can view or store a stored image in its actual size.

» Use a separate storage media for the video log. Video logs might not be saved if the video
storage space is reduced by the external processing(such as copying files and creating files),
To change the path to save video logs, see Video.

1) Click MONITORING > List View > Event Log.
2) To view log entries of a specific type only, click the Yof a column and apply a filter.

3

= Event Log «| » || s0rows ¥

1 4[ Y Save Filter * Period 4 | 1Day(s) (2018/12/12 00:00 ~ 2018/12/12 23:59) ¥ | » ]— 2 [B ]— 4

2018/12/1213:36 542501048 BioStation L2 542501.. DHCP connected
2018/12/1213:36 542501048 BioStation L2 542501... 1:N authentication failed (Fingerpr.
2018/12/12 13:36, 542501048 BioStation L2 542501... Network connected
2018/12/1213:36. 542501048 BioStation L2 542501 Network disconnected
5 2018/12/12 13:36. 542501048 BioStation L2 542501 All Users 55(Simba) User deletion succeeded (BioStar)
2018/12/1213:28. 542501048 BioStation L2 542501... All users 55(Simba) Access denied (Invalid access gro.
2018/12/12 09:47 542501048 BioStation L2 542501... All Users 55(Simba) User update succeeded (BioStar)
2018/12/12 09:47 542501048 BioStation L2 542501... All Users 55(Simba) User enroliment succeeded (Device)
2018/12/12 09:45 542501048 BioStation L2 542501... All Users 2(User 01) User update succeeded (BioStar)
2018/12/12 09:45 542501048 BioStation L2 542501... All users 1(Administra... User update succeeded (BioStar)
L |2018/12/12 09:42. 538101276 BioLiteNet 538101276 Tamper on
o [z Jowerpen
1 Save Filter Saves the set filter.
Button
2 Period You can set a desired period and sort event logs.
Page You can move a page or set the number of list rows to be displayed on one
3 Navigation ade
Buttons and page.
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= | "I Go to the first page.

Number of
List Rows = | *I: Go to the previous page.
210w ¥+ Set the number of list rows to be displayed on one page.
You can use the additional features with event logs.
) = Print the event log
Function
Buttons = Export to CSV file

(Print, CSV = Import the data file
Export, Data | = Change the column setting

File Import,
Column :
Setting) Note
= For more information about importing a data file, see Import Event
Logs.
Event Log Shows the event log. When an image log exists, it is displayed as 2] and
you can view or store a captured image in its actual size in PC.
Note

When Log Upload is set to Manual, the user can import the log manually by clicking Update
Log. For how to change log upload setting, refer to Server.

Latest
All 1 + | » ] 50 rows

From To
Update Log [Z]

If Latest is set, the log saved after the date of the log saved last in BioStar 2 will be imported

from the device, and if All is set, all logs of the device will be imported to BioStar 2. You can
also set a date range within which to import logs.

Import Event Logs

You can view all the logs of all past events. You can also apply various filters to sort the displayed data.
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Note

The exported data file from devices using older firmware version cannot be imported into
BioStar 2. Make sure always use the latest version of firmware.

Only data files exported from FaceStation 2, BioStation A2, and BioStation 2 can be imported.
Some information of event log may appear as a blank if a door, elevator, or zone is not set by
the BioStar 2.
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1) Click | *** | and then click Data Fle Import.

Print

CSV Export

Datﬂ{%le Import

Column Setting

2) Select the desired file (*.tgz) and then click Open.
3) A success message will appear on the screen when import successfully.

Real-time Log

You can view a log of various events in real time.

Note

= Make sure to check the time and date setting of the device. For more information on
configuring the device time, see Information.

» The real-time log can only be viewed while the Real-time Log page is displayed. In other
words, when the administrator is viewing another page for changing device settings, etc., the
real-time log cannot be viewed.

» If Log Upload is set to Manual in the Server, the real-time log cannot be viewed.

= When the image log is set, you can view or store a stored image in its actual size.

1) Click MONITORING > List View > Real-time Log.
2) To view log entries of a specific type only, click the T of a column and apply a filter.

2 3

® Real-time Log

1 —[ Y Save Filter Q Clear IZ] ]7 4

2015/11/20 14:51:06 541530948 BioStation A2 5. Administrator Authentication failed =]
5 2015/11/20 14:50:41 541530948 BioStation A25.. Administrator 1:1 authentication su..  [Z]
2015/11/20 14:50:29 541530948 BioStation A2 5. Administrator 1:N authentication su =]
2015/11/20 14:50:22 541530948 BioStation A2 5.. Administrator Access denied (Captu... @

Saves the set filter.

1 Save Filter
Button
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2 Start/Pause | payses or starts real-time log collection.
Button
Clears the collected log information. To view the entire event log, see Event
3 Clear Button
Log.
Function
4 Buttons Changes the column setting of the log.
(Column
Setting)
Shows the event log. When an image log occurs, a notification will pop up on
5 Event Log the left side of the browser screen and you can view a captured image in its
actual size of store in PC. You can also press 2] to check.

Live Video View

You can see the screen of IP camera set in Video menu and event log set up in real time. In addition,
Open, Manual Unlock, Manual Lock, and Release functions are available for the door control function.

Note

» The Live Video Viewl menu will appear when the Video license is activated.

= For more information on registering the NVR and IP camera, see Video.

= IP cameras that do not support the live streaming feature are displayed as "Disconnected".
= PC-NVR does not support the live video view.

1) Click MONITORING > List View > Live Video View.

v Live Video View

AXIS (M3203)(door 1) - a B HIKVISION IPC-HFW1420S(... ~ Al AXIS (M3203)(door 5) - aa x

- '][

| m g |

AXIS (M3203)(door 2) A o o AXIS (M3203)(door 3) A o B AXIS (M3203)(door4) o O
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2) Refer to the explanation below for how to operate the screen.
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Select the IP camera to monitor. If there is no desired the IP camera, see
1 IP camera .
Video.
2 Open Open the door temporarily.
3 Manual Unlock the door manually.
Unlock
4 Manual Lock | Lock the door manually.
5 Release Release the manual unlock or manual lock.
6 I\;iaerv%e size The live view screen can be viewed in a large size.
Device Status

You can view various device status information such as the device status, alarm and last event.

1) Click MONITORING > List View > Device Status.
2) To view log entries of a specific type only, click the T of a column and apply a filter.
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Device Status

T -

Device Name T Last Event

3 [] BioLiteNet 538101268 Normal

|:| BioLiteMet 538101276 (19.. Mormal

o (menJomoion

1 Save Filter Saves the set filter.
Button
Function
Buttons :
2 Changes the column setting of the log.
(Column g g g
Setting)
3 . Shows the device status list.
Status List = Select a device and click Clear Alarm to clear the alarm.

Door Status

You can view various door status information such as the door status, relay status, alarm and last
event.
You can also apply various filters to sort the displayed data.

1) Click MONITORING > List View > Door Status.
2) To view log entries of a specific type only, click the T of a column and apply a filter.

O Door Status

1 4[ Y Save Filter E]i 2

door 2 Closed Normal Locked

o o Jomogion

1 Save Filter Saves the set filter.
Button

Function
2 Buttons

(Column
Setting)

Changes the column setting of the log.
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Shows the door status list.
The following operations are available for the selected door:

= Manual Lock: Click after selecting a door to lock the door manually. If you
set Manual Lock, the door will have remained inaccessible even if a user
authenticates.

» Manual Unlock: Click after selecting a door to unlock the door manually.
If you set Manual Unlock, the door will have remained accessible even if a
user does not authenticate.

= Release: Release the manual lock or manual unlock set by the
administrator.

= Open: Click after selecting a door to open the door temporarily.

» Clear Alarm: Clear alarms of all doors. If an alarm is set in the Zone, the
alarm may be continuously output even if the door alarm is released. Click
Clear Alarmon Zone Status.

= Clear APB: Reset the anti-passback violation by selecting all or each user.

3 Status List

Note

Refer to below for the explanation on door events.

» Fre alarm unlocked: A state where the door designated as a fire alarm zone is unlocked
because a fire has broken out.

= Manual Lock: A state where the door is locked because the administrator has locked it
manually.

= Manual Unlock: A state where the door is unlocked and able to enter without an
authentication because the administrator has unlocked it manually.

» Schedule Locked: A state where the door is locked by the schedule that has been set.

= Schedule Unlocked: A state where the door is unlocked by the schedule that has been set.

= Normal: A state where a user can enter the door after an authentication.

Floor Status

You can view various floor status information such as the floor status, relay status, alarm and last
event.

Note

= The Roor Status menu will appear when the Advance or higher license is activated.

1) Click MONITORING > List View > Aoor Status.
2) To view log entries of a specific type only, click the T of a column and apply a filter.
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2
F|00I' Status x M ] 1 |41 | » ] 50 rows v

1 4[ Y Save Filter IZ] j’— 3

T FloorName Y  Floor Status Type Floor Relay

Elevator 1 Elevator 1-1 Normal Unlock

Elevator 1 Elevator 1 -2 Normal Locked

Elevator 1 Elevator1-3 Normal Locked

Elevator 1 Elevator 1 - 4 Normal Locked

|
u
U
d
a
d

Elevator 1 Elevator1-5 Normal Locked

o [ron  Jomown

1 Save Filter
Button

Saves the set filter.

Function
2 Buttons

(Column
Setting)

Changes the column setting of the log.

Shows the floor status list.
The following operations are available for the selected floor:

= Manual Lock: Click after selecting a floor to lock the floor manually.

» Manual Unlock: Click after selecting a floor to unlock the floor manually.
= Release: Release the manual lock.

= Open: Click after selecting a floor to open the floor temporarily.

= Clear Alarm: Clears alarms of all floors.

3 Status List

Zone Status

View zone status information such as the zone active status, alarm status, and the last event that has
occurred.

Note

= The Zone Status menu will appear when the Standard or higher license is activated.

1) Click MONITORING > List View > Zone Status.
2) To view log entries of a specific type only, click the T of a column and apply a filter.
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© Zone Status

1 4[ Y Save Filter E] ]— 2

Zone Name Y Active/Ina...

3 D Anti-passb... APB1 Active MNormal

[ Muster Muster 1 Active Normal Muster Status

o Jron—Jomogion

1 Save Filter

Saves the set filter.
Button

Function
2 Button

(Column
Setting)

Changes the column setting of the log.

Shows the zone status list.
The following operations are available for the selected zone:

= Clear APB: Reset the anti-passback violation by selecting all or each user.
This can be only used when selecting an anti-passback zone.

= Clear Alarm: Release the anti-passback violation alarm when selecting an
anti-passback zone, and closes the door relays that has been opened by
the fire alarm when selecting a fire alarm zone.

3 Status List )
Note

= If a muster zone is set, you can check the user's status by clicking
the Muster Status.

<+ Muster 1 <) (7 Jer (2 )] | s0roms +

InUsers 0, OutUsers 1, TotalUsers 2 Auto refresh at every minute E]

1 Administrator Al Users - - Hormal

2 > All Users B 2018/03/01 12:48:27 Hormal m

Alert History

You can view the history and status of various alerts. You can also apply various filters to sort the
displayed data.

1) Click MONITORING > List View > Alert History.
2) To view log entries of a specific type only, click the T of a column and apply a filter.
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@ Alert History W <) v e (o) o] | sorows ~

1 —[ Y Save Filter @]7 3
Date T Device T User h Alarm T Ack. By Status
4

2016/07/20 09:16:45 BioLiteNet 5381012.. Tamper on Administrator 2016/07/20 09:16

o Jaen oo

1 Save Filter Saves the set filter.
Button
You can move a page or set the number of list rows to be displayed on one
page.
Page » | M Go to the first page.
2 Indicator and | = | */: Go to the previous page.
Navigation . [z .
Buttons : Enter the page number to move to.
= " Go to the next page.
» | "I Go to the last page.
221ows = | get the number of list rows to be displayed on one page.
Function
Buttons
3 (Print, Prints the log or changes the column setting.
Column
Setting)
4 | _ Shows the alert list.
Alert History Click & to view the alert details.

Thermal Report

You can view the events including user's temperature information.

1) Click MONITORING > List View > Thermal Report.
2) To view log entries of a specific type only, click the T of a column and apply a filter.

4
2
{ Thermal Report x < s ) 50rows

1 —[ Y SeveFiter |+ Period | « | 1Day(s) (2020/10/12 00:00 ~ 2020/10/1223:59) ¥ | » + Celsius/Fahrenheir () Celsius (‘C) ]7 3 B]ﬁ 5
Date User Group v User v Device T Telephone Email Temper.. Event v
5 2020110112 151655 AllUsers 2test) FaceStation F2 547635994 (192.168..  010-4442-4444 test@test.com 2930 Accsss denied (Temp. not measured correctly)
2020/10/1215:16:51 All Users 2(test) FaceSt; F2 547835994 (192.168. 010-4444-4444 test@test.com 29.30 Access denied (Temp. not measured correctly)

2020/10/12 15:16:48 All Users 2test) FaceStation F2 547835994 (192,168 010-4442-4444 test@test.com 2910 Access Genied (Temp. not measured correctly)
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1 Save Filter Saves the set filter.
Button
2 Period You can set a desired period and sort thermal reports.
3 Celsius/ You can set the unit of temperature.
Fahrenheit
You can move a page or set the number of list rows to be displayed on one
Page page.
Navigation
4 Buttons and | . [ |: Go to the first page.
Number of _
List ROWS = | *I: Go to the previous page.
210w ¥+ Set the number of list rows to be displayed on one page.
Function You can use the additional features with thermal reports.
Buttons
5 (Print, CSV = Print the event log
Export,
Column = Export to CSV file
Setting) = Change the column setting
6 Reports You can view the events including user's temperature information.

Thermal & Mask

Graphic Map View

(® Related Information

If you add a graphic map, you can see and control the status of the doors in real-time in the graphic.

You can control the door and relay using the icons in the door status bar and see the alarm when an

event occurs at the door.

Adding and Managing Graphic Map Groups

Adding and Managing Graphic Maps

Note

The Graphic Map View will appear when the AC standard license is activated.
Adding and Managing Graphic Map Groups

You can register graphic map groups for easy management of multiple devices. Name your graphic map

groups according to door locations or office names for greater convenience.
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= Adding Graphic Map Groups

1) Click MONITORING > Graphic Map View.
2) Right-click on All Graphic Maps and click Add Group.

All Graphic Mapg

Add Group

3) Enter a group name.

Note
= Graphic map groups may be created in up to 8 levels.

» Up to 48 characters may be entered for a graphic map group name.

Renaming Graphic Map Groups

1) Click MONITORING > Graphic Map View.
2) Right-click on the name of a group you wish to rename and click Rename
Group.

All Graphic Maps

Graphic Map Group 1

i

Add Group
Rename Group

Delete Group

3) Enter a group name.

Note

» Up to 48 characters may be entered for a graphic map group name.

Deleting Graphic Map Groups

1) Click MONITORING > Graphic Map View.
2) Right-click on the name of a group you wish to delete and click Delete Group.

All Graphic Maps

Graphic Map Group 1

Add Group
Rename Group

Delete Group
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Note

= You cannot delete a group if it contains a graphic map. To delete a
group, you must delete all graphic maps belonging to the group.
Adding and Managing Graphic Maps

If you add a graphic map, you can see and control the status of the doors in real-time in the graphic.

Adding Graphic Map

1) Click MONITORING > Graphic Map View.
2) Click ADD GRAPHIC MAP.

Configuration =

* Name * Group All Graphic Maps

- Background Upload

3) Set the name and group of the graphic map.
4) Click Upload and select the background you want to use as the graphic map.

Note

» The max size of the images that can be used as a background is 5MB.

= Supported image file formats are BMP, GIF, JPG, JPEG, PNG.

= If you back up the BioStar 2 database, the image file registered in the
graphic map may be deleted. If you want to continue using images
registered as a background even after database backup, back up the
image files.

5) Select the door you want to display on the graphic map from the Door. The
door status bar appears.
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Graphic
1 Ma; The uploaded background image appears.
Door .
2 You can see the door status and temporarily open the door.
Status
Door
3 You can lock or unlock the door manually.
Relay
You can see the screen of the IP camera registered at the
door in real time.
Live
4 Video Note
View
= The Live Video View button is activated only when
the camera is registered at the door.
You can see or clear the alarm that has occurred on the
5 Alarm door

6) Select the zone you want to display on the graphic map from the Zone. The
Zone status bar appears.

You can see the type of zone.
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E

Note

= The zones can be selected up to 100.

You can see or clear the alarm that has occurred on the
Zone.

2 Alarm

7) Drag the door and zone status bar to the location of the door and zone in the
graphic map.
8) When setting is finished, click Apply.

Editing Graphic Map

1) Click MONITORING > Graphic Map View.
2) Click # inthe graphic map that you want to edit.

All Graphic Maps
Office 01
14F Graphic Map 01 # §

Office 02
3) After editing the information you want, click Apply.
Deleting Graphic Map

1) Click MONITORING > Graphic Map View.
2) Click ¥inthe graphic map that you want to delete.

All Graphic Maps
Office 01
14F Graphic Map 01 # §

Office 02

3) Click Yes to delete the selected graphic map.
You can use the VIDEO menu to interlock an IP camera with an event of the door. You can set the IP

camera to record video or image logs when a set event occurs. Saved videos can be viewed in the
MONITORING menu.
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Note

= The VIDEO menu will appear when the Video license is activated.

= If you connect BioStar 2 using the Cloud, cannot access to the VIDEO menu.

» Set the Network Time Protocol (NTP) on a PC with BioStar 2 installed before using the Video
menu. Go to the Control Panel > Date and Time and then click Change setting on the
Internet Time to set up. Use time.windows.com for the server address.

2
1 —[ S %;vns
6 i —]]73

1 Add NVR < NVR and IP Camera List
z Add IP Camera £ NVR and IP Camera Hierarchy
= Function Button (Column Setting) € Expand Button

Adding NVRs

You can add NVR to save video logs or image logs.

Note

= ACTi, Dahua, and Hikvision products can be added for NVR. Before adding NVR, check its
manufacturer.

» Set the Network Time Protocol (NTP) to synchronize the time between the BioStar 2 server
and the NVR. Use time.windows.com for the server address.

= PC-NVR does not support the live video view.

= NVR types that support the live video view are as follows.
- Dahua: DH-NVR4416-16P, DH-NVR608-32-4K
- Hikvision: DS-7616NI-E2 / 16P, DS-7608NI-E2 / 8P
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1) Click VIDEO > Add New NVR.
2) Edit the necessary items.

Add New NVR X

Cancel ]
o [rem oo
1 Name Enter the name of NVR.
Select the manufacturer of NVR. ACTi, Dahua and Hikvision products are
2 Manufacturer
supported.
3 P Enter the IP address of NVR.
4 Port Enter the port of NVR.
Enter the account information (ID) to access NVR.
Note
5 1D
» Enter the default administrator account information for the ID. If you
enter the ID after creating a custom administrator account in NVR
setting, the function may not work properly.
6 Password Enter the account information (password) to access NVR.

3) Click Apply to save the changes.

Note
» Contact the system administrator for the detailed information of NVR (IP, Port, ID,
Password).
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Adding IP Cameras

You can add an IP camera connected to NVR.

1)
2)

3)

4)

176

Note

» Before adding an IP camera, add NVR first. For more details, refer to Adding NVRs.
» Set the Network Time Protocol (NTP) to synchronize the time between the BioStar 2 server
and the IP camera. Use time.windows.com for the server address.

Click VIDEO > Add New Camera.
Select an added NVR from the list and click Next.

Select NVR

‘

« NVR | NVR 1 v |

[ e ]

The list of cameras connected to NVR will appear. Select a camera to add and click + Add. To
select a different NVR, click Prev.

NVR 1
| Type P
HIKVISION IPC-HFW14208 192.168.12.110
D AXIS (M3203) 192.168.12.63
D 112_Amcrest 192.168.12.112
D HikVion IP 84 192.168.12.84
[ Prev ] + Add ‘[ Cancel ]

After adding the camera, you can set the camera to record a video log according to an event
occurring at the door. For more details, refer to Editing IP Camera Settings.
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Editing IP Camera Settings

You can set the time interval to capture a video log or an image log and link the door and event type to
the IP camera.

1) Inthe camera list, click a camera to edit.
2) Edit the necessary items.

Information
1—— -
2 4[ * Name HIKVISION IPC-HFW142... + Channel ]7 E]
g—-p
5 4[ * Log Type Video A

Configuration

Video Log Setting
6 4| * Startrecording | 3 secs before an event * End recording | 3 secs after an event

Event

* Door v

+ Add

* Evermt Event Schedule ‘

o {menJomoior

1 1D You can view the camera ID.

2 Name You can change the camera name.

3 Channel You can view the camera channel.

4 P You can view the IP address of the camera.

You can set the log type to be captured by the camera.

= None: A video log or an image log is not captured.
» Video: A video log is captured.
= Image: An image log will captured.
5 Log Type
Note

= You can set Video Log Setting or Image Log Setting according

to the set Log Type.
= None is set for Log Type, you cannot set the Video Log Setting,
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o [nom  Jowooin

Image Log Setting, and Event.

You can set the time to capture a video log or an image log.

Note

= You can set Video Log Setting or Image Log Setting according
to the set Log Type.

When Log Type is set to Video

Video Log
6 sett""lg / + Startrecording | 3 secs before an event + End recording | 3 secs after an event
Image Log
Setting When Log Type is set to Image
* Capture an image | 3 s | before an event
Note

» Recorded video/image logs does not mean the real-time log. It can
view after storing in in BioStar 2 database.

Select a pre-registered entrance door. Click + Add and set a desired event
and schedule.

Note

= Door should be set.

7 Event = Only one door can be set per camera.

= If there is no registered entrance door, register one by referring to
Adding Doors.

= If there is no desired schedule, click Setting > Schedule and
register a new schedule. For more details, refer to Schedule.

= You can delete an added event by clicking [ ]

3) Click Apply to save the changes.

You can set the time code, shift, and schedule and/or view time card or report by using the TIME
ATTENDACE menu.

Shift
Schedule
Report

Setting
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14 Time & Attendance

Set according to the following order when registering the schedule for the first time.

Step 1. Time code setting

You can set the attendance and leave time code, overtime time code, and the go out/outside work/
vacation time code. You can also set the time rate and assign and display a color to make it easily

recognizable.

(® Related information

Step 2. Shift setting

You can set the service rule on a daily basis (24 hours). The shift includes the time code setting, the
start time of day setting and the rounding rule.

& Related information

Step 3. Schedule template setting

You can set the schedule template with the shift on a daily basis. You can also set the weekly and daily
schedule template.

& Related information

Step 4. Overtime rule setting

This can be used conveniently when the overtime time code has not been added to the shift. Overtime
set in the service rule has a start time and an end time, but Overtime rule calculates the total time
exceeding the range of regular service time. Overtime rule can be used conveniently for managing
total daily, weekly and monthly overtime hours, and when Overtime rule is set, it applies instead of the
overtime time code added to the shift.

& Related information
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Step 5. Schedule setting

You can set the period, user, overtime rule, and vacation schedule to apply to the schedule template set

in the previous step.

(® Related information

Shift

You can set the time code, time segment for time code, schedule template, and overtime rule. These
are the main components of T&A management.

Time Code

You can set the time code to be used for worktime calculation. It can be set for T&A records, time code
for overtime, and time code for vacation management.
You can assign and use a different time rate for each time code.

1) Click TIME ATTENDANCE > Shift > Time Code.
2) Click ADD TIME CODE and set each item.

1 4[ + Name

2 — ] - Description

3 4[ N TYPE Attendance managen‘sm Overtime ﬂ\a\]a[JE‘I“EﬂI Leave IVHHBIQEI'TIGHI
4 4[ « Time Rate ® 1

s —— + color EI
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o [son  Jowowr

1 Name Enter the desired time code name.

2 Description Enter a brief description of the time code.

Set the time code type.

» Attendance management: You can set the time code to be used for the
T&A record.

= Overtime management: You can set the time code to be used for
overtime.

3 Type = Leave management: You can set the time code to be used for go out,

outside work, business trip and vacation.

Note

= If the time code currently used by shift, Type cannot be changed.
» If Type is set to Leave management, Time Rate cannot be set.

Set the time rate according to the time code. 1 is the default time rate. If 2

4 Time Rate is set, it is calculated with twice the hourly pay when the set time code is
applied.
5 Color Set a color to distinguish the time code.

3) To save settings, click Apply. To add a shift, click Apply & Next. To save the settings and add
another time code, click Apply & Add New.

(® Related information

Shift

Shift

You can create a shift by applying a different time code for each hour based on a 24 hour cycle. You can
select either a fixed working shift , flexible working shift or floating working shift and you can set the
start time of day and rounding rule.

1) Click TIME ATTENDANCE > Shift > Shift.
2) Click ADD SHIFT and set each item.
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1 ———* Name

2 4[ * Description

k] —[ Type ®) Fixed Flexible Floating
~ ~

4 —[ * Day start time 05 | 00 Allowed a day before/after time
v v

5 * First check-in & \) Mo

Last check-out
[+ Time segment

Next day

~ ~ ~ ~ -~ N
4]
Attendance man... ¥ 09 00 18 : 00 04 00
v v v v A v
* Grace [ use
[ * Rounding [7] Punchin
7
Punch out
[+ Meal deduction 1 By Punch v
8
L * Meal deduction 2 Use
9 4[ * Break Time None =

Description
1 | Name Enter the desired shift name.
2 F)escrlpt Enter a brief description of the shift.
ion
Set the shift type. The detailed setting varies according to the shift type.
= Fixed: You can set the fixed service to attend and leave at a fixed time.
3 | Type = Hexible: You can set the flexible service with no fixed attendance and leave
times.
= Hoating: You can set the floating service with no fixed attendance and leave
times. In this shift type, the shift is automatically applied according to the
attendance time.
Da Set the start time of day.
4 Stayrt If you use Allowed a day before/after time, you can set Shift for work hours
Time exceeding 24 hours based on the Day start time set.
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Description

Note

= Allowed a day before/after time is activated only when you set the type
of Shift to Fixed.

When Yes is set, the first user authentication time is recorded as check-in time, and

First the last user authentication time is recorded as check-out time.
check-in
5 | &last Note
check-
out = If the First check-in & Last check-out is set to Yes, Break by Punch
should be set for recording the user’s break time.
When Fxed is selected for Type,
-~ -~
+ Day start time 05 00 [] Allowed a day before/after time
v v
il A
+ Time segment
Attendance man... ¥ 09 : 00 18 : 00 04 : 00
L4 L4 v v v v
+ Grace I:‘ Use
%
Time * Rounding [] punchin
6 | segmen [ Punch out
t

* Meal deduction 1 By Punch v
* Meal deduction 2 Use

+ Break Time None v

Select the salary code set as T&A record and then set Start time, End time and
Min. Duration.

You can also set Grace, Rounding, Meal deduction and Break Time. When
setting is finished, click Add.

Note

= The Allowed a day The before/after time can be set up to 6 hours.

= You can only add one time code set as Attendance management to the
shift.

» For the time code set as Overtime management, you can only set Start
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Description

time, End time, Min. Duration, Rounding .

When Hexible is selected for Type,

~ A
- Working hours 08 - 00

per day
v v

- Options

* Time code Attendance man... ¥

* Punch in Time Limit [ | Use + Punch out Time Limit [ | Use

* Meal deduction 1 By Punch v

¢ Meal deduction 2 Use

* Rounding [] eunchin
[ Ppunch out

* Break Time None v

Set the working hours per day, and then select the time code.

You can also set Punch in Time limit, Punch out Time Limit, Meal deduction,
Rounding, Break Time.

Note

» If Hexible is selected for Type, the time code for overtime cannot be
added.

When Hoating is selected for Type,
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Description

* Segment

+ Time segment

* Rounding

* Meal deduction 1

+ Meal deduction 2

+ Break Time

Apply leave by this segment

+Add

Next day
0 3 6 [l 12 5 18 2 2
Time code ‘Start time End time Min. Duration Action
A ~ A A A ES
Attendance man... ¥ 09 0o 18 oo 04 00
v v v v v v
~ ~
* Punchingrantedtime range | 5 . g
v
~
09 00
v v
+ Grace [ use
=

[ punehin

[] Punch out

By Punch ~

Use

None v

Select the time code and set Start time, End time, Min. Duration, and Punch in

granted time range.

You can also set Grace, Rounding, Meal deduction, and Break time.

Note

= You can configure the shift by up to 5 time slots.

= If you use the floating shift, you must select Apply leave by this
segment when setting up a leave management. You can select Apply
leave by this segment from the time segment configured as shifts.

» For the time code set as Overtime management, you can only set Start
time, End time, Min. Duration, Rounding.

Roundin
g

You can set the time rounding rule. Unit is the time to round off to and Point is the
time to apply rounding off. For example, 10 minutes are set for Unit and 7 minutes
are set for Point, an event occurring at 8:05 is considered to have occurred at 8
and an event occurring at 8:08 is considered to have occurred at 8:10.

Select the item which you intend to use, and then set Unit and Point.

= Punch in: You can set the rounding rule to process the registered time when an
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Description

attendance event is registered earlier/later than the set start time.
= Punch out: You can set the rounding rule to process the registered time when a
leave event is registered earlier/later than the set end time.

Note

= Rounding applies in preference to Grace.

You can set to deduct meal time from the shift.

= By Punch: You can set it to be deducted according to the record registered in the
device, without a fixed meal deduction time.
= Auto: You can set the meal deduction by setting Deduction time and Minimal

Meal hours before deduction.
8 deducti = Fixed: You can set the fixed meal deduction by setting Start time and End time.
on
1,2 Note
= You can deduct two meal times from the shift if you use Meal deduction
2,
= When using the meal deduction type as Auto or Fixed, Meal deduction 1
and Meal deduction 2 can be set only for the same type.
You can set the break time.
9 Break = By Punch: You can set it to be confirmed according to the record registered in
Time the device, without a fixed break time. If you select By Punch, you can set Max.

allowed break time.
» Fxed: You can set the fixed break time by setting Start time and End time.

3) To save settings, click Apply. To add a schedule template, click Apply & Next. To save the
settings and add another shift, click Apply & Add New.

& Related information

Schedule Template

Schedule Template

You can create a weekly and daily schedule by using the set shift.
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1)
2)

Click TIME ATTENDA NCE > Shift > Schedule Template.
Click ADD SCHEDULE TEMPLATE and set each item.

1 4[ Name

3 —A. 5
Description Daily Fixed 09:00~18:00 | 05:00 E

3 4[ Type Weekly Daily Flexible Flexible 8hr Omin 05:00

4 —  Weekend days m

* Please select one or consecutive two days

o Jron —Jomogion

1 Name Enter the desired schedule template name.
2 Description Enter a brief description of the schedule template.
3 Tvoe You can set either Weekly or Daily for the schedule template, and when
P Daily is selected, you can set the period to be used repeatedly.
Weekend
4 days You can set the days of the week that you want to use as the weekend.
5 Shift You can view the list of set service rules.
Set drag & drop for the set service rule. To apply all at once, click Copy All.
Note
6 Schedule
= To apply a shift that setting the Allowed a day before/after
time, Allowed a day before/after time cannot be set 24 hours
before Day start time on Shift the day before.
3) To save settings, click Apply. To add a schedule, click Apply & Next. To save the settings and

add another schedule template, click Apply & Add New.
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(® Related information

Overtime Rule

Rule

This can be used conveniently when the overtime time code has not been added to the shift. Overtime
set in the shift has a start time and an end time, but Rule calculates the total time exceeding the range
of regular working time. Rule can be used conveniently for managing total daily, weekly and monthly
overtime hours, and when Rule is set, it applies instead of the overtime time code added to the shift.

1) Click TIME ATTENDANCE > Shift > Rule.
2) Click ADD RULE and set each item.

1 4[ - Name
2 4[ - Description

[ - Overtime Mot Use
Daily overtime
Weekly overtime

Monthly overtime

Weekend overtime

Time Code None

~ ~
3 .

Day start time 05 00 First check-in & Last check-out

v v
Holiday overtime

Time Code None
~ ~

Day start time 05 00 First check-in & Last check-out
v v

o [ron  Jomown

1 Name Enter the desired overtime rule name.

2 Description Enter a brief description of the overtime rule.

Set the overtime rule.

3 Overtime Daily overtime, Weekly overtime, Monthly overtime rules can set the
overtime time code to be applied after the regular working time, and a
different overtime time code can be applied after a certain time. You can
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also limit the overtime hours for an employee by setting the maximum
overtime hours.

When you set as follows, the 'Overtime management' time code applies from
5 PM to 11 PM if the normal working time is from 8 AM to 5 PM, and the
'Overtime management' time code applies from 11 PM to 2 AM. Also, the
maximum overtime hours for an employee for one day is limited to 9 hours,
and the daily payroll is calculated only using the record of providing work
until 2 AM.

Mot Use

Daily overtime

Apply | Overtime manag... v |after|8 hour(s) |0 minute(s)
Apply| Overtime manag... v |after|6 hour(s) |0 minute(s) of [ Overtime management |
Max overtime (9 hour(s)
Weekly overtime
Monthly overtime
Note

= Total working time does not include break time or meal time.
For Weekend overtime and Holiday overtime rules, Time code and Day
start time can be set, and only First check-in & Last check-out can be

set.

Weekend overtime

Time Code None
~ -

Day start time 05 : 00 First check-in & Last check-out
v v

Holiday overtime

Time Code None
-~ ~

Day start time 05 | 00 First check-in & Last check-out
v v

3) To save settings, click Apply. To add a schedule, click Apply & Next. To save the settings and
add another rule, click Apply & Add New.
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(® Related information

Schedule

Schedule

You can create a service schedule by assigning the set schedule template, overtime rule, period, and
holiday to a user.
You can also add a temporary schedule or personal vacation to the created service schedule.

Note

» Before creating a schedule, check if the Time Code, Shift, Schedule Template, and Holiday
which you will use have been created correctly.
= Adding & deleting a schedule
You can create a service schedule for a registered user.

1) Click TIME ATTENDANCE > Schedule.
2) Click Add and set each item.

1 ———{ - Name
32— - peseription
53— - hule None
4 ——{ + Schedule template None v
5 —[ + Period 2017-03-17 ~ | 2017-03-17
6 —[ * Holiday None v
All Users EJ Go Go
15F USER 0 @
16F USER 0 Ad mi?i‘s)tramr
17F USER o [%Ig)
Usa(g )nuo
7 Us(e_‘rou}m
Us(eWrWO}OZ
Ui(swrzu}m
Us(e.‘raﬂ}ﬂﬂ
Us(e&o}os
Ui(swrsu}ﬂﬁ

Enter the desired schedule name.
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oo Lo

2 | Descriptio | Enter a brief description of the schedule.
n
Select the set overtime rule.
When the overtime rule is set, the overtime service salary
code set to the service rule will not apply. If you do not wish
use it, set None.
3 Rule
Note
» If there is no desired overtime rule, set one by
referring to the Overtime Rule.
Select the set schedule template.
4 Schedule Note
Template = If there is no desired schedule template, set one by
referring to the Schedule Template.
= Once schedule template is set, it cannot be changed.
Set the period to collect T&A events.
Note
> | Period = Once the start date is set, it cannot be changed. The
end date can be changed, and when it is changed to
a date which is earlier than the set date, leave events
for the changed period will be deleted.
Select the set vacation schedule. If you do not wish use it,
set None.
6 Holiday Note
= If there is no desired vacation schedule, add a
vacation schedule by referring to the Schedule.
7 User Add a user to apply the rule.

3) To save settings, click Apply.
4) To delete a schedule, select the schedule you wish to delete from the list, and
then click Delete schedule.

= Adding & deleting a temporary schedule

If you have already registered schedule. you can set a different service rule to a user
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temporarily.

1) Select a user assigned to the schedule from the list and click a date on the
calendar.

‘ ] ADD SCHEDULE

, Schedule 1 > User 1

< November 2018 >

Schedule 1 | . a
‘ ‘ 09:00~18:00 Daily ] 09:00~18:00 Daily

administator Add Temporary Schedule

o AddLesve

yser1

@ 7 5 g 7 E] ] 10
o
)

User3

@)

Usera

15)

2) Select Add Temporary Schedule and set each item. To apply it to other users
equally, add a user by clicking Q.

[kyle] Temporary Schedule X
+ Name | |

+ Shift | regular shift «

+ Period 2016-12-01 - 2016-12-01

+ Apply to Other User(s) Q,

= -

3) When you click Apply, the shift for the set period will be changed.
4) To delete a temporary schedule, click the service schedule of the set temporary
schedule, and then click Yes.

= Adding & deleting a leave

192

You can add a user’s personal leave schedule.

1) Select a user assigned to the schedule from the list and click a date on the
calendar.

‘ 5] ADD SCHEDULE
e

Schedule 1 > User 1

< November 2018 >

]

Shift Schedule

Schedule 1 I | 0 7
| ‘ 09:00~18:00 Daily ] 09:00~18:00 Daily

JE— Add Temporary Schedule

o Add Leave

User1

@ 7 5 5 7 & 9 10

lger2 (09:00~18:00 Daily ] 09:00~18:00 Daily __|09:00~18:00 Daily ) 03:00~18:00 Daily ] 09:00~18:00 Daily

)

user3

(4)

user 4

(8)
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2) Select Add Leave and set each item. To apply it to other users equally, add a
user by clicking Q,

User 1(2)

2018-11-01(Thu)
Leave management hd
Use Time O

EIED | 2018-11-01 End Date [ 2018-11-01
Leave Hours 1day(s)

Apply to Other User(s) Q,

Approver Comments

)

3) When you click OK, the leave will be registered on the set period.
4) To delete a leave, click the registered leave and click Yes.

Note

» If there is no desired leave management Time code, add one by referring
to the Time Code.

Report

You can create a T&A report with T&A events of a user collected through the system, and edit or export
time records as a CSV file or a PDF file.
7 preset report filters can be used conveniently, or the administrator can set the filter manually.

+ Before Using the Multiingual Report

BioStar 2 supports Korean and English language. To use multilingual report, please
check the following.

Font Setting

1. Go to [C:W Program FilesW BioStar 2(x64)W taW distW setupW report_fonts].

2. Create a folder with the language name you want to use. Refer to the ISO 639-
1 standard for language name. For example, to use Spanish, create a folder
named "es".

3. Copy and paste the font file into the folder you created. Only one TrueType Font
is supported.
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PDF View Setting
1. Click the link to install the PDF viewer on Google Chrome.

https://chrome.google.com/webstore/detail/pdf-viewer/
oemmndcbldboiebfnladdacbdfmadadm

= Before Updating the Report

1)
2)

3)

BioStar 2 uses MariaDB as the default database. If you are using MS SQL database,
please check the following.

When using BioStar 2 with MS SQL database, your PC's memory usage will
accumulate each time you update the report if there are a large number of
registered users. Reset Max Server Memory for the MS SQL database.

1. Run Microsoft SQL Server Management Studio.
2. Right-click BioStar 2 database in Object Explorer and click Property.
3. Click Memory and then decrease the value of Max Server Memory.

Note

* For more information on MariaDB and MS SQL Server settings,
see Installing BioStar 2.

Click TIME ATTENDA NCE > Report.

To use a preset filter list, select a desired filter type, set either User Group or User and click
Update Report.

To register a new filter, click ADD FILTER and set each item.

Search Conditions (-]

[ Filter Conditions
* Name Daily Report
* Report Type Daily

All Users Q - User Q

v || Column Setting

+ User Group

Save Filter

[ — ReportPeriod

< | Monthly (2018-11-01 ~2018-11-30) ¥ | »

Update Report SV Export PDF Export

Daily Report ) 1 e ()0 | sorows +

Date Name User ID Regular hours overtimehours  Total Work Ho...

Administrator 1

2018/11/01 User Group 1 Daily B - - Absence 0:00:00 0:00:00 0:00:00

2018/11/01 User 1 2 User Group 1 Daily 2 B = Absence 0:00:00 0:00:00 0:00:00

2018/11/01 User 2 3 User Group 1 Daily 5 B B Absence 0:00:00 0:00:00 0:00:00

Filter
Conditions

Set a new T&A report.
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Name: Enter the desired report name.

Report Type: Select the desired report type. Daily, Daily Summary,
Individual, Individual Summary, Leave, Exception, Modified Punch
Log History, Working alarm time reports are available.

Column Setting: Change or hide the order of columns in the report
table.

Rlter: This function is enabled only when Leave or Exception is set for
Report Type, and detailed conditions for leave or exception records can
be selected.

User Group / User: Select a user group or a user to create a report.
Save Flter: Save the set T&A report as the filter.

Set the period of report.

Period: Set the period for creating a report to Daily, Weekly, Monthly,
or Custom.

In/Out Only: Select to output only the check-in and check-out logs of the
user to the report.

All Punches: Select to output all punches of the user to the report.

) Report
Period Note
= In/Out Only and All Punches are enabled only in
Individual Report.

= Update Report: Update the report table to the most recent information.
= CSV Export: Save the created report as a CSV file.
= PDF Export: Save the created report as a PDF file.

3 Report View the created report.

Adding the Working alarm time report

You can update the report for users who have reached their specified working

hours, or notify the administrator by email.

You can update the Working alarm time report weekly.

1) Click TIME ATTENDANCE > Report > Working alarm time Report.
2) Set each item in Flter Conditions and Report Period and then click Update

Report.

3) Set Automated Email if you want to send an email notification to the

administrator for users who have reached their specified working hours.
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Search Conditions

- — Filter

* Name Working alarm time Report
* Report Type Working alarm time v || Column Setting
+ Working alarm time 40

+ User Group Q * User Q

[ — Report Period

Save Filter

* Period Weekly ( 2018-10-29 ~ 2018-11-04 )

Update Report CSV Export PDF Export

Email

Email

* Day of Week (1] * Time

* Recipient

E

Filter
1 Condition
S

Set a new T&A report.

= Name: Enter the desired report name.

= Report Type: Select the desired report type.

= Column Setting: Change or hide the order of columns in
the report table.

= Working alarm time: Set the time to generate Working
alarm time report.

= User Group / User: Select a user group or a user to
create a report.

= Save Flter: Save the set T&A report as the filter.

Report
Period

Set the period of report.

= Period: Set the period for creating a report.

= Update Report: Update the report table to the most
recent information.

= CSV Export: Save the created report as a CSV file.

= PDF Export: Save the created report as a PDF file.

Automat
ed Email

You can notify about users who have reached their specified
working hours for the administrator by email.

» Email: Click to send an email to an administrator
automatically.

= Day of Week: You can set the days of the week to send
an email to administrators.

= Time: You can set the time to send an email to
administrators.

» Recipient: You can add an administrator's email address
that receives the email.
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E

Note

= You need to configure Filter
Conditions and then save the
filter in order to set up
Automated Email.

= You can set the sender information

for automatically sent emails in %

Editing T&A Records

You can modify T&A records by clicking the created report table.

Note

» Inorder to modify T&A records, a report must be created first. For details about the creation

of a report, refer to Report.

» The attendance and leave record of a user whose T&A schedule has not been registered

cannot be modified.

1) Click a row to modify the record from the created report table.
2) Modify a T&A record or add a leave according to the desired method.

= Modfifying in the List

+« User1-2

1 —————{ - patenange | «| oaily (20181101~ 2018.11.01) ¥ | »

2
2018/11/01 (Thu) Daily

0:00:00 0:00:00 0:00:00

o Lo Lo

. You can set the period for the T&A record to be displayed as
1 Period .
a list.
5 Daily T&A | You can view the daily T&A record.
record
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Note

= You can add, modify or delete a T&A record by
clicking In/Out time. Click # after clicking In/Out
time to modify the registered T&A record. When you
click OK, changes will be saved.

= You can add a leave by clicking # Toadda leave,
the Time Code set as Leave management is
necessary. You can click ¥ of the added leave to
delete it.

T&A
3 record You can view T&A records according to the set period.

summary

View in
4 calendar You can view T&A records in a calendar.
button

= Modfifying in the calendar

|« User1-2
1 ——{ I vork Time [B—:
2 { < November 2018 >
1 2 3
G000 G000
4 5| 6 7| 8| E 10
oo G000 GO0 G000 G000
1 13 14 16| 17,
oo G000 GO0 G000 7
3
18] 20 21 24
GO00 0000 Jpww o000
25| 27 28
GO00 0000 G000 o000 D) ]
Monthly 0:00:00 0:00:00 0:00:00 0:00:00 0:00:00 1 0 0:00:00
Regular By Time Rate
0:00:00 0:00:00 0:00:00 0:00:00
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1 Event You can click each event type to display or hide on the
Type calendar.
You can move to the previous or next month by clicking < or
2 Month
>.
You can view the daily T&A record.
Note
= You can add, modify or delete a T&A record by
clicking the work time (white). You can modify the
5 | Daily T&A g (white) fy
record registered T&A record by clicking 4 , and when you
click OK, changes will be saved.
= You can add a leave by clicking the shift (gray). To
add a leave, the Time Code set as Leave
management is necessary. You can click W of the
added leave to delete it.
T&A
4 record You can view monthly the T&A record.
summary
5 | Viewinlist| yoy can view T&A records in a list.
button

Setting

You can register a device used for T&A management or set the user list synchronization option.

1) Click TIME ATTENDANCE > .

2) Seteach item.

+ Setting
[ Unregistered Devices

[ Sender Information

Edit

[ Export

4 —

BioLiteNet 538101276 (192.168.16.213)

Registered Devices

BioStation L2 542500114 (192.168.16.107

" Use|, ¥ asafiled separation delimiter
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This is the list of devices for which T&A management is available.
Select the desired device and click + Register to register the selected
device as a T&A management device.

1 Unregistered
Devices

This is the list of T&A management devices being used currently. To cancel
registration, select the desired device and click Unregister.

You can also change the T&A setting of a registered device by clicking
Setting. For details, refer to the device's T&A.

T&A type is a setting to map the T&A Event Key and T&A event
type(Check In, Check Out, Break Start, Break End, Meal Time Start,
Meal Time End).

2 | Registered

Devices
+ T&A Mode By User v + T&A Required \) Ho
Code 1 MNone v
Code 2 None
Code 3 None
Code 4 None
E pply ‘ Cancel ‘
3 Sender You can set the sender information to use when sending out notification

Information emails.

You can select the delimiter of the document when exporting T&A report to

4
Export CSV export.

Note

= When a registered device is deleted in DEVICE menu, the registered T&A management
device will be also deleted automatically.

You can manage the access of visitors by using the VISITOR menu.
You can also set up a PC where visitors can apply for a visit.

Applying to Visit

Managing Visitors

Note
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= The VISITOR menu will appear when the Visitor license is activated.

. < 2019/07/08 > §€ ‘ 2 . U 5 0 }74
e hecke ecked Out otal E: ‘;.I;Fw'»

9
8 —[ + Add Visitor ) search visitor + Filter Registere ]7 6 E]]i 5

1 Period and Number of Visitors by Status € Filter of Visitors by Status
z Page Navigation Buttons and Number of List Rows 7 List of Visitors by Status

= Search for Visitors in List of Selected ¢ Add Visitor Button

< List of Visitors Expired the Personal Data ¢ Search Visitor Button

n

! Function Button (Column Setting)

Applying to Visit

Visitors can view and accept the terms and conditions or the privacy policy for access.
Visitors with a visit record can also apply for a visit by reusing previously registered information, such as
their name, telephone number, and fingerprint.

Note

= You can access the visit application page on the visiting PC. If there is not the shortcut of the
visit application page on the visiting PC, create the shortcut by referring to

Applying to First Visit

If you are visiting for the first time, apply for a visit on the visit application page.
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Note

= You can access the visit application page on the visiting PC. If there is not the shortcut of the
visit application page on the visiting PC, create the shortcut by referring to Visit PC Settings.

If you visit the site for the first time, apply to visit on the visit application page.
1) Run the visit application page on the visiting PC.

If you have already visited, please fill in
the information below.

Welcome

R ros (=
v

2) Click Arst visit.
3) Check and accept the terms and conditions or the privacy policy for access and then click Next.
4) Enter or select the necessary fields.

Registration Information

Visitor

* Name * Telephone

Host

* Name « Telephone

Entry Information

* Zone v

* Period 2019/06/04 14:42 - 2019/06/05 14:42 E

o e oo

Enter the visitor's information.

* Name: Enter the name.
= Telephone: Enter the telephone number.

1 Visitor ]
Note

= If the Custom Visitor Field is set in the VISITOR setting, that fields are
activated.
= Up to 48 characters may be entered for a name.
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Enter the host's information.

= Name: Enter the name.

2 Host = Telephone: Enter the telephone number.

Note

= Up to 48 characters may be entered for a name.

Set the zone and period to visit.

= Zone: Set the access group.

» Period: Set the period for visit.
3 Entry

Information
Note

= Only access groups of sites assigned to visiting PC in VISITOR
setting are displayed.

5) Click Next.
6) Set the credentials.

Credential

1 4[ « Fingerprint + Fingerprint @

2

o ren oo

* card I Mo request

1 Fi i Click + Fingerprint to use the fingerprint authentication.
Ingerprint And enroll the fingerprint.
9 card Set the card to Request to use the card authentication.
ar And get a card from the visitor operator.
7) Click Next.

8) To apply for a visit, click Register.

Related Information
Visitor

Applying to Visit Using Existing Info
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Applying to Visit Using Existing Info
Visitors with a visit record can also apply for a visit by reusing previously registered information, such as

their name, telephone number, and fingerprint.

== Search by name and telephone number

If you have visited the site, you can use your existing visit information again to

request a visit.
1) Run the visit application page on the visiting PC.

If you have already visited, please fill in
the information below.

R e
v

2) Enter the name and telephone number and then click Search.

3) Check and accept the terms and conditions or the privacy policy for access and
then click Next.

4) Check the Registration Information. If there are items that need to be
modified, modify each item by referring to Applying to first visit and click Next.

5) Check the Credential. If there are items that need to be modified, modify each
item by referring to Applying to first visit and click Next.

6) To apply for a visit, click Register.

Search by fingerprint

If you have a fingerprint registered in the site of visit, you can search the
fingerprint and apply for a visit using the existing visit information.

1) Run the visit application page on the visiting PC.
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If you have already visited, please fill in
the information below.

Welcome

First visit

2) Click Search at the bottom of the fingerprint icon.
3) Scan your fingerprint to search the registered visitor.
4) If the visitor information is correct, click Yes.

Confirm X
Mame : Vero
Phone: 01000000007
Is it correct? Please check the

information.

5) Check and accept the terms and conditions or the privacy policy for access and
then click Next.
6) Check the Registration Information. If there are items that need to be

modified, modify each item by referring to Applying to first visit and click Next.
7) Check the Credential. If there are items that need to be modified, modify each
item by referring to Applying to first visit and click Next.
8) To apply for a visit, click Register.

Related Information
Visitor
Applying to First Visit

Managing Visitors

You can check the list of visitors and manage the check in and check out of them. You can also add,
delete, or modify visitor information.
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Note

= The VISITOR menu will appear when the Visitor license is activated.

Managing Registered Visitors

You can approve a visit or edit the registration information. You can also add or delete visitors.

== Approve the Visit

You can approve a visit.

1) Click VISITOR.

2) Click a visitor in the Registered.

3) Check the information of the visitor and then click Check in.

Visitor

* Name

+ Telephone 01000000003
Host

* Name

+ Telephone 01000000000

simba 01000000000

Entry Information

+ Access Group Access Group

+ Period 2019/06/04 10:00 | . | 2019/06/05 1000 | B

Credential

+ Card I to request

+ Credential

+ Fingerprint ((ﬁ\\

[ I | oo

Note

» If there are items that need to be modified, modify each item and click
Edit.

4) Check the Registration Information and then click Approve to approve the
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visit.
Registration Information

Privacy Policy

* Accept Terms Did not agree View terms

Visitor Information

* Name Shannon + Telephone 01000000003

+ Name Simba + Telephone 01000000000

Credential

+ Fingerprint + Card Mo request

Note

= The Approve button is deactivated for visitors who did not agree to the
terms and conditions when applying for a visit. Click View terms to
provide the visitor with the terms and conditions and request the
agreement. If a visitor does not accept the terms and conditions, the
visitor will be restricted from visiting.

» If a card device is set on the visiting PC, the Approve and register
card button is activated. Click Approve and register card to approve
the visit and issue an access card.

Enroll Card X

+ Registration Register by Card Reader v
Option
Information

+ Facility Code Read Card

+ Card ID 1

Cancel

a) Select a desired Registration Option.

Register by Card Reader

You can register a card by scanning the card

information with the device connected to the visiting PC.

a) Select Register by Card Reader for
Registration Option.
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b) Click Read Card and scan a card with the device.

Enter Manually

You can register a card by entering a card number
directly.

a) Select Enter Manually for Registration Option.
b) Enter the Facility Code or Card ID 1.

b) Click Enroll to register a card.

Add Visitors

You can add visitors.
1) Click VISITOR.
2) Click + Add Visitor.

Visitor

* Name

+ Telephone

Host

Not found

Entry Information

Credential

Cancel

m

Enter the visitor's information.

= Name: Enter the name.
= Telephone: Enter the telephone number.
1 Visitor

Note

= If the Custom Visitor Field is set in the VISITOR
setting, that fields are activated.
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H

= Up to 48 characters may be entered for a name.

2 Host

Enter the host's information.

= Name: Enter the name.
= Telephone: Enter the telephone number.

Note

= Up to 48 characters may be entered for a name.

= When you enter the name or telephone number, a list
of users with information that matches is displayed.
Click Choose to set a user of that list to the host.

Entry
3 Informatio
n

Set the zone and period to visit.

= Zone: Set the access group.
= Period: Set the period for visit.

Note

= Only access groups of sites assigned to visiting PC
in VISITOR setting are displayed.

4 Credential

Set the credentials.

= Card: Set the card to Request to use the card
authentication.

= Credential: Click + Fingerprint to use the fingerprint
authentication. And enroll the fingerprint.

3) Click Register to complete adding visitors.

Delete Visitors

1) Click Visitor.

2) Click a visitor to delete in the Registered.

< 2019/07/08 >

ALL PERIOD

+Add Visitor AN Search visitor

- Name  Telephone HostNa. HostTelep_ AccessGr.. Start Date

B veo 010000000 Simba
[J sy 010000000... Simba

[]  Sunyoung 010000000 Simba

3 2 0 5 0

Registered Checked In Checked Out Total

Allowed period for credent._.
010000000.. Access Gro.. 2019/07/081.. 2019/07/091.. 2019/07/08 12:49 ~2020/.. - - 2019/07/08 1
010000000.. Access Gro.. 2019/07/081.. 2019/07/091.. 2019/07/08 13:04 ~2020/.. - - 2019/07/08 1

010000000 Access Gro. 2019/07/081.. 2019/07/091.. 2019/07/08 13-05 ~2020/.. - - 2019/07/08 1

3) Click Delete Visitor and then click Yes.
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Note

= The Delete Visitor button is activated if you click | | (check box).
= You can delete visitors only in the Registered.

® Related Information

Managing Check In Visitors

You can check which visitors have been checked in and edit the registration information of them. And
you can also let the visitors check out.

1) Click VISITOR.
2) Click a visitor in the Checked In.
3) Check the information of the visitor and then click Check Out.
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« Jacey

Visitor
+ Name Jacey
+ Telephone 01000000002
Host
* Name ‘ Simba |
+ Telephone | 01000000000 |
Name Telephone Choose
Simba 01000000000 | choose |
Entry Information
+ Access Group ‘ Access Group v |
* Period | 2019708704 || 10:00 | .| 2019708705 || 10:00 | B
Credential
+ Credential —_—
entia + Fingerprint Im | +Card N |

s —

Note

» If there are items that need to be modified, modify each item and click Edit.
= You can let the visitors check out in the list. The Check Out button is activated if you click ||
(check box).

[ e ) sorome - =
< 2019/06/05 > o
A Dl @ @2 2
ALL PERIOD Registered Checked In Checked Out Total Personal Data
Expired
+Add Visitor || )\ Search Visitor * Filter | Checked in v | | @ checkout |B

~ *  Name  Telephone HostN.. HostTelep.. AccessGr..  Start Date Expiry Date  Allowed period for creden...  Checked In Checked Out  Update Date

Jacey 01000000. Simba 01000000... AccessGr.. 2019/06/041.. 2019/06/051... 2019/06/04 10:03 ~ 2020... 2019/06/041... - 2019/06/041.. EXPIRED

Managing Check Out Visitors

You can check which visitors have been checked out and register the visit again using that visitor's
registration information.

1) Click VISITOR.
2) Inthe Checked Out list, click the visitor to re-register.
3) Click Edit.
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Visitor

Mana

212

Visitor
* Name vero
« Telephone 01000000001
Host
* Name | Simba |
* Telephone | 01000000000 |
Name Telephone Choose
Simba 01000000000 | choose |
Entry Information
* Access Group | Access Group v ‘
+ Period \ 2019/06/04 H 16:53 \~| 2019/06/05 H 16:53 \E
Credential
+ Card () No request
+ Credential + Fingerprint m ‘
Type Card Data Format
Fingerprint I’ |
=
4) If there are items that need to be modified, modify each item and click Register.

ging All Visitors

You can view all visitors that have been registered, checked in, and checked out for the set period. You

can also add visitors.

1) Click VISITOR.
2) Click Total.
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Q0000 EXE | - 13
& 2019/06/05 > ’
fe Qs @l (@2, | O2
ALL PERIOD Registered Checked In Checked Out Total Personal Data
Expired
| +addvisitor || §) SearchVisitor | - Fifter | Alvisitors v | E]
| Telephone  Host N... Host Telep... AccessGr... Start Date Expiry Date Allowed period for creden... Checked In Checked Out Update Date
D Jacey 01000000... Simba 01000000... Access Gr.. 2019/06/041... 2019/06/051.. 2019/06/04 10:03 ~2020... 2019/06/041... - 2019/06/04 1... EXPIRED
D Chloe 01000000... Simba 01000000... AccessGr.. 2019/06/051.. 2019/06/061... 2019/06/05 16:00 ~ 2019. - - 2019/06/05 1...
D Julien 01011111...  Simba 01000000... Access Gr.. 2019/06/051... 2019/06/061... - - - 2019/06/051...
D Jacey 01000000... Simba 01000000... Access Gr... 2019/06/051... 2019/06/061... - - = 2019/06/05 1...
D sY 01000000... Simba 01000000... AccessGr.. 2019/06/051.. 2019/06/061... - - - 2019/06/051...
D Shannon  01000000... Simba 01000000... Access Gr.. 2019/06/041... 2019/06/051... 2019/06/0513:48 ~ 2019... - 2019/06/05 1... 2019/06/051... m
D vero 01000000... Simba 01000000... Access Gr.. 2019/06/051... 2019/06/061... 2019/06/05 14:00 ~ 2019, - 2019/06/05 1... 2019/06/051.. m
D PSY 01000001... Simba 01000000... Access Gr.. 2019/06/041.. 2019/06/051.. 2019/06/04 17:05 ~ 2019, - 2019/06/05 1... 2019/06/051.. m
D Sunyoung 01000000... Simba 01000000... Access Gr.. 2019/06/041... 2019/06/051... 2019/06/0417:05~2019... - 2019/06/05 1... 2019/06/051... m

Note

= You can approve the visit and add visitors in Total. For more details, refer to Managing
Registered Visitors.

= You can manage the checked in or checked out visitors in Total. For more details, refer to
Managing Check In Visitors or Managing Check Out Visitors.

Deleting Personal Data Expired

You can delete the visitors that have the personal data expired.

Note

= Only users with the operator level of Administrator can view the list of visitors who have
expired. You can refer to the Adding User Information for more detailed information on the
operator level.

1) Click VISITOR.
2) Click Personal Data Expired. The visitors that have personal data expired is displayed.

[ 0] [ v Joa [» ][ » ]| sorows v |[ v ]@

£ 2019/06/05 > . 4 2 -l 0 7 2
ALL PERIOD Registered ‘ 9 Checked In ‘ @ Checked Out ‘ Total Personal Data
Expired

| 0 searchvistor [ - Filter | Personal Data Expired v | | W Delete personal data |E]

| +Add visttor

- Name Telephone  Host N... Host Telep... Access Gr... Start Date Expiry Date  Allowed period for creden... Checked In Checked Qut Update Date

psy 01000001... Simba 01000000... Access Gr.. 2019/06/041... 2019/06/051... 2019/06/04 17:05~2019... - = 2019/06/04 1.

[]  sunyoung 01000000.. Simba  01000000.. AccessGr.. 2019/06/041.. 2019/06/051.. 2019/06/0410:03 ~2019.. 2019/06/050.. 2019/06/050... 2019/06/050... (ALY

Note
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= For more information on configuring the period for the credential, see Terms & Visitor
Settings.

3) Click || (check box) to select the visitors you want to delete.
4) Click Delete personal data and then click Yes.

You can use the Setting menu to configure user privileges, language, time, date, access card
management, server connection, doors, etc.
The modifiable items may differ depending on the user permission.

Account

Preferences

Card

Card Format

Server

Trigger & Action
Schedules

Alert

HTTPS

Cloud

Image Log

USB Agent

Face Group Matching
Audit Trail

Video

Daylight Saving Time
Security

Active Directory
Visitor

Mobile Access

Account

You can assign BioStar 2 operator account levels to registered users.
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1) Click Settings > ACCOUNT.
2) Click an account type. Depending on the type of license activated, the account type may vary.

Administrator: The user can use all menus.

User Operator: The user can only use the USER and PREFERENCE menus.

Monitoring Operator: The user can use the MONITORING and PREFERENCE menus and
only view the DASHBOARD, USER, DEVICE, DOOR, ZONE and ACCESS CONTROL menus.
Video Operator: The user can only use the VIDEO menu.

T&A Operator: The user can only use the TIME ATTENDA NCE menu and only view the
USER menu.

User: The user can only view own information and T&A records.

Visitor Operator: The user can only use the VISITOR menu.

3) Click + Add and select a user or click Q, to search for a user.

1 4[ + Name
2 4[ - Description

3 ——— - Admin tem Settings User Group ‘ Device Group. Door Group Elevator Group Access Group | Zone Type ‘Graphic Map Group

All Users -

1 Dashboard N/A
2 User Enabled
3 Device Enabled
4 Door Enabled
5 Elevator Enabled
6 Zone Enabled
Access Control Enabled
8 Monitoring Enabled
Time & Attendance Enabled

10 Setting N/A

1(Administrater)

o [ron  Jomown

1 Name Shows the account level name.
2 Description Show a brief description of the account level.
3 Adm'm ftem Show the group assigned the permission.

Settings
4 Adm.m Menu Shows the assigned privileges.

Settings

Shows the list of users assigned with the privileges. Click + Add to add a

5 Add User user.

» Click W to delete the registered users.

215



16 BioStar 2 Settings

4) Click Apply to save the settings.

Note

» If privileges have already been assigned while adding or editing users, the assigned users are
shown on the list.

» Unless a user with the privilege for Edit saves settings after changing the detailed settings of
each menu, the user with a Read privilege only can see the previous information yet to be
modified.

® Related Information

Adding Custom Account Level

You can assign BioStar 2 operator privilege levels to registered users.

Note

» The Admin Menu Settings may vary depending on the type of license that is activated.

1) Click Settings > ACCOUNT.
2) Click ADD CUSTOM LEVEL.

3) Enter or select the necessary items. Depending on the type of license activated, the account type
may vary.
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o (menJomoon

1

1 4[ « Name
2 4[ + Description
3 .

5 —— - Adduser

Name

Admin Item Settings

« Admin Menu Settings

All Users v All Devices All Doors - All Elevators = All access g.. v All zones v All Graphic .. =

1 Dashboard N/A
2 User Disabled
3 Device Disabled
4 Door Disabled
5 Elevator Disabled
Zone Disabled
Access Control Disabled
8 Monitaring Disabled
9 Time & Attendance Disabled

10 Setting N/A

— -

Enter the desired account level name.

2

Description

Enter a brief description of the account level.

Admin Item
Settings

Set the detailed permission for each item. You can select groups to assign
the edit and read permissions for each menu.

Admin Item Settings can be set for User Group, Device Group, Door
Group, Elevator Group, Access Group, Zone Type, Graphic Map Group
and it can be set based on the already created group information.

If there is no group you want, add a new group to that menu. For details
about the creation of a group, refer to Adding and Managing User Groups,
Adding and Managing Device Groups, Adding and Managing Door Groups,
Adding and Managing Elevator Groups, Adding and Managing Access Groups,
Adding and Managing Graphic Map Groups.

Admin Menu
Settings

Set the edit and read permissions for the menu. A different permission can
be set according to each menu.

» Edit: The permission to add, edit, and delete the items of the menu.
= Read: The permission to read the items of the menu.

Note

= Ifyou assign the edit permission to each menu, Add Button will be
enabled. However, there is no Add Button in Dashboard and Setting
menuy, so it is displayed as N/A. And Add button in Access Control
menu is only enabled when Access Group is set as All access groups
in Admin Item Settings and the edit permission is assigned.
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You can add or view the users assigned with the privilege. If you want to add
5 Add User a user, click + Add to add a user.

» Click W to delete the registered users.

4) Click Apply to save the settings.

Note

= Refer to the following example for configuring Admin Item Settings and Admin Menu
Settings.

User Group 01 Device Grou... Door Group ... All Elevators AC Group All zones All Graphic .

2 User Disabled
3 Device Disabled
4 Door Enabled
5 Elevator Disabled
6 Zone Disabled
7 Access Control Disabled

8 Monitoring Disabled
- User: You can see the user information in the 'User Group 01'. However, you cannot add a
new user or edit existing users.
- Device: You can see the device information in the 'Device Group 01'. However, you cannot
add a new device or edit existing devices.
- Door: The setting of doors included in the 'Door Group 01' can be edited or deleted. You
can edit the device of the door included in 'Door Group 01'. You can also add a new door to
'Door Group 01"
- Elevator: You can see the setting of all the elevators. However, you cannot add a new
elevator or edit existing elevators.
- Zone: You do not have permission.
- Access Control: The setting of access groups included in the 'AC Group' can be deleted.
You can add or delete users and user groups to 'AC Group'.
- Monitoring: You can see the access control events of the devices included in 'Device Group
01'. And you can see the device and door status zone status and the alert history. You can
also see a graphic map of 'All Graphic Maps'. However, you cannot control each status.

» If the configuring for Admin Item Settings and Admin Menu Settings do not match, the
permission will not be assigned for that item. If you select the item of the menu by the
account to which this custom permission was assigned, the 'Permission Denied' message is
displayed.
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= You can add an unlimited number of custom account levels.

Preference

You can change language, time zone, time/date format, and upload a sound file to be used as an alert.

1) Click Settings > PREFERENCE.
2) Edit the necessary fields.

. Language / Time Zone

* Language

* Time Zone

* Daylight Saving Time
Date/Time

* Date Format

[ Sound

* Alert

English v

(UTC+9:00) Seoul, Tokyo, Osaka, Sapporo, Y... ¥

yyyy/mm/dd v * Time Format hh:mm v

Sound Name File Size File Format Play -

Not found

o o Jomogion

You can configure the BioStar 2 language and time zone settings.
1 Language / » Language: Select a language to use.
Time Zone = Time Zone: Select a time zone to use.
» Daylight Saving Time: Select the daylight saving time to apply to BioStar
2 server. If no registered daylight saving time, see Daylight Saving Time.
You can configure the date and time format to use in BioStar 2.
5 Date/Time
Format = Date Format: Changes the date format.
» Time Format: Changes the time format.
You can upload a sound file to use in BioStar 2.
3 Sound
a) Click + Add.
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+ Sound Name | |

+ File Size 0KB
+ File Format

+ Sound Name Browse

* Sound Files must be .wav or .mp3 format and a maxiumum of 10 MB.

b) Click Browse to select a file.
¢) Select .wav file or .mp3 file and then click Open.
d) Click Add to upload

Note

= Sound files must be .wav or .mp3 format.
= A maximum file size is 10MB.

3) Click Apply to save the settings.

(® Related Information

Alert

Card

You can view the card status, assigned users, blacklist, etc.

1) Click Setting > CARD. The list of registered cards is shown.

Card Type Card ID Status User ID User Name
CSN 1225051669057584 Assigned 2 User 1
CSN 4276710323 Unassigned
CSN 989777499 Unassigned
CSN 1217252008448048 Unassigned
CSN 1234938686282624 Unassigned
CSN 308871143 Unassigned

2) Click Unassigned Card, Activated Card or Blacklist Card to view the list of corresponding
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cards.

Note

» If a card is blocked, the card information will appear in Blacklist Card list. To unblock the
card, select a card and click Unblock.

Changing Wiegand Card Data Format

You can change the Wiegand card data formats in use simultaneously.

Note

» The data format of the card already assigned to the user will be changed.

1) Click Settings > CARD.

2) Click | *** land then select Change All Wiegand Format.
3) Select a card data format to be changed from the list of Current and select a desired card data
format from the list of Changes to.

Change All Wiegand Format X

Choose a card data format to change a current card data format at once.
The card data format which is already used on BioStar 2 will be changed
simultaneously.

« Current ID#1-26 bit SIA Standard-H10301 L4

« Changes to ID#2-HID 37 bit-H10302 L 4

-

4) Click Apply to change the card data format.

Card Format

It is possible to set the Wiegand type of the card or the website key and layout of the smart / mobile
card.

1) Click Settings > CARD FORMAT.
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2) Configuring the settings by reffering to information, Wiegand and Smart / Mobile Card.

Wiegand

You can configure the format for reading card data. The card data is processed in the set Wiegand

format.

Note

The data format of the card already assigned to the user will be changed.

1) Click Settings > CARD FORMAT.
2) Click Wiegand.
3) Click # from the list and then configure the settings.

Information

+ Mame

- Description

+ Total Bits

« ID Field

+ Parity Bits

+ Add

Start Bit End Bit size
Do = = 0 1
Position Type Start Bit End Bit size 2148
odd ¥ = = 0 v

o (menJomoon

1 Name Enter a Wiegand format name.
2 Description Enter a short description.
3 Total Bits Enter the total bit count.
4 Facility You can set whether or not to use a facility code. If you want to use a facility
Code Field code, click |_l(check box) and enter a start bit and end bit.
4 ID Field Enter a start bit and end bit of the ID to use. Click + Add to add an ID field.
Set parity bits. Click + Add to add a parity bit.
5 Parity Bits Note
= You must enter the total bit to add a parity bit.

3) Click Apply to add the Wiegand format.
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Note

= Pre-defined formats cannot be edited or deleted.

Smart / Mobile Card

It is possible to set the layout of smart cards such as MIFARE, iCLASS, DESFire, iCLASS Seos and

mobile.

Note

= To set the mobile card, set Active for Mobile Card Enrollment on the User/Device
Management tab of Setting > SERVER.

1) Click Settings > CARD FORMAT.
2) Click ADD SMART CARD and configure the setting.

Information

1 4[ Name

+ Primary Key

+ Secondary Key

« Start Block Index

Layout

+ Template Count

* Use Face Template

MIFARE iCLASS

+ Secondary Key

v

DESFire ICLASS Seos

New Primary Key

New Secondary Key Convert to HEX

Converting Result

+ Template Size 300

* Face Template Size

o Jron—Jomogion

1 Name Enter the name of the smart card.
It is possible to set whether or not to use the secondary website key. If
5 Secondary Active is set, you can set Secondary Key. When a secondary site key is
Key set, authentication is carried out using the secondary website key when the
basic site key of the card does not match.
It is possible to set the structure of smart cards such as MIFARE, iCLASS,
DESFire, iCLASS Seos and mobile.
Smart Card ) . .
3 . The primary site key and the secondary site key support only HEX values. In
Setting . . ;
the field on the right side of the screen, enter the key value and click
Convert to HEX. Use the converted value as your site key.
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= DESFre Advanced: You can use a DESFire card issued by a third-party.

Setting is available only for DESFire.

Note

= To use DESFire Advanced, enter the information for App Master Key,
App Master Key Index, File Read Access Key, File Read Access Key
Index, File Write Access Key, File Write Access Key Index, App ID,
File ID, and Encryption Type correctly.

Primary Key: Key which encrypts the communication between the smart
key and the card reader.

Secondary Key: It is possible to set secondary website key.

Start Block Index: Select the start block where each template will be
saved. This block is the index of block where user information will be
saved. If the user already has the smart key, set available block for saving.
Setting is available only for MIFARE and iCLASS.

App ID: Set the application ID. This plays a role of directory which
includes file ID. Setting is available only for DESFire.

Fle ID: Set the file ID. Setting is available only for DESFire.

Encryption Type: It is possible to set the encryption type to DES/3DES or
AES. Setting is available only for DESFire.

ADF Address Value: ADF address where digital credential is stored and
only the iCLASS Seos card is available.

Layout

It is possible to change the layout where user information and fingerprint
information are recorded.

Template Count: Set the number of fingerprint templates to be included
in the layout.

Template Size: Set the number of bytes used by the fingerprint
template.

Use Face Template: Select whether to use the face template.

Face Template Size: Set the number of bytes used by the face template.

Note

= Face templates are only available on FaceStation F2.

3) Click Apply to enroll a smart card setting.

Server
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You can configure the BioStar 2 server information, user management, device management and

automatic upgrade settings

1) Click Settings > SERVER and configure the settings.

General

General

* BioStar IP Address

+ BioStar Port

+ Session Timeout

Any v * Log Upload @) suvtomatic

51212
60 Min

* Web Server Protocol HTTP (8) HTTPS

o [omooion

General .

You can configure the general information on BioStar 2.

BioStar IP Address: Set the server IP address. Change the
setting to use a specific IP address.

BioStar Port: Set the server port.

Session Timeout: Set a session timeout period. If there is no
activity on BioStar 2 for the set time after logging in, the session
is logged out automatically.

Log Upload: Select an event log upload method. If real-time
communication with the server is difficult, set this to Manual.
Web Server Protocol: Set a server communication protocol.

User/Device Management

User/Device Management

+ Automatic User
Synchronization

+ Fingerprint
Template Format

+ Enrollment Device

* Custom User Field

All Devices v * Mobile Card ¢ Inactive
Enroliment >
Suprema v * User ID Type Number -
add
Device ID Device Name Device Group IP Address
Not found
Add
Order Name Type Data

Not found

* Delete personal & credential data when issuing an AcC  (_J) Inactive

+ AC event log storage duration (D mactive

User/ You can configure the user synchronization and fingerprint
Device template format settings.
Manage

60

day(s)
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= Automatic User Synchronization: Change the user
information synchronization method. Select All Devices to have
the user information automatically synchronized with the server.
Select All Devices(Including user update from device) to
have the user information changed on the device automatically
synchronized to all devices that registered on the server. Select
Specific Devices(Only devices belonging to the access
group) to automatically synchronize only the devices belonging
to the access group with the changes.

= Mobile Card Enrollment: Set to Enabled to use the mobile
card.

= FAngerprint Template Format: Set the fingerprint template
format. Available options include SUPREMA, ISO and ANSI378.
If there are still user fingerprint template remaining in the
device, selecting a different format is not possible.

» User ID Type: Use of Number or Alphanumeric can be set for
user ID. When Alphanumeric is set for User ID Type, BioLite
Net, BioEntry Plus and BioEntry W cannot be used. In addition, all
users saved in Xpass and Xpass S2 will be deleted and all
settings except for the network will be initialized.

» Enrollment Device: You can designate certain devices that you
frequently use for fingerprint and card enroliment as an

ment enroliment device. Click the + Add and choose the devices.

= Custom User Held: You can add custom user fields for extra
user information and these fields appear on the User page.
There are three types of custom user fields: Number Input
Box, Text Input Box and Combo Box. If you choose the
Combo Box for a custom user field, you can add up to 20 items
with 32 characters each, and each item is separated by a
semicolon (;).

= Delete personal & credential data when issuing an AoC:
If you issue an AoC card which stores user's credentials on the
smart card, you can set BioStar 2 to delete user's data and
credential information automatically.

= AC event log storage duration: You can set the period for
storing the access control event logs.

Note

» If you select Automatic User Synchronization as
Specific Devices(Only devices belonging to the
access group), users stored in the device that do not
belong to the access group cannot be managed by the
server. If you use this option, go to DEVICE menu and
click Delete Data & Sync Device for each device to
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proceed with the synchronization.

» Even if you select Automatic User Synchronization as
Specific Devices(Only devices belonging to the
access group), Access groups set up for special
purposes, such as the following, will be synchronized
regardless of the device's access group.

- Dual authentication access group set up in the Devices
and Elevators

- Bypass Group in the Anti-passback Zone

- Bypass Group in the Scheduled Lock Zone

- Scheduled Unlock Authentication Group in the Scheduled
Unlock Zone

- Arm/Disarm Group in the Intrusion Alarm Zone

» Even if you select Automatic User Synchronization as
Specific Devices(Only devices belonging to the
access group), Users set to device administrator will be
synchronized regardless of the access group.

» NFC card is supported with the below conditions.

- Mobile device OS: Android 5.0 Lollipop or later

- BioStar 2 Mobile 2.4.1 or later

- Xpass S2: XPS2M-V2 FW 2.4 or later

- BioStation 2: BS2-OMPW, BS2-OIPW FW 1.4 or later

- BioStation A2: BSA2-OMPW, BSA2-OIPW FW 1.3 or later
- BioStation L2: BSL2-OM FW 1.2 or later

- BioEntry W2: BEW2-OAP, BEW2-ODP FW 1.1 or later

- FaceStation 2: FS2-D, FS2-AWB FW 1.0 or later

- BioLite N2: BLN2-ODB, BLN2-OAB, BLN2-PAB FW 1.0 or
later

- XPass D2: XPD2-MDB, XPD2-GDB, XPD2-GKDB FW 1.0 or
later

- Facelite: FL-DB FW 1.0 or later

- XPass 2: XP2-MDPB, XP2-GDPB, XP2-GKDPB FW 1.0 or
later

» BLE card is supported with the below conditions.

- Mobile device OS: Android .0 Lollipop or later / iOS 9.0 or
later

- BioStar 2 Mobile 2.4.1 or later

- FaceStation 2: FS2-AWB FW 1.0 or later

- BioLite N2: BLN2-ODB, BLN2-OAB, BLN2-PAB FW 1.0 or
later

- XPass D2: XPD2-MDB, XPD2-GDB, XPD2-GKDB FW 1.0 or
later

- Facelite: FL-DB 1.0 or later

- XPass 2: XP2-MDPB, XP2-GDPB, XP2-GKDPB FW 1.0 or
later
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= When User ID Type is changed from Alphanumeric to
Number, all user information registered on BioStar 2
should be deleted.
» The devices and the firmware versions where the User ID
Type can be changed are as follows.
- CoreStation FW 1.0.0 or later
- FaceStaion 2 FW 1.0.0 or later
- Facelite FW 1.0.0 or later
- BioEntry W2 FW 1.1.0 or later
- BioStation L2 FW 1.2.0 or later
- BioStation A2 FW 1.3.0 or later
- BioStation 2 FW 1.4.0 or later
- BioLite N2 FW 1.0.0 or later
- BioEntry P2 FW 1.0.0 or later
- BioEntry R2 FW 1.0.0 or later
- XPass 2 FW 1.0.0 or later
- XPass D2 FW 1.0.0 or later
- Xpass FW 2.4.0 or later
- Xpass S2 FW 2.4.0 or later

= If you change the value in the Order field, the position of

the custom field on the User page changes.

= For a number input field, a number from 0 to 4294962795

is allowed and characters are not allowed.

+ @x - Number Input Bo..

= For a text input field, up to 32 characters are allowed.

+ ex - Text Input Box

= For a combo box field, the items that have been set to the

field are displayed as item. If you want to configure a
combo box field as shown in the screenshot below, you
need to enter Option 1;0ption 2;0ption 3;0ption 4 in the
data field.

+ ex - Combo Box | Option 1

None

Option 1
Option 2
Option 3

Option 4
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License

Access Control
- Applied License Enterprise

< Issuedto psy + Expiry date Hone

Time Attendance
+ Activate License Online Name Activation Key Activate

+ Activate License Offline Request offline key Activate

Video
+ Activate License Online Name Activation Key Activate

* Activate License Offline | Request offline key Activate

Visitor
+ Activate License Online Name Activation Key Activate

+ Activate License Offline Request offline key Activate

o [omooion

You can activate the purchased license.

To activate the license online, click Activate after entering your
name and the activation key that you've received from Suprema.
To activate the license offline, click Request offline key, then
the Activate License Offline dialog will appear. Follow the
instructions on the dialog.

License

Server Matching

Server Matching

- Use Server Matching D Inactive + Max. Simultaneous 4 /8
Server Matching Count

Fingerprint

- Fast Mode ¢ Active « Security Level [ ] 171,000,000

Face

- Security Level [ ] Normal

Zem _lpesapten

You can configure server matching. If you use server matching, the
user’s fingerprint will be matched from BioStar 2, not the device.
The Server Matching will appear when the Advance or higher
license is activated.

Server = Use Server Matching: Activates/Deactivates server matching.

Matching | = Max. Simultaneous Server Matching Count: You can
configure how many matchings can be done simultaneously.

= Fast Mode: You can configure the fingerprint matching speed.

= Security Level: You can configure the server matching’s
security level for fingerprints and faces. The higher the security
level is set, the more the false rejection rate (FRR) can occur.
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Note

= Max. Simultaneous Server Matching Count depends
on the PC's CPU performance.

System Log Level Settings

System Log Level Settings

+ System log storage duration 60 day(s) 0: Do not delete system logs * System log level "
nfo -

I
Not Use -
Info v
Info v

Hot Use v

Hot Use v

Zem _|pesorpton

You can set the duration and log level of the system log to be
stored in the database. The system log storage period can be set
up to 120 days, and logs is not deleted when setting to 0.

System
Log Level | System logs are managed according to pre-defined categories, and
Settings the log level is divided into Trace, Debug, Info, Warning, and Error.
The high level contains all lower level logs. For example, when set
to Trace, you can store the logs including Debug, Info, Warning,
and Error logs.

2) Click Apply to save the settings.

Note

» Please inquire your network administrator for any help necessary with the web server
protocol configuration.

(® Related Information

Real-time Log
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Trigger & Action

You can set the device or BioStar to do a specific operation when a specific event has occurred at the

devices, doors and zones.

1) Click Settings > TRIGGER & ACTION
2) Click ADD TRIGGER & ACTION and configure the settings.

2
1 —[ Name x{: + Schedule -

.

@) Device Door Zone Event Device BioStar Action

Supervised Input (Open)
Q ’ putiop Q + Output
All Devices Supervised Input (Short) All Devices None e
BB siostation 2 546832500 Tamper on @B sosteton25s6aazs00 192 ||
ﬁ BioLiteNet 538101276 RS-485 disconnected i BioLiteNet 538101276 =
B iostation a2 541531008 Device restarted BB eiostation A2 541531008 (192

— A e

5

o Jron—Jomogion

1

Name Enter a name of the trigger & action.

Select a schedule.

Note
Schedule

= When configuring a user defined condition by selecting Input, if no
desired schedule is available, click + Add Schedule to create it.
» For more information on configuring schedules, see Schedules.

Select a device/door/zone at which a specific event will be monitored.
Multiple devices/doors/zones can be selected. The devices/doors/zones work

Device independently even when they are disconnected from the BioStar server.

Door, Zone )
Note

= The Zone will appear when the Advance or higher license is
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activated.
Triggerin . .
4 Erlggt ring Set a triggering event. At least one event must be selected.
ven
5 Device and Select a device which performs the action. You can select a device or BioStar
BioStar 2 2 to perform an action.
Set a signal to send when the selected triggering event occurs. You can also
set an email to which the log will be sent from BioStar 2.
6 Action

o Select BioStar and click 'ﬁ' to configure the email server information.
e To add an email address, click + Add and enter an email address. Click
OK to add the recipient.

3) Click Apply to save the settings.

Note

= For more information on email server information, contact your system administrator.

Schedules

You can add access schedules and holiday schedules.

= Adding New Schedule

1) Click Settings > SCHEDULE.

2) Click ADD SCHEDULE.

3) Enter the required information into the fields and set a schedule for each day of
the week.
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1T —— . Name
2 ——— . pescription

3 —. Type ®) Weekly Daily

4

Sunday
Monday
Tuesday
Wednesday
Thursday
Friday

Saturday

ol

5 ——{ - Holiday Schedule

3

7 4’ None -
0

ot ot

+add

1 Name Enter a name of the schedule.
2 Descripti Enter a short description of the schedule.
on
3 Type For schedule type, select Weekly or Daily. When set to
Daily, Cycle and Start Date can be selected.
Click on time slots to set a desired schedule and click OK.
+ Schedule & Clear
Time Slot 1 : -
Time Slot 2 : -
Time Slot 3 : -
4 Time Time Slot 4 : ~
Slots )
Time Slot 5 : -
!- i | Cancel |
= Up to 5 time slots can be configured for each day of the
week or each day.
= After setting a schedule, click 4+l to copy the time slots set
immediately above.
« Click # to edit the time slots. Click 2 to delete the set
time slots.
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Holiday Specify whether to apply a holiday schedule. When the option

5

Schedule | is selected, the detailed settings can be applied.

Holiday Click on time slots to set a desired schedule for holidays.
6 Time « Click # to edit the time slots. Click ¢ to delete the set

Slots time slots.

Holiday
Selection

Select pre-defined holidays.
7 » Click + Add to add a pre-defined holiday.

» Click ¥ to delete a holiday.

4) Click Apply to add the holiday schedule.

+ Adding Holiday Schedule

Alert

You can set the alarm type and message to display when a specific event has occurred at the devices,
doors and zones. You can adjust settings so that BioStar 2 can play the uploaded sound file upon the

occurrence of alarms.

1) Click Settings > ALERT.

Device Door
Device Disconnection Det... Forced door opened
Device restarted Held door opened
RS-485 disconnected Forced door open alarmed
Tamper on Held door open alarmed

Supervised Input (Short)
Supervised Input (Open)

AC Power Failure

Elevator

Enable all floor relays

2) Select event types to display on the screen.

3) Click = and enter a message to display on the screen. If you have uploaded the sound file to play

234

Zone
Anti-passback zone alarm.
Fire alarm zone alarm det...
Scheduled lock zone alar
Intrusion alarm detected
Interlock door open denie.
Interlock door open denie...

Muster zone alarm detected

Authentication
1:1 authentication failed
1:1 duress authentication s...
1:N authentication failed
1:N duress authentication s...
Access denied (Invalid acce .
Access denied (Disabled user)
Access denied(Invalid period)
Access denied (Blacklist)
Access denied (Hard Anti-pa...
Access denied (Forced lock ...
Access denied (Soft anti-pa...

Fake Fingerprint Detected
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upon the occurrence of a corresponding event, select it from the list of Sound HRle and set the Play
Options. If there is no sound file to play, upload it with reference to the Sound of

+ Name Alert Message
+ Message |
e
+ Sound File alert (2
+ Play Options Once

‘ pph Cancel

4) Click Apply to save the alert messages.
5) Click Apply to save the changes.

(® Related Information

HTTPS

In order to connect BioStar 2 through HTTPS, it is necessary to register the IP address where BioStar 2
is installed and install the certificate. For correct network connection, install the certificate before using
BioStar 2.

Note

» BioStar 2.5.0 uses HTTPS as the default communication protocol.

1) Click Settings > HTTPS.
2) Click Cert. Download.
3) Unzip the downloaded file and run cert-register.exe file. Enrollment Certification window will

appears.
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Enrollment Certification

Server Address :

Cancel

4) Enter the IP address of the PC where BioStar 2 is installed and click Enrollment.

5) Check the security warning message and click Yes.
6) When you restart the web browser and enter the registered IP address, Secure will appear on the

address bar of the web browser.

Cloud

You need to configure the cloud settings in order to access your BioStar 2 server remotely (outside of
the local network). Additionally, the cloud settings should be done in order to use the BioStar 2 Mobile

app.

Note

= The Cloud will available when the Standard or higher license is activated.
= If you use BioStar 2 Cloud, cannot connect to BioStar 2 through Internet Explorer or Edge.
» If you connect BioStar 2 using the Cloud, cannot access to the VIDEO menu.

1) Click Settings > CLOUD.
2) Edit the necessary fields.

General

1 —[' Cloud Use Use

2 —[ Subdomain Name suprema biostar2.com * Administrator e-mail suprema@suprema.co.kr ]— 3
Advanced

4 ———— Cloud Server Address | api.biostar2.com * Port Used By Cloud 52000 —:=

5 4[‘ Version v2

o {menJomoior

To use the cloud set it as Use. If you set as Not Use, it will be unable to
access BioStar 2 using BioStar 2 Mobile.

1 Cloud Use Note

» If you set Cloud Use as Use, Password Level should be set as
Medium or Strong. For more information, see Server.
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Enter the subdomain for usage. You can use the subdomain to access
5 Subdomain BioStar 2 using BioStar 2 Mobile.
Name The subdomain is a unique value for identification same as user ID, so use a
unique word such as company names.
3 Admlnls'Frat Enter the cloud administrator email.
or e-mail
Cloud
4 Server The Cloud server’s address. Normally set as default.
Address
5 Version The Cloud server's version. Normally set as default.
This is the port number the cloud uses. Normally set as default (52000).
If the cloud does not operate normally, modify the inbound and outbound
Port Used rules from the firewall setting on the PC where BioStar 2 is installed. For
6 By Cloud more information, contact the system administrator.
= Ports to be added to the inbound rule: BioStar 2 server port (Default
value: 80, user-specification), BioStar 2 cloud port (Default value: 52000,
user-specification)
» Ports to be added to the outbound rule: 4443, all ports used by ngrok

3) Click Apply to save the changes.

Note

» E-mail transfer may take up to 10 minutes.
= For the cloud, BioStar server must always be turned on. If the server loses more than one
week of connection, you must proceed with a re-register process via email.

Image Log

It is possible to set the default value which can be added when using the delete option of image log and
an image log from the device.

1) Click Settings > Image Log.
2) Edit the necessary fields.
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[ Preset
+ Configuration +Add
1:1 authentication succeeded Always ¥
1:1 authentication failed Always ¥
1:1 duress authentication succeeded Always ¥
1:N authentication succeeded Always ¥
1T — 1:N authentication failed Always v
1:N duress authentication succeeded Always ¥
Dual authentication succeeded Always ¥
Dual authentication failed Always ¥
Authentication failed Always ¥
Access denied Always ¥
Administrator menu entered Always ¥
[ Delete Option
7 —
+ Delete Option None
[ User Profile Image Option
3 —
+ Display user profile image when there is no image log for the events

o (mn Jomoon

It is possible to set the default setting to be used when adding an image log
to the device.
It is possible to add an event and schedule to delete by clicking + Add.

1 Preset )
Note

» If there is no desired schedule, set a desired condition by clicking +
Add Schedule.

It is possible to set the delete condition of image log.

= Delete Option: It is possible to set the condition to delete an image log.

Delete « Amount of Image Log: It is possible to set the unit of condition set at

Option Delete Option.

= Delete Cycle: It is possible to set the cycle to carry out the delete
condition of image log set from Delete Option and Amount of Image
Log.

If this option is on, the profile image registered for a user is displayed on
the Event Log and Real-time Log pages when there are user related
events. This option is particularly useful when you have devices that do not
have a built-in camera.

User Profile
3 Image

Option i
Note

= Even if the user profile image option is on, the image captured from
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the device camera is displayed when there is an image log for the
event.

3) Click Apply to save the changes.

Note

» The default setting set from Setting > Image Log does not apply to the device. To add or
change an image log of the device, refer to Image Log.

USB Agent

If you want to use the USB Device when logging into BioStar 2 from a client PC, installing the USB Device
Agent is required.

Note

= If User Account Control is enabled in Windows, USB Agent cannot be run automatically.
Disable the User Account Control or run as administrator.

1) Click Settings > USB AGENT.
2) Download the file by clicking Download, and install it.

USB Device Agent

You must install the USB Device Agent before using USB device. Click the Download button and then install the USB Device Agent.

Download

3) Select the byte order of USB card device.

Byte Order of USB Card Device

Byte order is applied to CSN card type only.

+ Byte Order MSB

4) Set the port that the USB Agent will use.
USB Agent Port

The USB Agent port number setting is to designate the port number to be communicated from the server, because the agent program runs at each client independently.

* USB Agent Port Number (8081
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5) Click Apply to save the changes.

Face Group Matching

Face group matching is the function used to specify a matching group based on the user groups set in
BioStar 2 and authenticate users in that manner.

Note

= Up to 10 matching groups can be created.
» Each group can include up to 3,000 face templates.
» The total number of face templates in the matching group cannot exceed 5,000.

1) Click Settings > Face Group Matching.
2) Edit the necessary fields.
General
1 + Group Matching fT_ Use

2 —[ + Group Matching Device Settings Device ID Device Name Device Group IP Address i

4 FaceStation 2 4 (192.168.16.208) All Devices 192.168.16.208 v

+ Matching Group Settings Number of Faces +had

t

1 hd 15F 15F USER - 4/ 3000

2 hd 16F 16F USER - 4 /3000

t

3 hd 17F 17F USER - 1/ 3000

o {menJomoior

Set whether or not to use Group Matching.

1 Group. Note
Matching

» To disable the group matching while it is being used, all devices set
previously and the group settings must be deleted.

Group
Matching
Device
Settings

Set a device to use the group matching. Only FaceStation 2 can be added.

Matching Click + Add and set Group Name and User Group.

3 Group )
Settings Note
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= Up to 10 matching groups can be created.

= A number of user groups can be set for one matching group.

= If the number of face templates included in the user group exceeds
3,000, it cannot be set as a matching group.

3) Click Apply to save the changes.

Audit Trail

Audit trail tracks user access information as well as all the information changed in the system. You can

set a filter for each item for sorting.

1) Click Settings > Audit Trail.

2
= Last 1 Month ‘\
1 -
B

i= Last 3 Months

e

3
« | Audit Trail X ) o[> )] | s0rows ~

Filter

* Operator L
* Datetime * User evel P * Category * Target * Action

2017/07/29 00:00 - 2017/... * None v None v None - None w None w None w T Save Filter @]74

Datetime User Operator Level [ Category Target Action Modification
2017/08/29 18:24:46 Administrator(1) Administrator(1) 127.0.0.1 Custom Fi. Add
2017/08/29 18:24:46 Administrator(1) Administrator(1) 127.0.0. Server Set. Update
2017/08/29 17:45:14 Administrator(1) Administrator(1) 127001 Zone APB1 Add
2017/08/29 15:3T:16 system 127.0.0.1 Device nvr(700000001) Add
2017/08/29 13:10:04 Administrator(1) Administrator(1) 127.0.0.1 Door Door 2 Add
2017/08/29 13:09:44 Administrator(1) Administrator(1) 127.0.0.1 System Action Login

o [ron  Jomown

1 Period You can set the previous 1 month or 3 months conveniently for the period.
5 Filt You can set conditions for each filter item. Click Save Filter to save the
Heer filter.
You can move a page or set the number of list rows to be displayed on one
page.
Page = " Go to the first page.
Navigati .
3 BSgltlc?:stlgﬂd = | *: Go to the previous page.
Number of « | 2 /2: Epter the page number to move to.
List Rows » " Go to the next page.
» | "I Go to the last page.
210ws | get the number of list rows to be displayed on one page.
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Function
Buttons

4 (CSV Export, | You can save the list of audit list as a CSV file or changes the column setting.
Column
Setting)

5 Audit List Shows the audit list.

Video

You can set the path to save video files and the storage duration.

Note

» The VIDEO menu will appear when the Video license is activated.
» Use a separate storage media for the video log. Video logs might not be saved if the video
storage space is reduced by the external processing(such as copying files and creating files),

1) Click Settings > Video.
2) Edit the necessary items.

1 —[ * Video File Path D:\Program Files\BioStar 2(x64)\ve\records\
2 —[ * Video Recording space 20 GByte
settings

3 4[ + Racording space manag  When the recording space is full, (®) overwrite from the oldest file.
ement
stop recording.

* Recording Space Status
D:\ Total Recording Space Status D:\ Video Recording Space Status

Unalloc ated
Space

F - 38029
Video
Alloc ated
Space

Remaining
Space Allocated
Space

* Video Recording Space 20 GByte *+ Total Recording Space 931.511 GByte
Status Status

* Video Allocated Space 20 GByte + Remaining Space 793.481 GByte

* Video Used Space 0 GByte

o L xen—] o

Video File You can change the path to save a video file.
1 Path It is recommended to use a separate storage media for saving files
securely.
Video . .
2 . You can set the recording space to store video files.
Recording
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space
settings

Recording
space
managemen
t

If there is insufficient storage space, you can set the file processing method.

Recording
4 Space You can view the video storage space status.
Status

3) Click Apply to save the changes.

Daylight Saving Time
Daylight Saving Time (DST) is a function that adjusts the time to better utilize natural daylight.
1) Click Settings > Daylight Saving Time.

2) Click + Add.
3) Edit the necessary items and click Add.

Add Daylight Saving Time X

+ Name D5T
+ Start Date/Time 03 + | Month 1 w [ Week SUN » | Day of Week 01:00

« End Date/Time 11 + | Month 2 w | Week SUN « | Day of Week 01:00

o« [

4) Click Apply to save the settings.

Note

» You cannot edit or delete a daylight saving time that is already in use.
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Security

You can set the password level and the maximum password age. You can also set the maximum invalid
attempts and the maximum password change limit.

1) Click Settings > SECURITY.
2) Edit the necessary items.

== Login Password

Login Password

- Password Level [ ] Medium

- Maximum Password Age

+ Maximum Invalid Attempts

+ Maximum Password Change Limit

Zem _lpesapten

Set the policy for the password complexity for BioStar 2 login.

L:J 'L:J {J

= Low: You can enter up to 32 characters.

= Medium: You must combine 8 to 32 alphabetic characters (a to
z), numbers, and at least one alphabetic capital (A to Z).

= Strong: You must combine 10 to 32 alphabetic characters (a to

Password . .
Level z), numbers, at least one alphabetic capital (A to Z), and
symbols.
Note
= If Cloud Use set to Use, you can only use Medium or
Strong.
You can set the period for which you want to use the password. If
the Maximum Password Age is exceeded, a password change
) request message is displayed at login.
Maximum
Password )
Age Note
= You can set the Maximum Password Age from 1 day to 180
days.
Maximum | You can set the Maximum Invalid Attempts and the time limit. If

Invalid you enter the wrong password more than the set number of times,
Attempts | you will not be able to log in for the time limit.

Maximum | Yoy can set the Maximum Password Change Limit.
Password

Change
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Note

Limit = You can set the Maximum Password Change Limit up to 10
times.

= Advanced Security Settings

Advanced Security Settings

« Encrypt Personal Data on Database @& ) use « Personal Data Encryption Key

+ Secure communication with device @) vse + Use external certificates (I NotUse

+ Device Hashkey Management (JP nNotuse

Zem JDeserpton

When Use is set for Encrypt Personal Data on
Database, all sensitive data including credential data and
personal information will be stored in the database as
encrypted. If this option is set as Not Use, the encrypted
data will be decrypted and the user's personal information
will be stored in an unencrypted state.

Note

» Items to be encrypted when using Encrypt Personal
Data on Database are as follows.
- Profile image
- User ID
Encrypt Personal - Name
Data on - Phone number
Database - User IP
- Email information for sender ans recipients
- Login ID
- Login password
- Face template
- Fingerprint template
-Card ID
- Smart card layout key
- Custom information for user and visitor
- Image log files
= Do not force start the server while encrypting
personal data on the database. Errors such as
failure to log in to BioStar 2 may occur.

Personal Data

. You can set the personal data encryption key. Click Change
Encryption Key
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and set a new encryption key. If changing the encryption
key, the existing data will be re-encrypted.

Note

= You can enter the encryption key with 32 characters
using letters, numbers, and symbols.

The communication between BioStar 2 and a device can be
protected using a certificate.

When Use is set for Secure communication with device,
BioStar 2 creates and sends a certificate to the device. The
device can use a secure channel for exchanging data with
BioStar 2 using this certificate. In order to use an external
certificate, Root certificate, Public key certificate, and
Private key files must be uploaded.

If Device Hashkey Management set to Use, you can set
a new data encryption key and administrator password.

Note

= The devices and the firmware versions where the
secure communication can be set are as follows.
- FaceStation 2 FW 1.1.0 or later
- BioStation A2 FW 1.5.0 or later
- BioStation 2 FW 1.6.0 or later

Secure - BioStation L2 FW 1.3.0 or later
communication - BioLite N2 FW 1.0.0 or later
with device

- BioEntry P2 FW 1.1.0 or later
- BioEntry W2 FW 1.2.0 or later
- FacelLite FW 1.0.0 or later
- XPass 2 FW 1.0.0 or later
- CoreStation FW 1.1.0 or later

» BioStar 2 creates or deletes a certificate according
to the setting status of Secure communication
with device, and the same certificate as the
previous certificate will not be created. For
example, if the setting of Secure communication
with device is changed in the order of [Use - Not
Use], the created certificate will be deleted
automatically. When the setting is changed in the
order of [Use - Not Use - Use], the operation of
[Create A certificate - Delete A certificate - Create B
certificate] is carried out.

= If the device is disconnected from the network
physically while using the secure communication of

246



16 BioStar 2 Settings

o Jowowon

BioStar 2, do not turn off the secure communication
option. In such a case, the certificate of BioStar 2
will be deleted, and the device will not be able to
connect again. To connect it again, the certificate
saved in the device must be deleted or the device
must be reset to factory default. For more details,
refer to the manual of the device.

Session Security

Session Security

+ Simultaneous Connection Allow ( Active

You can set whether to allow simultaneous connections using the

Simultane _ _

ous same account. If you set Simultaneous Connection Allow to
Connectio | Inactive, a previously logged in user will be logged out when
n Allow attempting to connect to the same account simultaneously.

3) Click Apply to save the settings.
Active Directory

You can synchronize user data stored in Microsoft Windows Active Directory to BioStar 2.

Note

= The Active Directory setting will appear when the AC Advanced license is activated.

» The Active Directory is available for a system environment with Windows Server 2008 R2 or
later.

= To use the Active Directory, set the User ID Type to Alphanumeric by referring to User/
Device Management.

1) Click Settings > ACTIVE DIRECTORY.
2) Edit the necessary items.
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Active Directory Server

1 4[ « Secure transfer L) Active
2 4[ + Keystore password

3 ————— - serveraddress

4 —————— - userName

6 ——t—— - userBaseON

Test Connect

7 ———T——— - UserGroup Filter @ ) Active
8 4[ * User Group Base DN Pull User Group
g 4[ - User Group None v

Field Configuration

« User Field Mapping BioStar? User Bk AD S r Fi Al
10 sAMAccountName

Update

Synchronize

+ Status Not yet executed
11 4[
Sync Now

You can use the encryption when communicating with a Windows Active
1 Secure Directory server.
transfer Install Active Directory Certificate Services and set the keystore password by
referring to Active Directory Encryption.
5 Keystore Enter the Windows Active Directory server encryption key store password.
password This can be only used when activating the Secure transfer.
3 Server Enter the server address for Windows Active Directory.
Address
4 User Name Enter the user name used by Windows Active Directory.
5 Password Enter the password used by Windows Active Directory.
Enter the base domain name for Windows Active Directory.
You can find the base domain name in the following way.
6 Base DN a) Run the Active Directory Administrative Center.
€ b) Right-click on the node where user data is stored, and then click
Property.
¢) In the property window, click Expand and then click Attribute Editor.
d) View the value of distributedName.
7 IL:J_slter Group You can enable or disable synchronization by user group.
ilter
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8 User Group Enter the base domain name of the user group for Windows Active Directory.
Base DN This can be only used when activating the User Group Filter.
Select the user group to synchronize. This can be only used when activating
9 User Group
the User Group Filter.
You can map data fields in Windows Active Directory to user fields in BioStar
2.
The user fields to be mapped can be set as shown below.
1o | User Field
Mapping
a) Click + Add to add a user field slot.
b) Set the BioStar 2 User Field and AD Server Field to map the correct data
to the user field in BioStar 2.
c) Click Update to apply user field mapping settings.
Note
= The User ID field is a static item and cannot be deleted.
) Click Sync Now to synchronize the user data. The last synchronization time
11 Synchronize

and date are displayed.

3) Click Apply to save the settings.

Active Directory Encryption

You can use the encryption when communicating with a Windows Active Directory server.

Set according to the following order when using the encryption for the first time.

Step 1. Installing Active Directory Certificate Services

To use Windows Active Directory server encryption communication, you must install the Active Directory

Certificate Services.

The Active Directory Certificate Services can be installed as follows:

1)

2)
3)

On the PC where the Windows Active Directory server is installed, run Server Manager, and then

click Manage > Add Roles and Features.
On Before You Begin, click Next.
On Select Installation Type, select Role-Based or feature-based installation and then click
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Next.

4) On Select destination server, select Select a server from the server pool, check the server,
and click Next.

5) On Select Server Roles, select Active Directory Certificate Services and click Next.

6) When a pop-up window appears, view the details and click Add Features > Next.

7) View the details of Active Directory Certificate Services and click Next.

8) On Confirm installation selections, click Install. When installation is complete, click Configure
Active Directory Certificate Services on the destination server.

9) When AD CS Configuration wizard appears, view the details and click Next.

10) On Role Services, click Certification Authority > Next.

11) On the Setup Type page, select Enterprise CA and click Next.

12) On the Specify the type of the CA page, select Root CA and click Next.

13) On the Specify the type of the private key page, select Create a new private key and click
Next.

14) Set the Cryptography for CA, CA Name, and Validity Period, and then click Next.

15) On the CA Database page, set the folder location for the certificate database and the
certificate database log and then click Next.

16) On Confirmation page, view the details of Active Directory Certificate Services and click
Configure.

Step 2. Connecting IDAPS

1) Click Start > Run.

2) Enter ldp in the input field.

3) When the Ldp-disconnected window appears, click Connect.
4) Fill in Server and Port fields and select SSL. And then click OK.

Step 3. Copying the root certificate

1) Run Command Prompt on the PC where the Windows Active Directory server is installed.

2) Enter certutil -ca.cert client.crt command to copy the root certificate.

3) Enter keytool -import -keystore ad.jks -file client.crt command to convert the server
certificate to .jks format.

4) Save the .jks-formatted server certificate to the BioStar 2 installation path.

Visitor

You can configure visiting sites and PCs. You can also set the terms and conditions for visitors.
And You can create the information fields that you want to know from the visitors by using the Custom
Visitor Field.
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Note

= The VISITOR setting will appear when the Visitor license is activated.
= Activate the Automatic User Synchronization or Use Server Matching option to use the
VISITOR.

1) Click Settings > VISITOR.
2) Set the necessary items.

Site Settings

Site Settings
. site + Add

Suprema 01 Acces... csN

Suprema 02 Acces. Wiegand 26 bit

oo

You can set the access group to use in the visiting PC and
managing PC of each site.

You can also set whether or not to use cards. If you are using a
card, you can also set Card Type and Card Data Format.

= Name: You can set the name of site.

= Access Group: You can select the access group to assign to the
visitor.

= Card Use: You can set whether or not to use a card.

= Card Type: You can select the type of card to use in the site. The
card type is activated only when you select Card Use.

= Card Data Format: You can configure the format for reading card
data. The Card Data Format is activated only when you set the
Card Type to Wiegand.

Site

Note

= Up to 48 characters may be entered for a site name.

Click Apply to save the setting of the site.

Visit PC Settings
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Visit PC Settings

vepesain m— =
Apply

+ Visit application page hiips://192.168.14.25/2 register_welcome

Drag and drop links: from your visiting PC to create shortcuts on your deskiop

“

You can set the visiting PC and managing PC.

= Name: You can set the name of the visiting PC and
managing PC.

= Fingerprint Device Name: Select a device to enroll visitors'
fingerprints when visitors access the site using the
fingerprint authentication.

= Card Device Name: Select a device to issue the card to
visitors when visitors access the site using the card
authentication.

1 Visit PC = Site: Select a site to manage the visit on the visiting PC.

Setting

Note

= Up to 48 characters may be entered for a name of
the visiting PC.

= You can use the fingerprint and card device at the
same time. You can select only one for each.

= You can only select one site per PC.

Click Apply to save the setting of the Visit PC Setting.

Visit You can create a shortcut icon of Visit application page on
2 applicati | the desktop of the visiting PC. Drag and drop the link to the
on page desktop of the visiting PC.

== Visit PC Select

Visit PC Select

+ Visit PC Select Visiting PC -

You can select the PC set in Visit PC Setting and assign it to the
current PC.
Click Apply to save the setting.

Visit PC
Select
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Terms & Visitor Settings

Terms & Visitor Settings

Accept Terms and Conditions Settings

I

L I 4
3 4[ + Allowed period for credential ’ Day(s)

Visitor Settings

* Guide to Completion of Visit rd

5 4[ * Default access period for visitor # | 1 Day(s)

You can set the terms and conditions for visitors.

Click o to activate the input field and enter the
contents of terms and conditions.

Terms and a
1 e
Conditions Note

= Up to 65,535 characters may be entered for
the sentence of terms and conditions.

= Up to 64 characters may be entered for the
sentence of accept terms and conditions.

You can set the privacy policy for visitors.

Click o to activate the input field and enter the
privacy policy.

2 Privacy Policy Note

= Up to 65,535 characters may be entered for
the sentence of privacy policy.

= Up to 64 characters may be entered for the
sentence of accept privacy policy.

You can set the period for keeping personal data that

visitors provide when they visit.

Allowed period P
3 Click to activate the input field and enter the

for credential
number of days to keep personal data.
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“

Note

= You can delete the visitors that have
the personal data expired in
VISITOR menu.

You can set the guide to appear on the screen as a
pop-up when a visitor completes an application for a
visit.

Click ' # to activate the input field and enter the guide

Guide to for visitors.
4 Completion of .
Visit Note

= Up to 65,535 characters may be entered for
the sentence of guide.

= |fyou do not enter the sentence of a guide,
nothing will be displayed on the screen when
visitors complete their visit application.

You can set the access period for visitors.

5 Default access ) p . .
period for visitor Click to activate the input field and enter the

default access period for visitors.

Custom Visitor Feld

Custom Visitor Field
* Custom Visitor Field Settings +add

Apply

1 purpose of visit Text Input Box ¥

g lEewen

You can add custom visitor fields for extra visitor information
and these fields appear on the visit application page.

= Order: You can set the order of the Custom Visitor Field.

Custom = Name: You can set the name of the Custom Visitor Field.

Visitor Field = Type: You can choose the Text Input Box, Number Input Box

Settings or Combo Box.

= Data: Enter the options to appear in the combo boxes. Each
item is separated by a semicolon (;). Data is only activated
when Type is set to Combo Box.
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o o

Note

allowed.

* Purpose of visit

* Number of visitors

data field.

* Option

= For a Text Input Box, characters and numbers are

= For a Number Input Box, numbers are allowed and
characters are not allowed.

= For a Combo Box, the items that have been set to the
field are displayed as item. If you want to configure a
combo box field as shown in the screenshot below, you
need to enter Option 1;0ption 2;0ption 3;0ption 4 in the

[ Mone

MHone

Option1
Option2
Option3

Option4

Click Apply to save the setting of the Custom Visitor Field.

Mobile Access

By linking BioStar 2 and Airfob Portal, you can issue the mobile access cards to users in BioStar 2.
Users can be issued mobile access cards through a link received by email or SMS without signing up for

Airfob Portal or registering mobile access cards separately.

Note

= The devices and the firmware versions that can use the mobile access are as follows.

- XPass 2 FW 1.1.0 or later

- XPass D2(Rev 2) FW 1.4.0 or later

- BioLite N2 FW 1.3.0 or later

- BioEntry W2(Rev 2) FW 1.6.0 or later
- FaceStation 2 FW 1.4.0 or later

You can set up Suprema Mobile Access as shown below.

Step 1. Join Airfob Portal and open site
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In Airfob Portal, you can set up mobile access cards and registration devices, and manage sites and
credits.

& Related information

Step 2. Configure the Mobile Access in BioStar 2

You can set whether to use the mobile access and manage settings related to Airfob Portal.
You can also register devices to use mobile access cards.

Related information

Step 3. Registering Devices
You can register devices to use mobile access directly from the Airfob Pass application or BioStar 2.

Related information

Step 4. Issuing Mobile Access Card
You can issue mobile access cards to users registered with BioStar 2.
To issue a mobile access card to a user, you must enter user information based on the messaging

option.

Related information

Airfob Portal

In Airfob Portal, you can set up mobile access cards and registration devices, and manage sites and
credits.
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1) Access the Airfob Portal(https://mc.suprema.io).

2) Click Get Started to sign up and create a site.

3) Enter the Airfob Portal administrator's email address in the Email input field and click Get Started.
The authentication code will be sent to the email address you entered.

4) Enter the authentication code you received in the authentication code field and click Confirm.

Note

» The authentication code is a 6 digit number.

5) Check the Privacy and Terms and click Agree.

6) Set the password and nickname to use in the Airfob Portal and click Create Account. Creating the
account will be completed.

7) Click Sign In.

8) Enter the email and password, then click Sign In.

9) Click Create Site to open the site.

Note

» Site means an organization or company that uses the mobile access.

10) Set the name and country of the site, and then click Next.
11) Select the site type.

Note

= You can select types either Dynamic or Regular depending on the type of sites or situations.
- Dynamic: This type allows you to reissue, revoke, or stop mobile access cards or specify
the expiration date of it. It deducts credits according to the period of use or devices. Dynamic
can be used in gyms, libraries, or shared facilities where it provides membership services.
- Regular: This type can be used permanently until an administrator deletes the access
authority. It deducts credits according to the number of issuances. Regular can be used in
companies as employee ID cards or access cards.

» BioStar 2 only supports regular card sites. Dynamic cards will be supported in the future.

12) Click Create. Creating the site will be completed.
13) Click the site name to access the Airfob Portal of the site.

Note

» For more information on using the Airfob Portal, see the Airfob Portal(https://mc.suprema.io).

Configuring Mobile Access

You can set whether to use the mobile access and manage settings related to Airfob Portal.
You can also register devices to use mobile access cards.
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1) Click Settings > MOBILE A CCESS.
2) Edit the necessary items.

General

* Mobile Access Setting Use + Site Type
* Domain https://api.mc.suprema.io * Port 443
* Site ID 1307 + Email test@suprema.co.kr

* Password = | eeseessscss Connect

o Jomerpt

= Mobile Access Setting: You can set whether to use the mobile access. If you set
the Mobile Access Setting to Use, you can issue mobile access cards to users.

Note

= To use Mobile Access with BioStar 2, complete the Airfob Portal sign-up and
initial setup first.

» Site Type: You can see the site type.

Note

» BioStar 2 only supports regular card sites. Dynamic cards will be supported
in the future.

= Domain: You can see the domain address of the Airfob Portal.

= Port: You can see the port number of the Airfob Portal.

= Site ID: Enter the site ID that you created in the Airfob Portal. You can find the site
ID in the Site & License menu of the Airfob Portal.

= Email: Enter the email address of the mobile access administrator.

» Password: Enter the password of the mobile access administrator.

= Device Registration: You can register devices to use the mobile access. Device
Registration appears when you complete entering the Domain, Port, Site ID,
Email, and Password, and then click Connect to successfully connect to the
Airfob Portal.

General

- Device Registration + Add

Not found

Click + Add to add devices to use the mobile access. The list of devices registered
in BioStar 2 is displayed.
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o o

Enrollment Device X

[ ] Device ID Name Group IP Address

[[] saresanz FaceLite 547832712 (192.168.14.240) All Devices 192.168.14.240

[[] 547833190 Xpass2 Keypad 547833190 (192.168.14.233) All Devices 192.168.14.233

Close

Select the device and click Add.

+ Device Registration Device ID Device Name Device Group IP Address

547833190 Xpass2 Keypad 547833190 (192.168.14.233) All Devices 192168 14.233 oW

The devices that have been added to the list of devices are displayed. Click < to
resend the mobile access certificate. Click ¥ to delete the registered device.

Note

= The devices and the firmware versions that can use the mobile access are as
follows.
- XPass 2 FW 1.1.0 or later
- XPass D2(Rev 2) FW 1.4.0 or later
- BioLite N2 FW 1.3.0 or later
- BioEntry W2(Rev 2) FW 1.6.0 or later
- FaceStation 2 FW 1.4.0 or later
= You can also register devices using the Airfob Pass application.
» If you delete the registered device, the mobile access certificate sent to the
device will be deleted.

Email Contents

You can set contents such as title, company name, company logo, and contact of email to which the
visual face mobile enrollment link will be sent.

Note

= Before setting an email contents, activate the Cloud. The Cloud will available when the
Standard or higher license is activated.
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= Enter user's email address in the user information to use visual face mobile enrollment.

1) Click Settings > EMAIL CONTENTS.
2) Edit the necessary items.

Email Contents Setting

1 4[ + Email Title Visual Face Enrollment
2 4[ + Company Name Suprema
3 4[ + Company Logo Upload Loga Image
rs 4i + Contact 012345678
5 4[ + SMTP Setting SMTP setting
§ ———— - TestMailRecipient Address | userGtest.com (9 Send Email
o [mem | oesrpio
1 Email Title Enter the title of the email.
2 Company Name Enter the company name.

Upload the company logo image.

3 Company Logo Note

= Supported image file formats are GIF, JPG, JPEG, JPE, JFIF, PNG.

4 Contact Enter the contact information of the person in charge.

Set the SMTP(Simple Mail Transfer Protocol) for sending emails.

SMTP Option X

Sender Information
+ SMTP Server Name
+ Description

« Server Address

Port(default:25) 25

+ User Name

4 SMTP Setting

« Password

Security Type SSL v

+ Sender

i,

= SMTP Server Name: Enter the SMTP server name.
= Description: Enter the description.
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o [t oo

» Server Address: Enter the SMTP server address. SMTP server
address is the same form as 'smtp. Email Service Provider.com', and
you can check it on the settings screen of email to use as an SMTP .

= Port(default:25): Enter the port number of the SMTP server. you
can check it on the settings screen of email to use as an SMTP.

» User Name: Enter the account of the SMTP service.

= Password: Enter the password of the SMTP service.

» Security Type: Select security type.

» Sender: Enter the email address of the sender.

Note

» For more information on SMTP information, contact your system
administrator.

= When using the SMTP server as the administrator's Gmail, note
the following when changing the administrator's Gmail account
password. When using Google 2-Step Verification, the SMTP
password uses that account's app password, not the Gmail
account's password. At this time, if the password of the Gmail
account is changed, the app password is automatically deleted,
and the SMTP password cannot be used. When changing the
password for the Gmail account, regenerate the app password
and then set the SMTP password again.

5 Test Mail
Recipient Address

Enter an email address to receive the test email and click Send Email.

3) Click Apply to save the settings.

For any inquires or technical support concerning BioStar 2, please contact the Suprema Technical
Support Team (support.supremainc.com).

For efficient technical support, please provide the following information.

= Company name, your name and job title, country information (regional information), contact
information and the best time to reach you

» Current BioStar 2 version and device models (examples: BioStar 2 V1.0.233, BioLite Net)

» Details of the error message

= BioStar 2 system log

= Description of your symptom and problem
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17 Troubleshooting

This section provides the disclaimers, copyright notice, and software end user license agreement of

Suprema.

Disclaimers

262

The information contained in this Guide is provided in regard to the Suprema product.

Your right of usage is recognized only for products included in sales agreements and
conditions guaranteed by Suprema. No license rights over other intellectual properties
mentioned in this Guide are recognized.

Suprema makes no representations or warranties concerning infringement of patents,
copyrights or other intellectual property rights as well as merchantability and fitness of the
product for a particular purpose in regard to the sale or use of the Suprema product.

Do not use the Suprema product in medical, life-saving and life-sustaining situations or in
situations where malfunction of the product could lead to personal injury or loss of life.
However, if an accident occurs while the purchaser is using the product in any of the
situations stated above, even if shortcomings are discovered in the design or production
process of the product and are claimed as a point of major negligence, employees,
subsidiaries, branches, affiliates, or distributors of Suprema shall not be liable and shall not
make reimbursements for any direct or indirect costs or expenses associated, including
lawyer fees.

Suprema may change the product standards and specifications at any time without any
adequate notice for improvements in stability, performance or design of the product.
Designers should keep in mind that features or descriptions marked as 'to be implemented' or
'to be defined' are always subject to change. Suprema will implement or define such features
or descriptions in a near future and shall not be liable for any consequent problems, including
problems of compatibility.

If you wish to obtain the latest specification documentation before you place an order for the
product, please contact Suprema, a sales agent of Suprema or a regional distributor.
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Copyright Notice

Copyright of this documentation is reserved by Suprema. All other product names, trademarks,
registered trademarks are the property of their respective owners.

Open Source License

MariaDB LGPL client libraries for C and Java

The LGPL license
GNU LESSER GENERAL PUBLIC LICENSE
Version 2.1, February 1999

Copyright (C) 1991, 1999 Free Software Foundation, Inc.

51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA
Everyone is permitted to copy and distribute verbatim copies
of this license document, but changing it is not allowed.

[This is the first released version of the Lesser GPL. It also counts
as the successor of the GNU Library Public License, version 2, hence
the version number 2.1.]

Preamble

The licenses for most software are designed to take away your freedom
to share and change it. By contrast, the GNU General Public Licenses
are intended to guarantee your freedom to share and change free
software--to make sure the software is free for all its users.

This license, the Lesser General Public License, applies to some
specially designated software packages--typically libraries--of the
Free Software Foundation and other authors who decide to use it. You
can use it too, but we suggest you first think carefully about whether
this license or the ordinary General Public License is the better
strategy to use in any particular case, based on the explanations
below.

When we speak of free software, we are referring to freedom of use,
not price. Our General Public Licenses are designed to make sure that
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you have the freedom to distribute copies of free software (and charge
for this service if you wish); that you receive source code or can get

it if you want it; that you can change the software and use pieces of

it in new free programs; and that you are informed that you can do
these things.

To protect your rights, we need to make restrictions that forbid
distributors to deny you these rights or to ask you to surrender these
rights. These restrictions translate to certain responsibilities for

you if you distribute copies of the library or if you modify it.

For example, if you distribute copies of the library, whether gratis

or for a fee, you must give the recipients all the rights that we gave
you. You must make sure that they, too, receive or can get the source
code. If you link other code with the library, you must provide
complete object files to the recipients, so that they can relink them
with the library after making changes to the library and recompiling

it. And you must show them these terms so they know their rights.

We protect your rights with a two-step method: (1) we copyright the
library, and (2) we offer you this license, which gives you legal
permission to copy, distribute and/or modify the library.

To protect each distributor, we want to make it very clear that there
is no warranty for the free library. Also, if the library is modified

by someone else and passed on, the recipients should know that what
they have is not the original version, so that the original author's
reputation will not be affected by problems that might be introduced
by others.

Finally, software patents pose a constant threat to the existence of
any free program. We wish to make sure that a company cannot
effectively restrict the users of a free program by obtaining a
restrictive license from a patent holder. Therefore, we insist that
any patent license obtained for a version of the library must be
consistent with the full freedom of use specified in this license.

Most GNU software, including some libraries, is covered by the
ordinary GNU General Public License. This license, the GNU Lesser
General Public License, applies to certain designated libraries, and
is quite different from the ordinary General Public License. We use
this license for certain libraries in order to permit linking those
libraries into non-free programs.
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When a program is linked with a library, whether statically or using a
shared library, the combination of the two is legally speaking a
combined work, a derivative of the original library. The ordinary
General Public License therefore permits such linking only if the
entire combination fits its criteria of freedom. The Lesser General
Public License permits more lax criteria for linking other code with
the library.

We call this license the "Lesser" General Public License because it

does Less to protect the user's freedom than the ordinary General

Public License. It also provides other free software developers Less

of an advantage over competing non-free programs. These disadvantages
are the reason we use the ordinary General Public License for many
libraries. However, the Lesser license provides advantages in certain
special circumstances.

For example, on rare occasions, there may be a special need to
encourage the widest possible use of a certain library, so that it
becomes a de-facto standard. To achieve this, non-free programs must
be allowed to use the library. A more frequent case is that a free
library does the same job as widely used non-free libraries. In this
case, there is little to gain by limiting the free library to free

software only, so we use the Lesser General Public License.

In other cases, permission to use a particular library in non-free
programs enables a greater number of people to use a large body of
free software. For example, permission to use the GNU C Library in
non-free programs enables many more people to use the whole GNU
operating system, as well as its variant, the GNU/Linux operating
system.

Although the Lesser General Public License is Less protective of the
users' freedom, it does ensure that the user of a program that is
linked with the Library has the freedom and the wherewithal to run
that program using a modified version of the Library.

The precise terms and conditions for copying, distribution and
modification follow. Pay close attention to the difference between a
"work based on the library" and a "work that uses the library". The
former contains code derived from the library, whereas the latter must
be combined with the library in order to run. TERMS AND CONDITIONS
FOR COPYING, DISTRIBUTION AND MODIFICATION
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0. This License Agreement applies to any software library or other
program which contains a notice placed by the copyright holder or
other authorized party saying it may be distributed under the terms of
this Lesser General Public License (also called "this License"). Each
licensee is addressed as "you".

A "library" means a collection of software functions and/or data
prepared so as to be conveniently linked with application programs
(which use some of those functions and data) to form executables.

The "Library", below, refers to any such software library or work
which has been distributed under these terms. A "work based on the
Library" means either the Library or any derivative work under
copyright law: that is to say, a work containing the Library or a
portion of it, either verbatim or with modifications and/or translated
straightforwardly into another language. (Hereinafter, translation is
included without limitation in the term "modification".)

"Source code" for a work means the preferred form of the work for
making modifications to it. For a library, complete source code means
all the source code for all modules it contains, plus any associated
interface definition files, plus the scripts used to control

compilation and installation of the library.

Activities other than copying, distribution and modification are not
covered by this License; they are outside its scope. The act of

running a program using the Library is not restricted, and output from
such a program is covered only if its contents constitute a work based
on the Library (independent of the use of the Library in a tool for
writing it). Whether that is true depends on what the Library does and
what the program that uses the Library does.

1. You may copy and distribute verbatim copies of the Library's
complete source code as you receive it, in any medium, provided that
you conspicuously and appropriately publish on each copy an
appropriate copyright notice and disclaimer of warranty; keep intact
all the notices that refer to this License and to the absence of any
warranty; and distribute a copy of this License along with the

Library.

You may charge a fee for the physical act of transferring a copy, and
you may at your option offer warranty protection in exchange for a
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fee.

2. You may modify your copy or copies of the Library or any portion of
it, thus forming a work based on the Library, and copy and distribute
such modifications or work under the terms of Section 1 above,
provided that you also meet all of these conditions:

* a) The modified work must itself be a software library.

* b) You must cause the files modified to carry prominent notices
stating that you changed the files and the date of any change.

* ¢) You must cause the whole of the work to be licensed at no
charge to all third parties under the terms of this License.

* d) If a facility in the modified Library refers to a function or
a table of data to be supplied by an application program that
uses the facility, other than as an argument passed when the
facility is invoked, then you must make a good faith effort to
ensure that, in the event an application does not supply such
function or table, the facility still operates, and performs
whatever part of its purpose remains meaningful.

(For example, a function in a library to compute square roots
has a purpose that is entirely well-defined independent of the
application. Therefore, Subsection 2d requires that any
application-supplied function or table used by this function
must be optional: if the application does not supply it, the
square root function must still compute square roots.)

These requirements apply to the modified work as a whole. If
identifiable sections of that work are not derived from the Library,

and can be reasonably considered independent and separate works in
themselves, then this License, and its terms, do not apply to those
sections when you distribute them as separate works. But when you
distribute the same sections as part of a whole which is a work based
on the Library, the distribution of the whole must be on the terms of
this License, whose permissions for other licensees extend to the
entire whole, and thus to each and every part regardless of who wrote
it.

Thus, it is not the intent of this section to claim rights or contest
your rights to work written entirely by you; rather, the intent is to
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exercise the right to control the distribution of derivative or
collective works based on the Library.

In addition, mere aggregation of another work not based on the Library
with the Library (or with a work based on the Library) on a volume of

a storage or distribution medium does not bring the other work under
the scope of this License.

3. You may opt to apply the terms of the ordinary GNU General Public
License instead of this License to a given copy of the Library. To do

this, you must alter all the notices that refer to this License, so

that they refer to the ordinary GNU General Public License, version 2,
instead of to this License. (If a newer version than version 2 of the
ordinary GNU General Public License has appeared, then you can specify
that version instead if you wish.) Do not make any other change in
these notices.

Once this change is made in a given copy, it is irreversible for that
copy, so the ordinary GNU General Public License applies to all
subsequent copies and derivative works made from that copy.

This option is useful when you wish to copy part of the code of the
Library into a program that is not a library.

4. You may copy and distribute the Library (or a portion or derivative

of it, under Section 2) in object code or executable form under the

terms of Sections 1 and 2 above provided that you accompany it with

the complete corresponding machine-readable source code, which must be
distributed under the terms of Sections 1 and 2 above on a medium
customarily used for software interchange.

If distribution of object code is made by offering access to copy from
a designated place, then offering equivalent access to copy the source
code from the same place satisfies the requirement to distribute the
source code, even though third parties are not compelled to copy the
source along with the object code.

5. A program that contains no derivative of any portion of the
Library, but is designed to work with the Library by being compiled or
linked with it, is called a "work that uses the Library". Such a work,
in isolation, is not a derivative work of the Library, and therefore

falls outside the scope of this License.
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However, linking a "work that uses the Library" with the Library
creates an executable that is a derivative of the Library (because it
contains portions of the Library), rather than a "work that uses the
library". The executable is therefore covered by this License. Section
6 states terms for distribution of such executables.

When a "work that uses the Library" uses material from a header file
that is part of the Library, the object code for the work may be a
derivative work of the Library even though the source code is

not. Whether this is true is especially significant if the work can be
linked without the Library, or if the work is itself a library. The
threshold for this to be true is not precisely defined by law.

If such an object file uses only numerical parameters, data structure
layouts and accessors, and small macros and small inline functions
(ten lines or less in length), then the use of the object file is
unrestricted, regardless of whether it is legally a derivative

work. (Executables containing this object code plus portions of the
Library will still fall under Section 6.)

Otherwise, if the work is a derivative of the Library, you may
distribute the object code for the work under the terms of Section
6. Any executables containing that work also fall under Section 6,
whether or not they are linked directly with the Library itself.

6. As an exception to the Sections above, you may also combine or link
a "work that uses the Library" with the Library to produce a work
containing portions of the Library, and distribute that work under
terms of your choice, provided that the terms permit modification of
the work for the customer's own use and reverse engineering for
debugging such modifications.

You must give prominent notice with each copy of the work that the
Library is used in it and that the Library and its use are covered by
this License. You must supply a copy of this License. If the work
during execution displays copyright notices, you must include the
copyright notice for the Library among them, as well as a reference
directing the user to the copy of this License. Also, you must do one
of these things:

* a) Accompany the work with the complete corresponding
machine-readable source code for the Library including whatever
changes were used in the work (which must be distributed under
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Sections 1 and 2 above); and, if the work is an executable
linked with the Library, with the complete machine-readable
"work that uses the Library", as object code and/or source code,
so that the user can modify the Library and then relink to
produce a modified executable containing the modified

Library. (It is understood that the user who changes the
contents of definitions files in the Library will not

necessarily be able to recompile the application to use the
modified definitions.)

* b) Use a suitable shared library mechanism for linking with the
Library. A suitable mechanism is one that (1) uses at run time a
copy of the library already present on the user's computer
system, rather than copying library functions into the
executable, and (2) will operate properly with a modified
version of the library, if the user installs one, as long as the
modified version is interface-compatible with the version that
the work was made with.

* ¢) Accompany the work with a written offer, valid for at least
three years, to give the same user the materials specified in
Subsection 6a, above, for a charge no more than the cost of
performing this distribution.

* d) If distribution of the work is made by offering access to
copy from a designated place, offer equivalent access to copy
the above specified materials from the same place.

* e) Verify that the user has already received a copy of these
materials or that you have already sent this user a copy.

For an executable, the required form of the "work that uses the
Library" must include any data and utility programs needed for
reproducing the executable from it. However, as a special exception,
the materials to be distributed need not include anything that is
normally distributed (in either source or binary form) with the major
components (compiler, kernel, and so on) of the operating system on
which the executable runs, unless that component itself accompanies
the executable.

It may happen that this requirement contradicts the license

restrictions of other proprietary libraries that do not normally

accompany the operating system. Such a contradiction means you cannot
use both them and the Library together in an executable that you
distribute.

7. You may place library facilities that are a work based on the
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Library side-by-side in a single library together with other library
facilities not covered by this License, and distribute such a combined
library, provided that the separate distribution of the work based on
the Library and of the other library facilities is otherwise

permitted, and provided that you do these two things:

* a) Accompany the combined library with a copy of the same work
based on the Library, uncombined with any other library
facilities. This must be distributed under the terms of the
Sections above.

* b) Give prominent notice with the combined library of the fact
that part of it is a work based on the Library, and explaining
where to find the accompanying uncombined form of the same work.

8. You may not copy, modify, sublicense, link with, or distribute the
Library except as expressly provided under this License. Any attempt
otherwise to copy, modify, sublicense, link with, or distribute the
Library is void, and will automatically terminate your rights under
this License. However, parties who have received copies, or rights,
from you under this License will not have their licenses terminated so

long as such parties remain in full compliance.

9. You are not required to accept this License, since you have not
signed it. However, nothing else grants you permission to modify or
distribute the Library or its derivative works. These actions are
prohibited by law if you do not accept this License. Therefore, by
modifying or distributing the Library (or any work based on the
Library), you indicate your acceptance of this License to do so, and
all its terms and conditions for copying, distributing or modifying
the Library or works based on it.

10. Each time you redistribute the Library (or any work based on the
Library), the recipient automatically receives a license from the
original licensor to copy, distribute, link with or modify the Library
subject to these terms and conditions. You may not impose any further
restrictions on the recipients' exercise of the rights granted

herein. You are not responsible for enforcing compliance by third
parties with this License.

11. If, as a consequence of a court judgment or allegation of patent
infringement or for any other reason (not limited to patent issues),
conditions are imposed on you (whether by court order, agreement or
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otherwise) that contradict the conditions of this License, they do not
excuse you from the conditions of this License. If you cannot

distribute so as to satisfy simultaneously your obligations under this
License and any other pertinent obligations, then as a consequence you
may not distribute the Library at all. For example, if a patent

license would not permit royalty-free redistribution of the Library by

all those who receive copies directly or indirectly through you, then

the only way you could satisfy both it and this License would be to
refrain entirely from distribution of the Library.

If any portion of this section is held invalid or unenforceable under
any particular circumstance, the balance of the section is intended to
apply, and the section as a whole is intended to apply in other
circumstances.

It is not the purpose of this section to induce you to infringe any
patents or other property right claims or to contest validity of any
such claims; this section has the sole purpose of protecting the
integrity of the free software distribution system which is
implemented by public license practices. Many people have made
generous contributions to the wide range of software distributed
through that system in reliance on consistent application of that
system; it is up to the author/donor to decide if he or she is willing

to distribute software through any other system and a licensee cannot
impose that choice.

This section is intended to make thoroughly clear what is believed to
be a consequence of the rest of this License.

12. If the distribution and/or use of the Library is restricted in
certain countries either by patents or by copyrighted interfaces, the
original copyright holder who places the Library under this License
may add an explicit geographical distribution limitation excluding
those countries, so that distribution is permitted only in or among
countries not thus excluded. In such case, this License incorporates
the limitation as if written in the body of this License.

13. The Free Software Foundation may publish revised and/or new
versions of the Lesser General Public License from time to time. Such
new versions will be similar in spirit to the present version, but may
differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Library
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specifies a version number of this License which applies to it and

"any later version", you have the option of following the terms and
conditions either of that version or of any later version published by
the Free Software Foundation. If the Library does not specify a

license version number, you may choose any version ever published by
the Free Software Foundation.

14. If you wish to incorporate parts of the Library into other free
programs whose distribution conditions are incompatible with these,
write to the author to ask for permission. For software which is
copyrighted by the Free Software Foundation, write to the Free
Software Foundation; we sometimes make exceptions for this. Our
decision will be guided by the two goals of preserving the free status
of all derivatives of our free software and of promoting the sharing
and reuse of software generally.

NO WARRANTY

15. BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO
WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE

LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS
AND/OR OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT WARRANTY OF
ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO,

THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE
LIBRARY IS WITH YOU. SHOULD THE LIBRARY PROVE DEFECTIVE, YOU ASSUME

THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

16. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN
WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY
AND/OR REDISTRIBUTE THE LIBRARY AS PERMITTED ABOVE, BE LIABLE TO YOU
FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR
CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE
LIBRARY (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING
RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A
FAILURE OF THE LIBRARY TO OPERATE WITH ANY OTHER SOFTWARE), EVEN IF
SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES. END OF TERMS AND CONDITIONS.

MariaDB Server
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The GPL license

GNU GENERAL PUBLIC LICENSE
Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc.
59 Temple Place - Suite 330, Boston, MA 02111-1307, USA

Everyone is permitted to copy and distribute verbatim copies
of this license document, but changing it is not allowed.

Preamble

The licenses for most software are designed to take away your freedom
to share and change it. By contrast, the GNU General Public License is
intended to guarantee your freedom to share and change free
software--to make sure the software is free for all its users. This

General Public License applies to most of the Free Software

Foundation's software and to any other program whose authors commit to
using it. (Some other Free Software Foundation software is covered by
the GNU Library General Public License instead.) You can apply it to

your programs, too.

When we speak of free software, we are referring to freedom, not price.
Our General Public Licenses are designed to make sure that you have
the freedom to distribute copies of free software (and charge for this
service if you wish), that you receive source code or can get it if you
want it, that you can change the software or use pieces of it in new

free programs; and that you know you can do these things.

To protect your rights, we need to make restrictions that forbid anyone
to deny you these rights or to ask you to surrender the rights. These
restrictions translate to certain responsibilities for you if you

distribute copies of the software, or if you modify it.

For example, if you distribute copies of such a program, whether gratis
or for a fee, you must give the recipients all the rights that you

have. You must make sure that they, too, receive or can get the source
code. And you must show them these terms so they know their rights.

We protect your rights with two steps: (1) copyright the software, and
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(2) offer you this license which gives you legal permission to copy,
distribute and/or modify the software.

Also, for each author's protection and ours, we want to make certain

that everyone understands that there is no warranty for this free
software. If the software is modified by someone else and passed on, we
want its recipients to know that what they have is not the original, so

that any problems introduced by others will not reflect on the original
authors' reputations.

Finally, any free program is threatened constantly by software patents.
We wish to avoid the danger that redistributors of a free program will
individually obtain patent licenses, in effect making the program
proprietary. To prevent this, we have made it clear that any patent
must be licensed for everyone's free use or not licensed at all.

The precise terms and conditions for copying, distribution and
modification follow.

GNU GENERAL PUBLIC LICENSE

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION
0. This License applies to any program or other work which contains a

notice placed by the copyright holder saying it may be distributed

under the terms of this General Public License. The "Program",

below, refers to any such program or work, and a "work based on

the Program" means either the Program or any derivative work under

copyright law: that is to say, a work containing the Program or a

portion of it, either verbatim or with modifications and/or

translated into another language. (Hereinafter, translation is

included without limitation in the term "modification".) Each

licensee is addressed as "you".

Activities other than copying, distribution and modification are

not covered by this License; they are outside its scope. The act

of running the Program is not restricted, and the output from the
Program is covered only if its contents constitute a work based on
the Program (independent of having been made by running the
Program). Whether that is true depends on what the Program does.

1. You may copy and distribute verbatim copies of the Program's
source code as you receive it, in any medium, provided that you
conspicuously and appropriately publish on each copy an appropriate
copyright notice and disclaimer of warranty; keep intact all the
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notices that refer to this License and to the absence of any
warranty; and give any other recipients of the Program a copy of
this License along with the Program.

You may charge a fee for the physical act of transferring a copy,
and you may at your option offer warranty protection in exchange
for a fee.

2. You may modify your copy or copies of the Program or any portion
of it, thus forming a work based on the Program, and copy and
distribute such modifications or work under the terms of Section 1
above, provided that you also meet all of these conditions:

a. You must cause the modified files to carry prominent notices
stating that you changed the files and the date of any change.

b. You must cause any work that you distribute or publish, that
in whole or in part contains or is derived from the Program
or any part thereof, to be licensed as a whole at no charge
to all third parties under the terms of this License.

c. If the modified program normally reads commands interactively
when run, you must cause it, when started running for such
interactive use in the most ordinary way, to print or display
an announcement including an appropriate copyright notice and
a notice that there is no warranty (or else, saying that you
provide a warranty) and that users may redistribute the
program under these conditions, and telling the user how to
view a copy of this License. (Exception: if the Program
itself is interactive but does not normally print such an
announcement, your work based on the Program is not required
to print an announcement.)

These requirements apply to the modified work as a whole. If
identifiable sections of that work are not derived from the

Program, and can be reasonably considered independent and separate
works in themselves, then this License, and its terms, do not

apply to those sections when you distribute them as separate

works. But when you distribute the same sections as part of a

whole which is a work based on the Program, the distribution of

the whole must be on the terms of this License, whose permissions
for other licensees extend to the entire whole, and thus to each

and every part regardless of who wrote it.
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Thus, it is not the intent of this section to claim rights or
contest your rights to work written entirely by you; rather, the
intent is to exercise the right to control the distribution of
derivative or collective works based on the Program.

In addition, mere aggregation of another work not based on the
Program with the Program (or with a work based on the Program) on
a volume of a storage or distribution medium does not bring the
other work under the scope of this License.

3. You may copy and distribute the Program (or a work based on it,
under Section 2) in object code or executable form under the terms
of Sections 1 and 2 above provided that you also do one of the
following:

a. Accompany it with the complete corresponding machine-readable
source code, which must be distributed under the terms of
Sections 1 and 2 above on a medium customarily used for
software interchange; or,

b. Accompany it with a written offer, valid for at least three
years, to give any third-party, for a charge no more than your
cost of physically performing source distribution, a complete
machine-readable copy of the corresponding source code, to be
distributed under the terms of Sections 1 and 2 above on a
medium customarily used for software interchange; or,

¢. Accompany it with the information you received as to the offer
to distribute corresponding source code. (This alternative is
allowed only for noncommercial distribution and only if you
received the program in object code or executable form with
such an offer, in accord with Subsection b above.)

The source code for a work means the preferred form of the work for
making modifications to it. For an executable work, complete

source code means all the source code for all modules it contains,
plus any associated interface definition files, plus the scripts

used to control compilation and installation of the executable.
However, as a special exception, the source code distributed need
not include anything that is normally distributed (in either

source or binary form) with the major components (compiler,

kernel, and so on) of the operating system on which the executable
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runs, unless that component itself accompanies the executable.

If distribution of executable or object code is made by offering
access to copy from a designated place, then offering equivalent
access to copy the source code from the same place counts as
distribution of the source code, even though third parties are not
compelled to copy the source along with the object code.

. You may not copy, modify, sublicense, or distribute the Program

except as expressly provided under this License. Any attempt
otherwise to copy, modify, sublicense or distribute the Program is
void, and will automatically terminate your rights under this
License. However, parties who have received copies, or rights,
from you under this License will not have their licenses
terminated so long as such parties remain in full compliance.

5. You are not required to accept this License, since you have not

signed it. However, nothing else grants you permission to modify
or distribute the Program or its derivative works. These actions
are prohibited by law if you do not accept this License.
Therefore, by modifying or distributing the Program (or any work
based on the Program), you indicate your acceptance of this
License to do so, and all its terms and conditions for copying,
distributing or modifying the Program or works based on it.

6. Each time you redistribute the Program (or any work based on the

Program), the recipient automatically receives a license from the
original licensor to copy, distribute or modify the Program

subject to these terms and conditions. You may not impose any
further restrictions on the recipients' exercise of the rights
granted herein. You are not responsible for enforcing compliance
by third parties to this License.

7. If, as a consequence of a court judgment or allegation of patent

infringement or for any other reason (not limited to patent
issues), conditions are imposed on you (whether by court order,
agreement or otherwise) that contradict the conditions of this
License, they do not excuse you from the conditions of this
License. If you cannot distribute so as to satisfy simultaneously
your obligations under this License and any other pertinent
obligations, then as a consequence you may not distribute the
Program at all. For example, if a patent license would not permit
royalty-free redistribution of the Program by all those who
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receive copies directly or indirectly through you, then the only
way you could satisfy both it and this License would be to refrain
entirely from distribution of the Program.

If any portion of this section is held invalid or unenforceable
under any particular circumstance, the balance of the section is
intended to apply and the section as a whole is intended to apply
in other circumstances.

It is not the purpose of this section to induce you to infringe any
patents or other property right claims or to contest validity of

any such claims; this section has the sole purpose of protecting
the integrity of the free software distribution system, which is
implemented by public license practices. Many people have made
generous contributions to the wide range of software distributed
through that system in reliance on consistent application of that
system; it is up to the author/donor to decide if he or she is
willing to distribute software through any other system and a
licensee cannot impose that choice.

This section is intended to make thoroughly clear what is believed
to be a consequence of the rest of this License.

8. If the distribution and/or use of the Program is restricted in
certain countries either by patents or by copyrighted interfaces,
the original copyright holder who places the Program under this
License may add an explicit geographical distribution limitation
excluding those countries, so that distribution is permitted only
in or among countries not thus excluded. In such case, this
License incorporates the limitation as if written in the body of
this License.

9. The Free Software Foundation may publish revised and/or new
versions of the General Public License from time to time. Such
new versions will be similar in spirit to the present version, but
may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the
Program specifies a version number of this License which applies
to it and "any later version", you have the option of following

the terms and conditions either of that version or of any later
version published by the Free Software Foundation. If the Program
does not specify a version number of this License, you may choose
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any version ever published by the Free Software Foundation.

10. If you wish to incorporate parts of the Program into other free

programs whose distribution conditions are different, write to the
author to ask for permission. For software which is copyrighted
by the Free Software Foundation, write to the Free Software
Foundation; we sometimes make exceptions for this. Our decision
will be guided by the two goals of preserving the free status of

all derivatives of our free software and of promoting the sharing
and reuse of software generally.

NO WARRANTY

11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO

WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE
LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT
HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM "AS IS" WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE
QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE
PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY
SERVICING, REPAIR OR CORRECTION.

12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN

WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY
MODIFY AND/OR REDISTRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE
LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL,
INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR
INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF
DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU
OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY
OTHER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS

How to Apply These Terms to Your New Programs

If you develop a new program, and you want it to be of the greatest

possible use to the public, the best way to achieve this is to make it

free software which everyone can redistribute and change under these

terms.
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To do so, attach the following notices to the program. It is safest to
attach them to the start of each source file to most effectively convey
the exclusion of warranty; and each file should have at least the
"copyright" line and a pointer to where the full notice is found.

ONE LINE TO GIVE THE PROGRAM'S NAME AND A BRIEF IDEA OF WHAT IT DOES.

Copyright (C) YYYY NAME OF AUTHOR

This program is free software; you can redistribute it and/or modify
it under the terms of the GNU General Public License as published by
the Free Software Foundation; either version 2 of the License, or
(at your option) any later version.

This program is distributed in the hope that it will be useful,

but WITHOUT ANY WARRANTY; without even the implied warranty of
MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the
GNU General Public License for more details.

You should have received a copy of the GNU General Public License
along with this program; if not, write to the Free Software
Foundation, Inc., 59 Temple Place - Suite 330, Boston, MA 02111-1307, USA.

Also add information on how to contact you by electronic and paper mail.

If the program is interactive, make it output a short notice like this
when it starts in an interactive mode:

Gnomovision version 69, Copyright (C) 19YY NAME OF AUTHOR

Gnomovision comes with ABSOLUTELY NO WARRANTY; for details type “show w'.

This is free software, and you are welcome to redistribute it
under certain conditions; type “show c' for details.

The hypothetical commands “show w' and “show c' should show the
appropriate parts of the General Public License. Of course, the

commands you use may be called something other than “show w' and "show
'; they could even be mouse-clicks or menu items--whatever suits your
program.

You should also get your employer (if you work as a programmer) or your
school, if any, to sign a "copyright disclaimer" for the program, if
necessary. Here is a sample; alter the names:
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Yoyodyne, Inc., hereby disclaims all copyright interest in the program
*Gnomovision' (which makes passes at compilers) written by James Hacker.

SIGNATURE OF TY COON, 1 April 1989
Ty Coon, President of Vice

This General Public License does not permit incorporating your program
into proprietary programs. If your program is a subroutine library,

you may consider it more useful to permit linking proprietary
applications with the library. If this is what you want to do, use the
GNU Library General Public License instead of this License.

Node.js
Node.js is licensed for use as follows:

mm

Copyright Node.js contributors. All rights reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the "Software"), to

deal in the Software without restriction, including without limitation the
rights to use, copy, modify, merge, publish, distribute, sublicense, and/or
sell copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in
all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING

FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS
IN THE SOFTWARE.

mm

This license applies to parts of Node.js originating from the
https://github.com/joyent/node repository:

mm
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Copyright Joyent, Inc. and other Node contributors. All rights reserved.
Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the "Software"), to

deal in the Software without restriction, including without limitation the
rights to use, copy, modify, merge, publish, distribute, sublicense, and/or
sell copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in
all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING

FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS
IN THE SOFTWARE.

mm

The Node.js license applies to all parts of Node.js that are not externally
maintained libraries.

The externally maintained libraries used by Node.js are:

- c-ares, located at deps/cares, is licensed as follows:
Copyright 1998 by the Massachusetts Institute of Technology.
Copyright (C) 2007-2013 by Daniel Stenberg

Permission to use, copy, modify, and distribute this
software and its documentation for any purpose and without
fee is hereby granted, provided that the above copyright
notice appear in all copies and that both that copyright
notice and this permission notice appear in supporting
documentation, and that the name of M.LT. not be used in
advertising or publicity pertaining to distribution of the
software without specific, written prior permission.

M.LT. makes no representations about the suitability of
this software for any purpose. It is provided "as is"
without express or implied warranty.

mm
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- HTTP Parser, located at deps/http_parser, is licensed as follows:

mm

http_parser.c is based on src/http/ngx_http_parse.c from NGINX copyright
Igor Sysoev.

Additional changes are licensed under the same terms as NGINX and
copyright Joyent, Inc. and other Node contributors. All rights reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the "Software"), to

deal in the Software without restriction, including without limitation the
rights to use, copy, modify, merge, publish, distribute, sublicense, and/or
sell copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in
all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING

FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS
IN THE SOFTWARE.

mm

- ICU, located at deps/icu, is licensed as follows:

mm

ICU License - ICU 1.8.1 and later

COPYRIGHT AND PERMISSION NOTICE

Copyright (c) 1995-2016 International Business Machines Corporation and others

All rights reserved.

Permission is hereby granted, free of charge, to any person obtaining
a copy of this software and associated documentation files (the
"Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish,
distribute, and/or sell copies of the Software, and to permit persons
to whom the Software is furnished to do so, provided that the above
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copyright notice(s) and this permission notice appear in all copies of
the Software and that both the above copyright notice(s) and this
permission notice appear in supporting documentation.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND,
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT
OF THIRD PARTY RIGHTS. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR
HOLDERS INCLUDED IN THIS NOTICE BE LIABLE FOR ANY CLAIM, OR ANY

SPECIAL INDIRECT OR CONSEQUENTIAL DAMAGES, OR ANY DAMAGES WHATSOEVER
RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF
CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN
CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

Except as contained in this notice, the name of a copyright holder
shall not be used in advertising or otherwise to promote the sale, use
or other dealings in this Software without prior written authorization
of the copyright holder.

All trademarks and registered trademarks mentioned herein are the
property of their respective owners.

Third-Party Software Licenses

This section contains third-party software notices and/or additional
terms for licensed third-party software components included within ICU
libraries.

1. Unicode Data Files and Software

COPYRIGHT AND PERMISSION NOTICE

Copyright © 1991-2016 Unicode, Inc. All rights reserved.
Distributed under the Terms of Use in
http://www.unicode.org/copyright.html.

Permission is hereby granted, free of charge, to any person obtaining

a copy of the Unicode data files and any associated documentation

(the "Data Files") or Unicode software and any associated documentation
(the "Software") to deal in the Data Files or Software

without restriction, including without limitation the rights to use,
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copy, modify, merge, publish, distribute, and/or sell copies of

the Data Files or Software, and to permit persons to whom the Data Files
or Software are furnished to do so, provided that

(a) this copyright and permission notice appear with all copies

of the Data Files or Software,

(b) this copyright and permission notice appear in associated
documentation, and

(c) there is clear notice in each modified Data File or in the Software

as well as in the documentation associated with the Data File(s) or
Software that the data or software has been modified.

THE DATA FILES AND SOFTWARE ARE PROVIDED "AS IS", WITHOUT WARRANTY OF
ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT OF THIRD PARTY RIGHTS.

IN NO EVENT SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS
NOTICE BE LIABLE FOR ANY CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL
DAMAGES, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE,

DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER
TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR
PERFORMANCE OF THE DATA FILES OR SOFTWARE.

Except as contained in this notice, the name of a copyright holder
shall not be used in advertising or otherwise to promote the sale,
use or other dealings in these Data Files or Software without prior
written authorization of the copyright holder.

2. Chinese/Japanese Word Break Dictionary Data (cjdict.txt)

#  The Google Chrome software developed by Google is licensed under
# the BSD license. Other software included in this distribution is

# provided under other licenses, as set forth below.

#
# The BSD License

# http://opensource.org/licenses/bsd-license.php

# Copyright (C) 2006-2008, Google Inc.

#

# All rights reserved.

#

# Redistribution and use in source and binary forms, with or without

# modification, are permitted provided that the following conditions are met:
#

# Redistributions of source code must retain the above copyright notice,
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# this list of conditions and the following disclaimer.

# Redistributions in binary form must reproduce the above

# copyright notice, this list of conditions and the following

# disclaimer in the documentation and/or other materials provided with

# the distribution.

# Neither the name of Google Inc. nor the names of its

# contributors may be used to endorse or promote products derived from

# this software without specific prior written permission.

#

#

# THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND

# CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES,

# INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF

# MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE

# DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
# LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR

# CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
# SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR

# BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF

# LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
# NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
# SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

#

#

# The word list in cjdict.txt are generated by combining three word lists

# listed below with further processing for compound word breaking. The

# frequency is generated with an iterative training against Google web

# corpora.

* Libtabe (Chinese)
- https://sourceforge.net/project/?group_id=1519
- Its license terms and conditions are shown below.

* IPADIC (Japanese)
- http://chasen.aist-nara.ac.jp/chasen/distribution.html
- Its license terms and conditions are shown below.

#
#[*

# * Copyrighy (c) 1999 TaBE Project.

# * Copyright (c) 1999 Pai-Hsiang Hsiao.
# * All rights reserved.
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*

Redistribution and use in source and binary forms, with or without
* modification, are permitted provided that the following conditions
* are met:

* . Redistributions of source code must retain the above copyright

* notice, this list of conditions and the following disclaimer.

* . Redistributions in binary form must reproduce the above copyright

* notice, this list of conditions and the following disclaimer in

* the documentation and/or other materials provided with the

*  distribution.

* . Neither the name of the TaBE Project nor the names of its

*  contributors may be used to endorse or promote products derived

*  from this software without specific prior written permission.

*

* THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
* "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT

* LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS

* FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE

* REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,

* INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES

* (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
* SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)

* HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
* STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)

* ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
* OF THE POSSIBILITY OF SUCH DAMAGE.

*/
/*
* Copyright (c) 1999 Computer Systems and Communication Lab,
* Institute of Information Science, Academia
* Sinica. All rights reserved.

*

Redistribution and use in source and binary forms, with or without

*

modification, are permitted provided that the following conditions
* are met:

* . Redistributions of source code must retain the above copyright

* notice, this list of conditions and the following disclaimer.

* . Redistributions in binary form must reproduce the above copyright
* notice, this list of conditions and the following disclaimer in

* the documentation and/or other materials provided with the
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*  distribution.

* . Neither the name of the Computer Systems and Communication Lab

* nor the names of its contributors may be used to endorse or

* promote products derived from this software without specific

*  prior written permission.

*

* THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
* "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT

* LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS

* FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE

* REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,

* INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES

* (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
* SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)

* HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
* STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)

* ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED

* OF THE POSSIBILITY OF SUCH DAMAGE.

*/

Copyright 1996 Chih-Hao Tsai @ Beckman Institute,
University of Illinois
c-tsai4@uiuc.edu http://casper.beckman.uiuc.edu/~c-tsai4

Copyright 2000, 2001, 2002, 2003 Nara Institute of Science
and Technology. All Rights Reserved.

Use, reproduction, and distribution of this software is permitted.
Any copy of this software, whether in its original form or modified,
must include both the above copyright notice and the following
paragraphs.

Nara Institute of Science and Technology (NAIST),

the copyright holders, disclaims all warranties with regard to this
software, including all implied warranties of merchantability and
fitness, in no event shall NAIST be liable for

any special, indirect or consequential damages or any damages
whatsoever resulting from loss of use, data or profits, whether in an
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action of contract, negligence or other tortuous action, arising out
of or in connection with the use or performance of this software.

A large portion of the dictionary entries
originate from ICOT Free Software. The following conditions for ICOT
Free Software applies to the current dictionary as well.

Each User may also freely distribute the Program, whether in its
original form or modified, to any third party or parties, PROVIDED

that the provisions of Section 3 ("NO WARRANTY") will ALWAYS appear
on, or be attached to, the Program, which is distributed substantially

in the same form as set out herein and that such intended

distribution, if actually made, will neither violate or otherwise
contravene any of the laws and regulations of the countries having
jurisdiction over the User or the intended distribution itself.

NO WARRANTY

The program was produced on an experimental basis in the course of the
research and development conducted during the project and is provided
to users as so produced on an experimental basis. Accordingly, the
program is provided without any warranty whatsoever, whether express,
implied, statutory or otherwise. The term "warranty" used herein
includes, but is not limited to, any warranty of the quality,

performance, merchantability and fitness for a particular purpose of

the program and the nonexistence of any infringement or violation of

any right of any third party.

Each user of the program will agree and understand, and be deemed to
have agreed and understood, that there is no warranty whatsoever for
the program and, accordingly, the entire risk arising from or

otherwise connected with the program is assumed by the user.

Therefore, neither ICOT, the copyright holder, or any other
organization that participated in or was otherwise related to the
development of the program and their respective officials, directors,
officers and other employees shall be held liable for any and all
damages, including, without limitation, general, special, incidental
and consequential damages, arising out of or otherwise in connection
with the use or inability to use the program or any product, material
or result produced or otherwise obtained by using the program,
regardless of whether they have been advised of, or otherwise had
knowledge of, the possibility of such damages at any time during the
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project or thereafter. Each user will be deemed to have agreed to the
foregoing by his or her commencement of use of the program. The term
"use" as used herein includes, but is not limited to, the use,

modification, copying and distribution of the program and the

production of secondary products from the program.

In the case where the program, whether in its original form or
modified, was distributed or delivered to or received by a user from
any person, organization or entity other than ICOT, unless it makes or
grants independently of ICOT any specific warranty to the user in
writing, such person, organization or entity, will also be exempted
from and not be held liable to the user for any such damages as noted
above as far as the program is concerned.
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3. Lao Word Break Dictionary Data (laodict.txt)

# Copyright (c) 2013 International Business Machines Corporation

# and others. All Rights Reserved.

#

# Project: http://code.google.com/p/lao-dictionary/

# Dictionary: http://lao-dictionary.googlecode.com/git/Lao-Dictionary.txt

# License: http://lao-dictionary.googlecode.com/git/Lao-Dictionary-LICENSE. txt
# (copied below)

#

# This file is derived from the above dictionary, with slight

# modifications.

H

Copyright (C) 2013 Brian Eugene Wilson, Robert Martin Campbell.
All rights reserved.

Redistribution and use in source and binary forms, with or without
maodification,
are permitted provided that the following conditions are met:

H O OHF OH OH K R

#

# Redistributions of source code must retain the above copyright notice, this
# list of conditions and the following disclaimer. Redistributions in

# binary form must reproduce the above copyright notice, this list of

# conditions and the following disclaimer in the documentation and/or

# other materials provided with the distribution.

#
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#

# THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
# "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT

# LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS

# FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE

# COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT,

# INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES

# (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
# SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)

# HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
# STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)

# ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED

# OF THE POSSIBILITY OF SUCH DAMAGE.

4. Burmese Word Break Dictionary Data (burmesedict.txt)

Copyright (c) 2014 International Business Machines Corporation
and others. All Rights Reserved.

This list is part of a project hosted at:
github.com/kanyawtech/myanmar-karen-word-lists

H OH OH OHF O R

H*

Copyright (c) 2013, LeRoy Benjamin Sharon
All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions
are met: Redistributions of source code must retain the above
copyright notice, this list of conditions and the following
disclaimer. Redistributions in binary form must reproduce the
above copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials provided
with the distribution.

Neither the name Myanmar Karen Word Lists, nor the names of its
contributors may be used to endorse or promote products derived
from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND
CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF

HOH O O OH OH OH OH WK W O OHOHOH W WK WK WK K
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MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,

EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF
THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.

HOH O O OH OH OH OB OB R

5. Time Zone Database

ICU uses the public domain data and code derived from Time Zone
Database for its time zone support. The ownership of the TZ database
is explained in BCP 175: Procedure for Maintaining the Time Zone
Database section 7.

# 7. Database Ownership

The TZ database itself is not an IETF Contribution or an IETF
document. Rather it is a pre-existing and regularly updated work
that is in the public domain, and is intended to remain in the

public domain. Therefore, BCPs 78 [RFC5378] and 79 [RFC3979] do
not apply to the TZ Database or contributions that individuals make
to it. Should any claims be made and substantiated against the TZ
Database, the organization that is providing the IANA

Considerations defined in this RFC, under the memorandum of
understanding with the IETF, currently ICANN, may act in accordance
with all competent court orders. No ownership claims will be made
by ICANN or the IETF Trust on the database or the code. Any person
making a contribution to the database or code waives all rights to

H OB O O OH OFH O OH OH OH WK OH K K

future claims in that contribution or in the TZ Database.

mm

- libuv, located at deps/uy, is licensed as follows:

mm

libuv is part of the Node project: http://nodejs.org/
libuv may be distributed alone under Node's license:
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Copyright Joyent, Inc. and other Node contributors. All rights reserved.
Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the "Software"), to

deal in the Software without restriction, including without limitation the
rights to use, copy, modify, merge, publish, distribute, sublicense, and/or
sell copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in
all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING

FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS
IN THE SOFTWARE.

This license applies to all parts of libuv that are not externally
maintained libraries.

The externally maintained libraries used by libuv are:
- tree.h (from FreeBSD), copyright Niels Provos. Two clause BSD license.
- inet_pton and inet_ntop implementations, contained in src/inet.c, are
copyright the Internet Systems Consortium, Inc., and licensed under the ISC

license.

- stdint-msvc2008.h (from msinttypes), copyright Alexander Chemeris. Three
clause BSD license.

- pthread-fixes.h, pthread-fixes.c, copyright Google Inc. and Sony Mobile
Communications AB. Three clause BSD license.

- android-ifaddrs.h, android-ifaddrs.c, copyright Berkeley Software Design
Inc, Kenneth MacKay and Emergya (Cloud4all, FP7/2007-2013, grant agreement
n°® 289016). Three clause BSD license.

mm
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- OpenSSL, located at deps/openssl|, is licensed as follows:

mm

Copyright (c) 1998-2016 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions
are met:

1. Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in

the documentation and/or other materials provided with the
distribution.

3. All advertising materials mentioning features or use of this
software must display the following acknowledgment:

"This product includes software developed by the OpenSSL Project
for use in the OpenSSL Toolkit. (http://www.openssl.org/)"

4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to
endorse or promote products derived from this software without

prior written permission. For written permission, please contact
openssl-core@openssl.org.

5. Products derived from this software may not be called "OpenSSL"
nor may "OpenSSL" appear in their names without prior written
permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following
acknowledgment:

"This product includes software developed by the OpenSSL Project
for use in the OpenSSL Toolkit (http://www.openssl.org/)"

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT " "AS IS" AND ANY
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR
ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT

NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;

LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
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HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)

ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes cryptographic software written by Eric Young
(eay@cryptsoft.com). This product includes software written by Tim
Hudson (fh@cryptsoft.com).

mm

- Punycode.js, located at lib/punycode.js, is licensed as follows:

mm

Copyright Mathias Bynens <https://mathiasbynens.be/>

Permission is hereby granted, free of charge, to any person obtaining
a copy of this software and associated documentation files (the
"Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish,
distribute, sublicense, and/or sell copies of the Software, and to
permit persons to whom the Software is furnished to do so, subject to
the following conditions:

The above copyright notice and this permission notice shall be
included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND,
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND

NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE
LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION
OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION
WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

mm

- V8, located at deps/v8, is licensed as follows:

mm

This license applies to all parts of V8 that are not externally
maintained libraries. The externally maintained libraries used by V8
are:

- PCRE test suite, located in
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test/mjsunit/third_party/regexp-pcre/regexp-pcre.js. This is based on the
test suite from PCRE-7.3, which is copyrighted by the University

of Cambridge and Google, Inc. The copyright notice and license

are embedded in regexp-pcre.js.

- Layout tests, located in test/mjsunit/third_party/object-keys. These are
based on layout tests from webkit.org which are copyrighted by
Apple Computer, Inc. and released under a 3-clause BSD license.

- Strongtalk assembler, the basis of the files assembler-arm-inl.h,
assembler-arm.cc, assembler-arm.h, assembler-ia32-inl.h,
assembler-ia32.cc, assembler-ia32.h, assembler-x64-inl.h,
assembler-x64.cc, assembler-x64.h, assembler-mips-inl.h,
assembler-mips.cc, assembler-mips.h, assembler.cc and assembler.h.
This code is copyrighted by Sun Microsystems Inc. and released
under a 3-clause BSD license.

- Valgrind client API header, located at third_party/valgrind/valgrind.h
This is release under the BSD license.

These libraries have their own licenses; we recommend you read them,
as their terms may differ from the terms below.

Further license information can be found in LICENSE files located in
sub-directories.

Copyright 2014, the V8 project authors. All rights reserved.
Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are
met:

* Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above
copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials provided
with the distribution.

* Neither the name of Google Inc. nor the names of its
contributors may be used to endorse or promote products derived
from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
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LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

mm

- zlib, located at deps/zlib, is licensed as follows:
zlib.h -- interface of the 'zlib' general purpose compression library
version 1.2.8, April 28th, 2013

Copyright (C) 1995-2013 Jean-loup Gailly and Mark Adler

This software is provided 'as-is', without any express or implied
warranty. In no event will the authors be held liable for any damages
arising from the use of this software.

Permission is granted to anyone to use this software for any purpose,
including commercial applications, and to alter it and redistribute it
freely, subject to the following restrictions:

1. The origin of this software must not be misrepresented; you must not
claim that you wrote the original software. If you use this software

in a product, an acknowledgment in the product documentation would be
appreciated but is not required.

2. Altered source versions must be plainly marked as such, and must not be
misrepresented as being the original software.

3. This notice may not be removed or altered from any source distribution.

Jean-loup Gailly Mark Adler
jloup@gzip.org madler@alumni.caltech.edu

mm

- npm, located at deps/npm, is licensed as follows:

mm

The npm application
Copyright (c) npm, Inc. and Contributors
Licensed on the terms of The Artistic License 2.0
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Node package dependencies of the npm application
Copyright (c) their respective copyright owners
Licensed on their respective license terms

The npm public registry at https://registry.npmjs.org

and the npm website at https://www.npmjs.com

Operated by npm, Inc.

Use governed by terms published on https://www.npmjs.com

"Node.js"
Trademark Joyent, Inc., https://joyent.com
Neither npm nor npm, Inc. are affiliated with Joyent, Inc.

The Node.js application
Project of Node Foundation, https://nodejs.org

The npm Logo
Copyright (c) Mathias Pettersson and Brian Hammond

"Gubblebum Blocky" typeface
Copyright (c) Tjarda Koster, https://jelloween.deviantart.com
Used with permission

The Artistic License 2.0

Copyright (c) 2000-2006, The Perl Foundation.

Everyone is permitted to copy and distribute verbatim copies
of this license document, but changing it is not allowed.

Preamble

This license establishes the terms under which a given free software
Package may be copied, modified, distributed, and/or redistributed.
The intent is that the Copyright Holder maintains some artistic
control over the development of that Package while still keeping the
Package available as open source and free software.

You are always permitted to make arrangements wholly outside of this
license directly with the Copyright Holder of a given Package. If the
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terms of this license do not permit the full use that you propose to
make of the Package, you should contact the Copyright Holder and seek
a different licensing arrangement.

Definitions

"Copyright Holder" means the individual(s) or organization(s)
named in the copyright notice for the entire Package.

"Contributor" means any party that has contributed code or other
material to the Package, in accordance with the Copyright Holder's
procedures.

"You" and "your" means any person who would like to copy,
distribute, or modify the Package.

"Package" means the collection of files distributed by the
Copyright Holder, and derivatives of that collection and/or of
those files. A given Package may consist of either the Standard
Version, or a Modified Version.

"Distribute" means providing a copy of the Package or making it
accessible to anyone else, or in the case of a company or
organization, to others outside of your company or organization.

"Distributor Fee" means any fee that you charge for Distributing
this Package or providing support for this Package to another
party. It does not mean licensing fees.

"Standard Version" refers to the Package if it has not been
modified, or has been modified only in ways explicitly requested
by the Copyright Holder.

"Modified Version" means the Package, if it has been changed, and
such changes were not explicitly requested by the Copyright
Holder.

"Original License" means this Artistic License as Distributed with
the Standard Version of the Package, in its current version or as
it may be modified by The Perl Foundation in the future.

"Source" form means the source code, documentation source, and
configuration files for the Package.
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"Compiled" form means the compiled bytecode, object code, binary,
or any other form resulting from mechanical transformation or
translation of the Source form.

Permission for Use and Modification Without Distribution

(1) You are permitted to use the Standard Version and create and use
Modified Versions for any purpose without restriction, provided that
you do not Distribute the Modified Version.

Permissions for Redistribution of the Standard Version

(2) You may Distribute verbatim copies of the Source form of the
Standard Version of this Package in any medium without restriction,
either gratis or for a Distributor Fee, provided that you duplicate

all of the original copyright notices and associated disclaimers. At
your discretion, such verbatim copies may or may not include a
Compiled form of the Package.

(3) You may apply any bug fixes, portability changes, and other
modifications made available from the Copyright Holder. The resulting
Package will still be considered the Standard Version, and as such

will be subject to the Original License.

Distribution of Modified Versions of the Package as Source

(4) You may Distribute your Modified Version as Source (either gratis
or for a Distributor Fee, and with or without a Compiled form of the
Modified Version) provided that you clearly document how it differs
from the Standard Version, including, but not limited to, documenting
any non-standard features, executables, or modules, and provided that
you do at least ONE of the following:

(a) make the Modified Version available to the Copyright Holder
of the Standard Version, under the Original License, so that the
Copyright Holder may include your modifications in the Standard

Version.

(b) ensure that installation of your Modified Version does not
prevent the user installing or running the Standard Version. In
addition, the Modified Version must bear a name that is different
from the name of the Standard Version.
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(c) allow anyone who receives a copy of the Modified Version to
make the Source form of the Modified Version available to others
under

(i) the Original License or

(i) a license that permits the licensee to freely copy,
modify and redistribute the Modified Version using the same
licensing terms that apply to the copy that the licensee
received, and requires that the Source form of the Modified
Version, and of any works derived from it, be made freely
available in that license fees are prohibited but Distributor
Fees are allowed.

Distribution of Compiled Forms of the Standard Version
or Modified Versions without the Source

(5) You may Distribute Compiled forms of the Standard Version without
the Source, provided that you include complete instructions on how to
get the Source of the Standard Version. Such instructions must be
valid at the time of your distribution. If these instructions, at any

time while you are carrying out such distribution, become invalid, you
must provide new instructions on demand or cease further distribution.
If you provide valid instructions or cease distribution within thirty

days after you become aware that the instructions are invalid, then

you do not forfeit any of your rights under this license.

(6) You may Distribute a Modified Version in Compiled form without
the Source, provided that you comply with Section 4 with respect to
the Source of the Modified Version.

Aggregating or Linking the Package

(7) You may aggregate the Package (either the Standard Version or
Modified Version) with other packages and Distribute the resulting
aggregation provided that you do not charge a licensing fee for the
Package. Distributor Fees are permitted, and licensing fees for other
components in the aggregation are permitted. The terms of this license
apply to the use and Distribution of the Standard or Modified Versions
as included in the aggregation.

(8) You are permitted to link Modified and Standard Versions with
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other works, to embed the Package in a larger work of your own, or to
build stand-alone binary or bytecode versions of applications that
include the Package, and Distribute the result without restriction,
provided the result does not expose a direct interface to the Package.

Items That are Not Considered Part of a Modified Version

(9) Works (including, but not limited to, modules and scripts) that
merely extend or make use of the Package, do not, by themselves, cause
the Package to be a Modified Version. In addition, such works are not
considered parts of the Package itself, and are not subject to the

terms of this license.

General Provisions

(10) Any use, modification, and distribution of the Standard or
Modified Versions is governed by this Artistic License. By using,
modifying or distributing the Package, you accept this license. Do not
use, modify, or distribute the Package, if you do not accept this
license.

(11) If your Modified Version has been derived from a Modified

Version made by someone other than you, you are nevertheless required
to ensure that your Modified Version complies with the requirements of
this license.

(12) This license does not grant you the right to use any trademark,
service mark, tradename, or logo of the Copyright Holder.

(13) This license includes the non-exclusive, worldwide,
free-of-charge patent license to make, have made, use, offer to sell,
sell, import and otherwise transfer the Package with respect to any
patent claims licensable by the Copyright Holder that are necessarily
infringed by the Package. If you institute patent litigation

(including a cross-claim or counterclaim) against any party alleging
that the Package constitutes direct or contributory patent
infringement, then this Artistic License to you shall terminate on the
date that such litigation is filed.

(14) Disclaimer of Warranty:

THE PACKAGE IS PROVIDED BY THE COPYRIGHT HOLDER AND CONTRIBUTORS "AS
IS' AND WITHOUT ANY EXPRESS OR IMPLIED WARRANTIES. THE IMPLIED
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR
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NON-INFRINGEMENT ARE DISCLAIMED TO THE EXTENT PERMITTED BY YOUR LOCAL
LAW. UNLESS REQUIRED BY LAW, NO COPYRIGHT HOLDER OR CONTRIBUTOR WILL
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, OR CONSEQUENTIAL
DAMAGES ARISING IN ANY WAY OUT OF THE USE OF THE PACKAGE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

mm

- GYP, located at tools/gyp, is licensed as follows:

mm

Copyright (c) 2009 Google Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are
met:

* Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above
copyright notice, this list of conditions and the following disclaimer
in the documentation and/or other materials provided with the
distribution.

* Neither the name of Google Inc. nor the names of its
contributors may be used to endorse or promote products derived from
this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

mm

- marked, located at tools/doc/node_modules/marked, is licensed as follows:

mm

Copyright (c) 2011-2014, Christopher Jeffrey (https://github.com/chijj/)

304



18 Appendix

Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the "Software"), to deal
in the Software without restriction, including without limitation the rights

to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in
all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
THE SOFTWARE.

mm

- cpplint.py, located at tools/cpplint.py, is licensed as follows:

mm

Copyright (c) 2009 Google Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are
met:

* Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above
copyright notice, this list of conditions and the following disclaimer
in the documentation and/or other materials provided with the
distribution.

* Neither the name of Google Inc. nor the names of its
contributors may be used to endorse or promote products derived from
this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
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SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

mm

- ESLint, located at tools/eslint, is licensed as follows:

mm

ESLint
Copyright jQuery Foundation and other contributors, https://jquery.org/

Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the "Software"), to deal
in the Software without restriction, including without limitation the rights

to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in
all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
THE SOFTWARE.

mm

- gtest, located at deps/gtest, is licensed as follows:

306

mm

Copyright 2008, Google Inc.
All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are
met:

* Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.
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* Redistributions in binary form must reproduce the above
copyright notice, this list of conditions and the following disclaimer
in the documentation and/or other materials provided with the
distribution.

* Neither the name of Google Inc. nor the names of its
contributors may be used to endorse or promote products derived from
this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

mm

- node-weak, located at test/gc/node_modules/weak, is licensed as follows:

mm

Copyright (c) 2011, Ben Noordhuis <info@bnoordhuis.nl>

Permission to use, copy, modify, and/or distribute this software for any
purpose with or without fee is hereby granted, provided that the above
copyright notice and this permission notice appear in all copies.

THE SOFTWARE IS PROVIDED "AS IS" AND THE AUTHOR DISCLAIMS ALL WARRANTIES
WITH REGARD TO THIS SOFTWARE INCLUDING ALL IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR
ANY SPECIAL, DIRECT, INDIRECT, OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN
ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF
OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

mm

boost
Boost Software License - Version 1.0 - August 17th, 2003
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Permission is hereby granted, free of charge, to any person or organization
obtaining a copy of the software and accompanying documentation covered by
this license (the "Software") to use, reproduce, display, distribute,

execute, and transmit the Software, and to prepare derivative works of the
Software, and to permit third-parties to whom the Software is furnished to

do so, all subject to the following:

The copyright notices in the Software and this entire statement, including

the above license grant, this restriction and the following disclaimer,

must be included in all copies of the Software, in whole or in part, and

all derivative works of the Software, unless such copies or derivative

works are solely in the form of machine-executable object code generated by
a source language processor.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE, TITLE AND NON-INFRINGEMENT. IN NO EVENT
SHALL THE COPYRIGHT HOLDERS OR ANYONE DISTRIBUTING THE SOFTWARE BE LIABLE
FOR ANY DAMAGES OR OTHER LIABILITY, WHETHER IN CONTRACT, TORT OR OTHERWISE,
ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER
DEALINGS IN THE SOFTWARE.

// Copyright Joe Coder 2004 - 2006.

// Distributed under the Boost Software License, Version 1.0.

glog
Copyright (c) 2008, Google Inc.
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of Google Inc. nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL
THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
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SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY
WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

GoAhead
Copyright (c) 20XX GoAhead Software, Inc. All Rights Reserved.

gtest

Copyright 2008, Google Inc.
All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are
met:

* Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above
copyright notice, this list of conditions and the following disclaimer
in the documentation and/or other materials provided with the
distribution.

* Neither the name of Google Inc. nor the names of its
contributors may be used to endorse or promote products derived from
this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

309



18 Appendix

iconv

the libiconv and libcharset libraries and their header files are under LGPL.
- refer to http://www.gnu.org/licenses/Igpl.html

libfcgi

This FastCGI application library source and object code (the
"Software") and its documentation (the "Documentation") are
copyrighted by Open Market, Inc ("Open Market"). The following terms
apply to all files associated with the Software and Documentation
unless explicitly disclaimed in individual files.

Open Market permits you to use, copy, modify, distribute, and license
this Software and the Documentation for any purpose, provided that
existing copyright notices are retained in all copies and that this

notice is included verbatim in any distributions. No written

agreement, license, or royalty fee is required for any of the

authorized uses. Modifications to this Software and Documentation may
be copyrighted by their authors and need not follow the licensing

terms described here. If maodifications to this Software and
Documentation have new licensing terms, the new terms must be clearly
indicated on the first page of each file where they apply.

OPEN MARKET MAKES NO EXPRESS OR IMPLIED WARRANTY WITH RESPECT TO THE
SOFTWARE OR THE DOCUMENTATION, INCLUDING WITHOUT LIMITATION ANY
WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. IN
NO EVENT SHALL OPEN MARKET BE LIABLE TO YOU OR ANY THIRD PARTY FOR ANY
DAMAGES ARISING FROM OR RELATING TO THIS SOFTWARE OR THE
DOCUMENTATION, INCLUDING, WITHOUT LIMITATION, ANY INDIRECT, SPECIAL OR
CONSEQUENTIAL DAMAGES OR SIMILAR DAMAGES, INCLUDING LOST PROFITS OR
LOST DATA, EVEN IF OPEN MARKET HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES. THE SOFTWARE AND DOCUMENTATION ARE PROVIDED "AS IS".
OPEN MARKET HAS NO LIABILITY IN CONTRACT, TORT, NEGLIGENCE OR
OTHERWISE ARISING OUT OF THIS SOFTWARE OR THE DOCUMENTATION.
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This package contains C software to implement JPEG image encoding, decoding,and transcoding. JPEG
is a standardized compression method for full-color and gray-scale images.

The distributed programs provide conversion between JPEG "JFIF" format and image files in PBMPLUS
PPM/PGM, GIF, BMP, and Targa file formats.

The core compression and decompression library can easily be reused in other programs, such as
image viewers. The package is highly portable C code;
we have tested it on many machines ranging from PCs to Crays.

We are releasing this software for both noncommercial and commercial use.

Companies are welcome to use it as the basis for JPEG-related products.

We do not ask a royalty, although we do ask for an acknowledgement in product literature (see the
README file in the distribution for details).

We hope to make this software industrial-quality --- although, as with anything that's free, we offer no
warranty and accept no liability.

For more information, contact jpeg-info@jpegclub.org.

microzip
the microzip libraries and their header files are under LGPL.
- refer to http://www.gnu.org/licenses/Igpl.html

minizip
MiniZip - Copyright (c) 1998-2010 - by Gilles Vollant - version 1.1 64 bits from Mathias Svensson

Credits

Gilles Vollant - Original MiniZip author

Even Rouault - ZIP64 unzip Support

Daniel Borca - BZip Compression method support in unzip
Mathias Svensson - ZIP64 zip support

Mathias Svensson - BZip Compression method support in zip

License
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Condition of use and distribution are the same than zlib :

This software is provided 'as-is', without any express or implied
warranty. In no event will the authors be held liable for any damages
arising from the use of this software.

Permission is granted to anyone to use this software for any purpose,
including commercial applications, and to alter it and redistribute it
freely, subject to the following restrictions:

1. The origin of this software must not be misrepresented; you must not
claim that you wrote the original software. If you use this software
in a product, an acknowledgment in the product documentation would be
appreciated but is not required.

2. Altered source versions must be plainly marked as such, and must not be
misrepresented as being the original software.

3. This notice may not be removed or altered from any source distribution.

nginx

/*

* Copyright (C) 2002-2014 Igor Sysoev

* Copyright (C) 2011-2014 Nginx, Inc.

* All rights reserved.

*

* Redistribution and use in source and binary forms, with or without

* modification, are permitted provided that the following conditions

* are met:

* 1. Redistributions of source code must retain the above copyright

*  notice, this list of conditions and the following disclaimer.

* 2. Redistributions in binary form must reproduce the above copyright

*  notice, this list of conditions and the following disclaimer in the

*  documentation and/or other materials provided with the distribution.

*

* THIS SOFTWARE IS PROVIDED BY THE AUTHOR AND CONTRIBUTORS " *AS IS" AND

* ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE

* IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
* ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE

* FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
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* DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS

* OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)

* HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
* LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY

* OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF

* SUCH DAMAGE.

*/

OpenSSL

LICENSE ISSUES

The OpenSSL toolkit stays under a dual license, i.e. both the conditions of
the OpenSSL License and the original SSLeay license apply to the toolkit.
See below for the actual license texts. Actually both licenses are BSD-style
Open Source licenses. In case of any license issues related to OpenSSL
please contact openssl-core@openssl.org.

OpenSSL License

* Copyright (c) 1998-2011 The OpenSSL Project. All rights reserved.
*

* Redistribution and use in source and binary forms, with or without
* modification, are permitted provided that the following conditions

* are met:

*

* 1. Redistributions of source code must retain the above copyright

*  notice, this list of conditions and the following disclaimer.

* 2. Redistributions in binary form must reproduce the above copyright
*  notice, this list of conditions and the following disclaimer in

*

the documentation and/or other materials provided with the

*

distribution.

* 3. All advertising materials mentioning features or use of this
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*  software must display the following acknowledgment:
*  "This product includes software developed by the OpenSSL Project
*  for use in the OpenSSL Toolkit. (http://www.openssl.org/)"

* 4, The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to
*  endorse or promote products derived from this software without

*  prior written permission. For written permission, please contact

*  openssl-core@openssl.org.

*

5. Products derived from this software may not be called "OpenSSL"
*  nor may "OpenSSL" appear in their names without prior written
*  permission of the OpenSSL Project.

* 6. Redistributions of any form whatsoever must retain the following

*  acknowledgment:

*  "This product includes software developed by the OpenSSL Project

*  for use in the OpenSSL Toolkit (http://www.openssl.org/)"

*

* THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT " “AS IS" AND ANY

* EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
* IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
* PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR

* ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,

* SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT

* NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;

* LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)

* HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
* STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)

* ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
* OF THE POSSIBILITY OF SUCH DAMAGE.

* This product includes cryptographic software written by Eric Young
* (eay@cryptsoft.com). This product includes software written by Tim
* Hudson (tjh@cryptsoft.com).

X

*/

Original SSLeay License
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/* Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)

* All rights reserved.

*

* This package is an SSL implementation written

* by Eric Young (eay@cryptsoft.com).

* The implementation was written so as to conform with Netscapes SSL.
*

* This library is free for commercial and non-commercial use as long as
* the following conditions are aheared to. The following conditions

* apply to all code found in this distribution, be it the RC4, RSA,

* |hash, DES, etc., code; not just the SSL code. The SSL documentation
* included with this distribution is covered by the same copyright terms
* except that the holder is Tim Hudson (tjh@cryptsoft.com).

*

* Copyright remains Eric Young's, and as such any Copyright notices in

* the code are not to be removed.

* If this package is used in a product, Eric Young should be given attribution
* as the author of the parts of the library used.

* This can be in the form of a textual message at program startup or

* in documentation (online or textual) provided with the package.

*

* Redistribution and use in source and binary forms, with or without

* modification, are permitted provided that the following conditions

* are met:

* 1. Redistributions of source code must retain the copyright

*  notice, this list of conditions and the following disclaimer.

* 2. Redistributions in binary form must reproduce the above copyright
*  notice, this list of conditions and the following disclaimer in the

*  documentation and/or other materials provided with the distribution.
* 3. All advertising materials mentioning features or use of this software

*

must display the following acknowledgement:
*  "This product includes cryptographic software written by
*  Eric Young (eay@cryptsoft.com)"

*

The word 'cryptographic' can be left out if the rouines from the library

*  being used are not cryptographic related :-).

* 4, If you include any Windows specific code (or a derivative thereof) from

*  the apps directory (application code) you must include an acknowledgement:

*  "This product includes software written by Tim Hudson (tjh@cryptsoft.com)"

*

* THIS SOFTWARE IS PROVIDED BY ERIC YOUNG " "AS IS" AND

* ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE

* IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
* ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE
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* FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
* DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
* OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)

* HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
* LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
* OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF

* SUCH DAMAGE.

*

* The licence and distribution terms for any publically available version or

* derivative of this code cannot be changed. i.e. this code cannot simply be

* copied and put under another distribution licence

* Tincluding the GNU Public Licence.]

*/

PCRE
PCRE LICENCE

PCRE is a library of functions to support regular expressions whose syntax
and semantics are as close as possible to those of the Perl 5 language.

Release 8 of PCRE is distributed under the terms of the "BSD" licence, as
specified below. The documentation for PCRE, supplied in the "doc"
directory, is distributed under the same terms as the software itself.

The basic library functions are written in C and are freestanding. Also
included in the distribution is a set of C++ wrapper functions, and a
just-in-time compiler that can be used to optimize pattern matching. These
are both optional features that can be omitted when the library is built.

THE BASIC LIBRARY FUNCTIONS

Written by: Philip Hazel
Email local part: ph10

Email domain:  cam.ac.uk

University of Cambridge Computing Service,
Cambridge, England.
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Copyright (c) 1997-2014 University of Cambridge
All rights reserved.

PCRE JUST-IN-TIME COMPILATION SUPPORT

Written by: Zoltan Herczeg
Email local part: hzmester
Emain domain:  freemail.hu

Copyright(c) 2010-2014 Zoltan Herczeg
All rights reserved.

STACK-LESS JUST-IN-TIME COMPILER

Written by: Zoltan Herczeg
Email local part: hzmester
Emain domain:  freemail.hu

Copyright(c) 2009-2014 Zoltan Herczeg
All rights reserved.

THE C++ WRAPPER FUNCTIONS

Contributed by: Google Inc.
Copyright (c) 2007-2012, Google Inc.

All rights reserved.

THE "BSD" LICENCE

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice,
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this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

* Neither the name of the University of Cambridge nor the name of Google
Inc. nor the names of their contributors may be used to endorse or
promote products derived from this software without specific prior
written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

End

sqlcipher
Copyright (c) 2008, ZETETIC LLC
All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

* Neither the name of the ZETETIC LLC nor the
names of its contributors may be used to endorse or promote products
derived from this software without specific prior written permission.

318



18 Appendix

THIS SOFTWARE IS PROVIDED BY ZETETIC LLC "AS IS" AND ANY

EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL ZETETIC LLC BE LIABLE FOR ANY

DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

sqlite

Anyone is free to copy, modify, publish, use, compile, sell, or distribute the original SQLite code, either
in source code form or as a compiled binary, for any purpose, commercial or non-commercial, and by
any means.

TiddlyWiki

Copyright (c) UnaMesa Association 2004-2007

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL
THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY
WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILIT

websocketpp

WebSocket++ is an open source (BSD license)
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
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that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO,

THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED.

IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.

zlib
(C) 1995-2013 Jean-loup Gailly and Mark Adler

This software is provided 'as-is', without any express or implied
warranty. In no event will the authors be held liable for any damages
arising from the use of this software.

Permission is granted to anyone to use this software for any purpose,
including commercial applications, and to alter it and redistribute it
freely, subject to the following restrictions:

1. The origin of this software must not be misrepresented; you must not
claim that you wrote the original software. If you use this software
in a product, an acknowledgment in the product documentation would be
appreciated but is not required.

2. Altered source versions must be plainly marked as such, and must not be
misrepresented as being the original software.

3. This notice may not be removed or altered from any source distribution.

Jean-loup Gailly Mark Adler
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jloup@gzip.org madler@alumni.caltech.edu

SIL
Copyright (c) 1994-2008, SIL International (http://www.sil.org/).

This Font Software is licensed under the SIL Open Font License, Version 1.1,
with Reserved Font Names "Lateef" and "SIL".

This license is copied below, and is also available with an FAQ at:
http://scripts.sil.org/OFL

PREAMBLE

The goals of the Open Font License (OFL) are to stimulate worldwide
development of collaborative font projects, to support the font creation
efforts of academic and linguistic communities, and to provide a free and
open framework in which fonts may be shared and improved in partnership
with others.

The OFL allows the licensed fonts to be used, studied, modified and
redistributed freely as long as they are not sold by themselves. The
fonts, including any derivative works, can be bundled, embedded,
redistributed and/or sold with any software provided that any reserved
names are not used by derivative works. The fonts and derivatives,
however, cannot be released under any other type of license. The
requirement for fonts to remain under this license does not apply

to any document created using the fonts or their derivatives.

DEFINITIONS

"Font Software" refers to the set of files released by the Copyright
Holder(s) under this license and clearly marked as such. This may
include source files, build scripts and documentation.

"Reserved Font Name" refers to any nhames specified as such after the
copyright statement(s).

"Original Version" refers to the collection of Font Software components as
distributed by the Copyright Holder(s).
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"Modified Version" refers to any derivative made by adding to, deleting,

or substituting -- in part or in whole -- any of the components of the
Original Version, by changing formats or by porting the Font Software to a
new environment.

"Author" refers to any designer, engineer, programmer, technical
writer or other person who contributed to the Font Software.

PERMISSION & CONDITIONS

Permission is hereby granted, free of charge, to any person obtaining

a copy of the Font Software, to use, study, copy, merge, embed, modify,
redistribute, and sell modified and unmodified copies of the Font
Software, subject to the following conditions:

1) Neither the Font Software nor any of its individual components,
in Original or Modified Versions, may be sold by itself.

2) Original or Modified Versions of the Font Software may be bundled,
redistributed and/or sold with any software, provided that each copy
contains the above copyright notice and this license. These can be
included either as stand-alone text files, human-readable headers or
in the appropriate machine-readable metadata fields within text or
binary files as long as those fields can be easily viewed by the user.

3) No Maodified Version of the Font Software may use the Reserved Font
Name(s) unless explicit written permission is granted by the corresponding
Copyright Holder. This restriction only applies to the primary font name as
presented to the users.

4) The name(s) of the Copyright Holder(s) or the Author(s) of the Font
Software shall not be used to promote, endorse or advertise any
Modified Version, except to acknowledge the contribution(s) of the
Copyright Holder(s) and the Author(s) or with their explicit written
permission.

5) The Font Software, modified or unmodified, in part or in whole,
must be distributed entirely under this license, and must not be
distributed under any other license. The requirement for fonts to
remain under this license does not apply to any document created
using the Font Software.

TERMINATION
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This license becomes null and void if any of the above conditions are

not met.

DISCLAIMER

THE FONT SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND,
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT
OF COPYRIGHT, PATENT, TRADEMARK, OR OTHER RIGHT. IN NO EVENT SHALL THE
COPYRIGHT HOLDER BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY,
INCLUDING ANY GENERAL, SPECIAL, INDIRECT, INCIDENTAL, OR CONSEQUENTIAL
DAMAGES, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING
FROM, OUT OF THE USE OR INABILITY TO USE THE FONT SOFTWARE OR FROM
OTHER DEALINGS IN THE FONT SOFTWARE.

Software End User License Agreement(EULA)

SUPREMA INC.
SOFTWARE LICENSE A GREEMENT

PLEASE REA D THE FOLLOWING TERMS A ND CONDITIONS CAREFULLY BEFORE INSTALLING OR
USING THE SOFTWARE OR ANY ACCOMPA NYING DOCUMENTA TION (COLLECTIVELY, THE
“SOFTWARE").

THE TERMS AND CONDITIONS OF THIS SOFTWA RE LICENSE AGREEMENT (“AGREEMENT") GOVERN
USE OF THE SOFTWA RE UNLESS YOU AND SUPREMA INC (“"COMPANY") HAVE EXECUTED A
SEPARATE AGREEMENT GOVERNING USE OF THE SOFTWARE.

Company is willing to license the Software to you only upon the condition that you accept all the terms
contained in this Agreement. By installing or using the Software, you have indicated that you understand
this Agreement and accept all of its terms. If you are accepting the terms of this Agreement on behalf
of a company or other legal entity, you represent and warrant that you have the authority to bind that
company or other legal entity to the terms of this Agreement, and, in such event, “you” and “your” will
refer to that company or other legal entity. If you do not accept all the terms of this Agreement, then
Company is unwilling to license the Software to you, and you must return the Software to Company for
a full refund, if you have paid for the license to the Software, or, if Company has made the Software
available to you without charge, you must destroy all copies of the Software. Your right to return the
Software for a refund expires 30 days after the date of purchase.

1. Grant of License.

Conditioned upon your compliance with the terms and conditions of this Agreement, Company grants
you a non-exclusive, non-transferable, revocable license to Execute (as defined herein) the executable
form of the Software on or in connection with hardware products sold by the Company, solely for your
internal business purposes. You may make a single copy of the Software for backup purposes, provided
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that you reproduce on it all copyright and other proprietary notices that are on the original copy of the
Software. Company reserves all rights in the Software not expressly granted to you in this Agreement.
For purposes of this Agreement, “Execute” and “Execution” means to load, install, and run the Software
in order to benefit from its functionality as designed by Company.

2. Restrictions.

Except as expressly specified in this Agreement, you may not: (a) copy (except in the course of loading
or installing) or modify the Software, including but not limited to adding new features or otherwise
making adaptations that alter the functioning of the Software; (b) transfer, sublicense, lease, lend, rent
or otherwise distribute the Software to any third party; or (c) make the functionality of the Software
available to multiple users through any means, including but not limited to by uploading the Software to
a network or file-sharing service or through any hosting, application services provider, service bureau,
software-as-a-service (SaaS) or any other type of services. You acknowledge and agree that portions
of the Software, including but not limited to the source code and the specific design and structure of
individual modules or programs, constitute or contain trade secrets of Company and its licensors.
Accordingly, you agree not to disassemble, decompile or reverse engineer the Software, in whole or in
part, or permit or authorize a third party to do so, except to the extent such activities are expressly
permitted by law notwithstanding this prohibition.

3. Ownership.

The copy of the Software is licensed, not sold. You own the media on which the Software is recorded,
but Company retains ownership of the copy of the Software itself, including all intellectual property
rights therein. The Software is protected by copyright laws and the related regulations of your
jurisdictional countries, the copyright law of the Republic of Korea, and international treaties. You will
not delete or in any manner alter the copyright, trademark, and other proprietary rights notices or
markings appearing on the Software as delivered to you.

4, Term.

The license granted under this Agreement remains in effect for a period of 75 years, unless earlier
terminated in accordance with this Agreement. You may terminate the license at any time by destroying
all copies of the Software in your possession or control. The license granted under this Agreement will
automatically terminate, with or without notice from Company, if you breach any term of this
Agreement. Upon termination, you must at Company’s option either promptly destroy or return to
Company all copies of the Software in your possession or control.

5. Limited Warranty.

Company warrants that, for [thirty (30)] days following the date of purchase (or delivery, if Company
has made the Software available to you without charge), the Software will perform in all material
respects in accordance with any accompanying documentation (“"Documentation”). As your sole and
exclusive remedy and Company’s entire liability for any breach of this limited warranty, Company will at
its option and expense promptly correct or replace the Software so that it conforms to this limited
warranty. Company does not warrant that the Software will meet your requirements, that the Software
will operate in the combinations that you may select for Execution, that the operation of the Software
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will be error-free or uninterrupted, or that all Software errors will be corrected. The warranty set forth
in this Section 5 does not apply to the extent that Company provides you with the Software (or portions
of the Software) for beta, evaluation, testing or demonstration purposes.

6. DISCLAIMER.

THE LIMITED WARRANTY SET FORTH IN SECTION 5 IS IN LIEU OF AND COMPANY EXPRESSLY
DISCLAIMS ALL OTHER WARRANTIES AND CONDITIONS, EXPRESS OR IMPLIED, INCLUDING BUT NOT
LIMITED TO ANY IMPLIED WARRANTIES AND CONDITIONS OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE AND NONINFRINGEMENT, AND ANY WARRANTIES AND CONDITIONS ARISING
OUT OF COURSE OF DEALING OR USAGE OF TRADE. NO ADVICE OR INFORMATION, WHETHER ORAL
OR WRITTEN, OBTAINED FROM COMPANY OR ELSEWHERE WILL CREATE ANY WARRANTY OR
CONDITION NOT EXPRESSLY STATED IN THIS AGREEMENT.

7. Limitation of Liability.

COMPANY'S TOTAL LIABILITY TO YOU FROM ALL CAUSES OF ACTION AND UNDER ALL THEORIES OF
LIABILITY WILL BE LIMITED TO ANY REFUND THE LOCAL DISTRIBUTOR OR INSTALLER MAY PROVIDE IN
REGARDS TO THE DIRECT DAMAGES UP TO AND LIMITED TO THE AMOUNT PAID FOR THE SOFTWARE.
IN NO EVENT WILL COMPANY BE LIABLE TO YOU FOR ANY SPECIAL, INCIDENTAL, EXEMPLARY, PUNITIVE
OR CONSEQUENTIAL DAMAGES (INCLUDING LOSS OF DATA, BUSINESS, PROFITS OR ABILITY TO
EXECUTE) OR FOR the cost of procuring substitute products ARISING OUT OF OR IN CONNECTION WITH
THIS AGREEMENT OR THE EXECUTION OR PERFORMANCE OF THE SOFTWARE, WHETHER SUCH
LIABILITY ARISES FROM ANY CLAIM BASED UPON CONTRACT, WARRANTY, TORT (INCLUDING
NEGLIGENCE), STRICT LIABILITY OR OTHERWISE, AND WHETHER OR NOT COMPANY HAS BEEN
ADVISED OF THE POSSIBILITY OF SUCH LOSS OR DAMAGE. THE FOREGOING LIMITATIONS WILL
SURVIVE AND APPLY EVEN IF ANY LIMITED REMEDY SPECIFIED IN THIS AGREEMENT IS FOUND TO HAVE
FAILED OF ITS ESSENTIAL PURPOSE.

8. Indemnities

You shall indemnify Company and hold Company harmless from and against, and shall defend against,
any and all claims, including, but not limited to, the claim in relation to the infringement of the third
party’s Intellectual Property and damages of every kind for injury to or death of any person or persons
and for damage to or loss of property.

9. Export Law.

You agree to comply fully with all export or import controls imposed by the country of origin, destination
or use, including regulations under such laws. You agree not to export or re-export (directly or
indirectly) to ensure that neither the Software nor any technical data related thereto nor any direct
product thereof are exported or re-exported directly or indirectly in violation of, or used for any purposes
prohibited by, such laws and regulations.

10. Governing Law.
This Agreement will be governed by and construed in accordance with the laws of the Republic of Korea,
without regard to or application of conflict of laws rules or principles. The United Nations Convention on
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Contracts for the International Sale of Goods will not apply.

11. Arbitration.

In the event of any dispute controversy or claim arising out of, or in connection with, or relating to this
Agreement, or the breach, termination or invalidity of this Agreement, all attempts shall be made to
solve it through mutual consultation in a spirit of confidence and integrity. If all attempts so made
through mutual consultations have proved to be of no help within a reasonable time, arbitration rather
than legal proceedings shall solve it. The matter shall be referred to the Korean Commercial Arbitration
Board (43rd Fl., Trade Tower 159, Samsung-dong, Kangnam-ku, Seoul 135-729, Korea) using the Rules
of Arbitration of the International Chamber of Commerce. The award of the arbitrators shall be final and
binding upon the parties. The award shall be enforceable by any court having jurisdiction over the party
against whom the award has been rendered or where any assets of the party against whom the award
has been rendered can be located. The arbitrator(s) will be entitled to award attorneys’ fees, costs and
expenses incurred in connection with any dispute, controversy or claim arising out of, or in connection
with, or relating to this Agreement, or the breach, termination or invalidity of this Agreement (including
but not limited to costs and expenses associated with procuring expert witnesses), to the prevailing
party in any arbitration.

12. General.

You may not assign or transfer this Agreement or any rights granted hereunder, by operation of law or
otherwise, without Company’s prior written consent, and any attempt by you to do so, without such
consent, will be void. Except as expressly set forth in this Agreement, the exercise by either party of any
of its remedies under this Agreement will be without prejudice to its other remedies under this
Agreement or otherwise. All notices or approvals required or permitted under this Agreement will be in
writing and delivered by confirmed facsimile transmission, by overnight delivery service, or by certified
mail, and in each instance will be deemed given upon receipt. All notices or approvals will be sent to
the addresses set forth in the applicable ordering document or invoice or to such other address as may
be specified by either party to the other in accordance with this section. The failure by either party to
enforce any provision of this Agreement will not constitute a waiver of future enforcement of that or any
other provision. Any waiver, modification or amendment of any provision of this Agreement will be
effective only if in writing and signed by authorized representatives of both parties. If any provision of
this Agreement is held to be unenforceable or invalid, that provision will be enforced to the maximum
extent possible, and the other provisions will remain in full force and effect. This Agreement is the
complete and exclusive understanding and agreement between the parties regarding its subject matter,
and supersedes all proposals, understandings or communications between the parties, oral or written,
regarding its subject matter, unless you and Company have executed a separate agreement. Any terms
or conditions contained in your purchase order or other ordering document that are inconsistent with or
in addition to the terms and conditions of this Agreement are hereby rejected by Company and will be
deemed null.

13. Contact Information.
If you have any questions regarding this Agreement, you may contact Suprema at
sales@supremainc.com.

326



Index

1

1:N fastmode 66
1:N SecurityLevel 66

A

Access Group 109

Access Group Status 111

Access level 108

Access on Card 136

Activate the purchased license 224
Adding Custom AccountLevel 216
Adding holiday 232

Adding PIN 123

Adding schedule 232

Adding User Information 115
Advanced device search 57
Advanced Enrollment 66

Alert 234

AlertHistory 167

AlertList 51

Alllog 159

Analog Interphone 80

Anti passback 99

Anti-passback 98

Anti-passback Bypass 145
Anti-passback Zone 145
Assigning CSN Card 134
Assigning Wiegand Card 135
Audit Trail 241

Auth Tieout 66

Automatic meal deduction 181
Automatic user information syncing setting

B

Background setting 73

Basic device search 55

Batch editing device information 61
Batch editing doors 100

Batch editing user information 143
Before using 49

BioMini Enrollment Package 239
BioStar 2 date/time setting 219
BioStar 2 language setting 219
BioStar 2 Mobile app 236

BioStar 2 preferences 219

224

C

Camera Frequency 81

Card Format 221

Card list 220

Changing database of BioStar2 47
Changing port of BioStar 2 45
Changing server status of BioStar2 43
Cloud 236

CSN Card 134

CSv 118

Custom User Field 224

D

Dashboard 51

Database Backup 224
Daylight Saving Time 243
Delete Data & Sync Device 55
DESFire 136,138,223
Device - administrator 71
Device - authentication 66
Device - display/sound 73
Device - information 62
Device - network 64
Device - trigger & action 77
Device administrator setting 71
Device auth mode 66
Device configuration 61
Device language setting 73
Device Status 163

Device volume 73

DM-20 85

Door - configuration 95
Door - information 95
Door - option 97
Dooralarm 99

Door Group 93

Doorrelay 95

Doorsensor 95

Door Status 164

Dual authentication mode 97
Duress 125

E

Elevator 100

Elevator - Alarm 106
Elevator - Detail 103
Elevator - Information 103
Elevator - Option 105

327



328

Index

Elevator Group 101
Enroll Fingerprint 125
Enroliment Device 224
Entrydevice 95
EventLog 159

Event Status by Period 51
Exit button 95

Exit device 95

F

Face Detection Level 66
Fingerprint LFD 66
Fire Alarm Zone 147

First check-in & Last check-out

Fixed Shift 181

Flexible Shift 181
Floating Shift 181

Floor Status 165
Format SmartCard 138

G

General server setting 224
Grace 181

Graphic Map 169,171
Group 54,113

Hard APB 98
HTTPS 235

iCLASS 136,138,223
Image Log 78,237
Installing BioStar2 33
Intercom 80

Interlock Zone 154
Intrustion Alarm Zone 151
IP Camera 176

L

Log upload method setting 224

Login 42
login password 244
Long-term Idle User 144

M

Managing Users Registered with Devices
Matching Tiimeout 66

MIFARE 136, 138, 223

Missed Alarm 51

Mobile Card 223

Mobile Credential 255

Mobile Credential Partal 255

Muster Zone 156

N

Notice 51
NVR 174

O

OM-120 86
Overtime Rule 188

P

password level 244
Personal auth mode 123

R

Read SmartCard 138
Real-time Log 161
Registering CSN Card 134
Registering Wiegand Card 135
Report 193

Rounding 181

RS-485 settings 64

S

Scan Timeout 66
Schedule Template 186
Scheduled Lock 149
Scheduled Unlock 150
Secure communication with device 224
Secure Credential Card 136
Secure Tamper 80
Sensor Mode 66

Sensor Sensitivity 66
Seos 223

Server Matching 66, 224
session security 244
Session timeout setting 224

59



Index

Shift 181

SIP Interphone 80
Slave device search 58
Slave devices 58
SmartCard 136,223
Soft APB 98
Supported card list 133
Sync Device 55

System Requirements 31
system security 244

T

T&A 178

T&ADevice 199
T&A Schedule 190
TCP/IP settings 64
Template format 66
thermal report 168
Time Card 197
Time Code 180
Transferring User Information to Devices 141
Trigger & Action 231
Troubleshooting 261

U

Upgrading Firmware 60
User - BioStar privilege setting 115
User account privilege setting 214

V

Version Information 4
Video Setting 242

W

Wiegand 79,222

Wiegand Card 135

Wiegand Card Data Format 221

Wiegand Device 91

Wiegand Device Search and Registration 58
WLAN 64

Z

Zone Status 166

329



Suprema Inc.

17F Parkview Tower, 248, Jeongjail-ro, Bundang- gu, Seongnam-si, Gyeonggi-do, 13554, Rep. of KOREA
S SIS NI el +8231 7834502 | Fax: +82317834503 | Inquiry: sales_sys@supremainc.com

SECURITY & BIOMETRICS

©2020 Suprema Inc. Suprema and identifying product names and numbers herein are registered trade marks of Suprema, Inc. All non-Suprema brands and product names are
trademarks or registered trademarks of their respective companies. Product appearance, build status and/or specifications are subject to change without notice.




	BioStar 2 Overview
	License
	Versions

	Installation
	Minimum System Requirements
	Installing BioStar 2

	Login
	Changing server status of BioStar 2
	Changing port of BioStar 2
	Changing database of BioStar 2

	Before Using
	Dashboard
	Device
	Adding and Managing Device Groups
	Basic Search and Registration
	Advanced Search and Registration
	Wiegand Device Search and Registration
	Slave Device Search and Registration
	Managing Users Registered with Devices
	Upgrading Firmware
	Editing Device Settings and Information
	Information
	Network
	Authentication
	Advanced Settings
	Administrator
	T&A
	Display/Sound
	Trigger & Action
	Image Log
	Wiegand
	Secure Tamper
	Interphone
	Analog Interphone
	SIP Interphone

	Camera

	Thermal & Mask
	DM-20
	OM-120
	CoreStation
	Wiegand Device


	Door
	Adding and Managing Door Groups
	Adding Doors
	Information
	Configuration
	Option
	Anti-passback
	Alarm

	Editing Doors

	Elevator
	Adding and Managing Elevator Groups
	Adding Elevators
	Information
	Detail
	Option
	Alarm

	Editing Elevators

	Access Control
	Adding and Managing Access Levels
	Adding and Managing Access Groups
	Adding and Managing Floor Levels
	Access Group Status

	Users
	Adding and Managing User Groups
	Adding User Information
	Export/Import CSV
	Export/Import User Information

	Adding User Credentials
	Adding PIN
	Auth Mode
	Enroll Fingerprint
	Enroll Face
	Enroll Visual Face
	Enroll Card
	Registering CSN Card
	Registering Wiegand Card
	Registering Smart / Mobile Cards
	Read/Format Smart Cards


	Enroll Mobile Access Card

	Transferring User Information to Devices
	Deleting User from Devices
	Editing User Information
	Managing Long-term Idle Users

	Zone
	Anti-passback Zone
	Fire Alarm Zone
	Scheduled Lock Zone
	Scheduled Unlock Zone
	Intrusion Alarm Zone
	Interlock Zone
	Muster Zone

	Monitoring
	List View
	Event Log
	Import Event Logs

	Real-time Log
	Live Video View
	Device Status
	Door Status
	Floor Status
	Zone Status
	Alert History
	Thermal Report

	Graphic Map View
	Adding and Managing Graphic Map Groups
	Adding and Managing Graphic Maps


	Video
	Adding NVRs
	Adding IP Cameras
	Editing IP Camera Settings


	Time & Attendance
	Shift
	Time Code
	Shift
	Schedule Template
	Rule

	Schedule
	Report
	Editing T&A Records

	Setting

	Visitor
	Applying to Visit
	Applying to First Visit
	Applying to Visit Using Existing Info

	Managing Visitors
	Managing Registered Visitors
	Managing Check In Visitors
	Managing Check Out Visitors
	Managing All Visitors
	Deleting Personal Data Expired


	BioStar 2 Settings
	Account
	Adding Custom Account Level

	Preference
	Card
	Changing Wiegand Card Data Format

	Card Format
	Wiegand
	Smart / Mobile Card

	Server
	Trigger & Action
	Schedules
	Alert
	HTTPS
	Cloud
	Image Log
	USB Agent
	Face Group Matching
	Audit Trail
	Video
	Daylight Saving Time
	Security
	Active Directory
	Active Directory Encryption 

	Visitor
	Mobile Access
	Airfob Portal
	Configuring Mobile Access

	Email Contents

	Troubleshooting
	Appendix
	Disclaimers
	Copyright Notice
	Open Source License
	Software End User License Agreement(EULA)




